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TUYÊN BỐ BẢN QUYỀN 

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được 

phép dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo.  

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh 

thiếu lành mạnh sẽ bị nghiêm cấm. 
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LỜI GIỚI THIỆU 

Flash được sinh ra với mục đích ban đầu để làm hoạt hình vector, nên tạo hoạt 

hình là một phần quan trọng trong Flash.   

Để làm hoạt hình trong Flash ngoài việc vẽ các frame liên tiếp khác nhau, ta 

còn có một cách khác nhanh hơn đó là dùng tween.   

Tween là khái niệm dùng để chỉ chuyển động được tạo ra một cách tự động, 

mô tả sự thay đổi giữa 2 frame. Ví dụ: sự thay đổi vị trí, màu sắc, hình dán, … của 

vật thể. Đối tượng được Tween là symbol. Nếu ta không tạo symbol mà áp dụng 

tween ngay lập tức với một hình vẽ, hình đó sẽ tự động được biến thành một 

symbol.  

Mỗi layer chỉ được phép chứa một tween, không được phép chứa thêm gì khác, 

nếu không tween sẽ không hoạt động. Có 2 loại tween trong Flash:  

 Motion tween: Classic tween và Motion tween cùng thuộc loại này. Từ phiên 

bản CS3 trở về trước chỉ có Classic tween, không có motion tween. Về bản chất 2 

tween này giống nhau, tuy nhiên Motion tween áp dụng một số tính năng mới của 

Flash CS4 (Ví dụ: 3D Tween) và cách sử dụng thuận tiện hơn classic tween. 2 loại 

tween này cùng tạo ra hoạt hình dựa trên sự thay đổi tính chất của 1 symbol giữa 2 

frame.  

 Shape tween: Khác biệt cơ bản giữa shape tween và 2 loại trên nằm ở việc 

shape tween không làm việc với symbol. Thay vào đó ta định nghĩa shape tween 

bằng việc thay đổi đối tượng đồ họa tại 2 frame khác nhau, shape tween sẽ tự hiểu 

và sinh ra chuyển động thay đổi hình dáng tương ứng. Để giúp việc này đúng như 

ta mong muốn, Flash cũng cung cấp một số công cụ hỗ trợ sẽ được bàn tới trong 

phần tiếp theo của bài học.  

 Flash CS4 cung cấp một tính năng rất mạnh cho người làm hoạt hình, đó là 

bone. Tính năng bone sẽ giúp ta định nghĩa khung xương của đối tượng đồ họa, 

qua đó ta có thể tạo các chuyển động phức tạp như động vật di chuyển, khớp máy. 

Lâm Đồng, ngày 07 tháng  7   năm 2017 
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CHƯƠNG TRÌNH MÔ ĐUN 

Tên mô đun: THIẾT KẾ HOẠT HÌNH VỚI FLASH 

Mã mô đun: MĐ 31 

VỊ TRÍ, TÍNH CHẤT CỦA MÔ ĐUN 

1. Vị trí:  

− Mô đun được bố trí giảng dạy sau các môn chung và đồ hoạ ứng dụng 1, đồ 

hoạ ứng dụng 2 

2. Tính chất: 

− Mô đun thiết kế hoạt hình với Flash là mô đun thuộc nhóm các mô đun tự 

chọn của hệ Trung cấp ngành Công nghệ thông tin 

MỤC TIÊU MÔ ĐUN 

1. Về kiến thức: 

− Liệt kê và nêu được chức năng các công cụ 

− Phân loại các tập tin: ảnh, âm thanh, video và điều kiện sử dụng chúng. 

− Phân loại các kiểu chuyền động và các kiểu biến hình trong Flash. 

− Phân biệt các hiệu ứng có sẵn trong Flash. 

2. Về kỹ năng: 

− Tạo hình bằng các công cụ có sẵn 

− Chèn các tập tin hình, âm thanh, video vào tập tin Flash. 

− Tạo các biểu tượng, sử dụng các hiệu ứng khung hình, lớp, bảng tiến trình để 

tạo ra hình ảnh động. 

− Viết lệnh tạo sự chuyển động cho hình vẽ 

3. Về năng lực tự chủ và trách nhiệm: 

− Có khả năng tự nghiên cứu, tư ̣hoc̣, tham khảo tài liêụ liên quan đến môn hoc̣ để 

vâṇ duṇg vào hoaṭ đôṇg hoc tâp̣. 

− Vâṇ duṇg được các kiến thức tự nghiên cứu, học tâp̣ và kiến thức, kỹ năng đã 

được học để hoàn thiêṇ các kỹ năng liên quan đến môn hoc̣ môṭ cách khoa hoc̣, 

đúng quy điṇh.  

NỘI DUNG MÔ ĐUN 
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BÀI 1: GIỚI THIỆU TỔNG QUAN VỀ FLASH 
Mã bài: MĐ 31_01 

GIỚI THIỆU 

Bài học giới thiệu với bạn về phần mềm Flash 5. Bạn sẽ được hướng dẫn cách 

tạo, lưu một File. Ngoài ra, để tiếp cận phần mềm mới bạn sẽ được cung cấp các 

khái niệm cơ bản, hướng dẫn bạn làm quen với các thành phần trong môi trường 

làm việc. 

MỤC TIÊU 

− Trình bày chức năng của chương trình Flash; 

− Trình bày được các thuật ngữ thường dùng trong Flash; 

− Tạo và lưu được tập tin Flash; 

− Thao tác được trên giao diện và các bảng điều khiển; 

NỘI DUNG CHÍNH 

1 CHỨC NĂNG VÀ GIAO DIỆN FLASH   

1.1 Chức năng  

Phiên bản Adobe Flash CS5 xuất xưởng năm 2010, phiên bản CS5.5 xuất 

xưởng nửa cuối năm 2011. So với các phiên bản trước đó, CS5 và CS5.5 có nhiều 

thay đổi về cả giao diện chương trình lẫn các tính năng của nó.  

Về giao diện: phiên bản CS5/CS5.5 dành cho Windows đã tuyệt giao với giao 

diện Window, sử dụng một giao diện độc lập với hệ điều hành.  

Về tính năng: bổ sung thêm nhiều công cụ mới làm cho công việc sáng tác trở 

nên đơn giản hơn như các công cụ Bone, Bind, 3D Translation, 3D Rotation, các 

hiêụ ứng script hổ trợ màn hı̀nh cảm ứng...  

1.2 Giao diện  

 Khởi động chuơng trình 

Trong giao diện tổng thể Essential của Flash CS5/CS5.5, có thể chia làm 5 

vùng chính:  

− Vùng hệ thống menu phía trên cùng.  

− Vùng thanh công cụ ở bên phải.  

− Vùng thuộc tính và thư viện bên cạnh thanh công cụ.  

− Vùng sáng tác ở trung tâm. 
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Lưu ý:  

Flash CS5/CS5.5 cho phép bạn làm việc theo chế độ Tab. Trên vùng thanh 

menu, ở góc bên phải mục Essentials cho phép ta chuyển đổi qua lại giữa các cách 

bố trí giao diện. Có 6 chế độ bố trí giao diện: Animator, Classic, Debug, Designer, 

Developer và Essentials. 

 

 Tạo dự án mới 

− File/ New 
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− Phần Genernal/ Chọn ActionScript 3.0 

− Nhấn Create. 

Lưu ý: 

− ActionScript 3.0: tạo dự án Flash hỗ trợ ActionScript 3.0. Dự án này sử dụng 

cho Flash Player và Flash Plugin với nền tảng chủ yếu là Desktop. Bạn cũng 

lưu ý rằng, trong giáo trình này, chúng ta đang thảo luận về ActionScript 3.0. 

Phiên bản này là phiên bản mới nhất của ActionScript cho đến thời điểm này.  

− ActionScript 2.0: tương tự như dư ̣ án ActionScript 3.0, tuy nhiên phiên bản 

ActionScript được hỗ trợ là 2.0.  

− Adobe Air 2/AIR: tạo dự án Flash cho Desktop hoặc các thiết bị khác có hỗ trợ 

Adobe Air. Trong trường hợp này, AIR được sử dụng là phiên bản AIR 2.0 trở 

lên. Adobe Air là một dự án mới của Adobe nhằm tạo ra môi trường cho các 

nhà phát triển xây dựng những ứng dụng dựa vào công nghệ Flash có thể chạy 

độc lập trên các nền tảng hệ điều hành. Nó có nhiều điểm tương đồng với công 

nghệ Java của Sun hay .NET của Microsoft. Để phát triển một trình ứng dụng 

trên Adobe Air, bạn hoàn toàn có thể sử dụng trình soạn thảo Adobe Flash hoặc 

Adobe Flex Builder (hay Adobe Flash Buider).  

− AIR for Android: tạo dự án Flash chạy trên AIR phục vụ cho các thiết bị sử 

dụng hệ điều hành Android của Google. Trong giáo trình này, tôi sẽ giới thiệu 

cho các bạn cách cài đặt AIR và các ứng dụng chạy trên AIR cho bộ giả lập 

Android SDK do Google cung cấp. Chi tiết phần này sẽ được trình bày trong 

phần xuất bản tập tin Flash.  

− AIR for iOS: tạo dự án Flash chạy trên AIR phục vụ cho các thiết bị sử dụng hệ 

điều hành iOS của Apple. iOS SDK của Apple chỉ cung cấp cho các nhà phát 

triển sử dụng nền tảng MacOS, do đó, nếu bạn là một nhà phát triển ứng dụng 

Windows, bạn chỉ có thể lựa chọn một trong hai cách: cài đặt MacOS để sử 

dụng bộ SDK; hoặc sử dụng môi trường giả lập Virtual PC để cài đặt MacOS. 

Hiển nhiên, bạn hoàn toàn có thể viết các ứng dụng cho iOS trong trường hợp 

sử dụng Adobe Flash CS5 trở lên, tuy nhiên, để đảm bảo ứng dụng thực thi tốt 

trên hệ điều hành này, bạn cần kiểm tra nó trên môi trường giả lập hoặc trên 

chính thiết bị đó.  

− Flash Lite 4, Adobe Device Central: tạo dự án Flash cho Mobile chạy trên Flash 

Lite. Khi chọn kiểu dự án này, Adobe Flash CS5/CS5.5 sẽ tự động gọi đến 

Adobe Device Central. Đây là tiện ích quản lý các thông tin về Flash Lite hỗ trợ 

trên các dòng điện thoại. 

2 CÁC KHÁI NIỆM CƠ BẢN 
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2.1 Thuộc tính (Properties): 

Thuộc tính là các tính chất áp dụng cho một đối tượng (lớp, hình vẽ, …) 

2.2 Layer 

Layer là các lớp được dùng trong việc sáng tác. Mỗi một khung hình có thể 

chứa nhiều layer khác nhau. Mỗi một đối tượng thường được xây dựng trên mỗi 

layer. Kĩ thuật layer được sử dụng rộng rãi trong đồ họa máy tính, bao gồm cả đồ 

họa điểm như: photoshop, corel photopaint hay đồ họa vector như: illustrator, 

coreldraw. 

 

− Tạo mới Layer 

− Tạo thư mục  chứa Layer 

− Xoá Layer 

− Biểu tượng con mắt dùng để ẩn 

hiện Layer 

− Biểu tượng chìa khoá dùng để 

khoá Layer 

− Biểu tượng hình vuông để hiển thị 

đường viền và màu nền của đối 

tượnd 

2.3 Frame 

Frame là khung hình dùng trong kĩ thuật tạo chuyển động. Vật thể chuyển động 

được là nhờ vào kĩ thuật thay thế các khung hình. Như tôi đã trình bày ở trên, mắt 

người chỉ có thể lưu được không quá 24 hình ảnh trong một giây, nếu tốc độ 

chuyển đổi các khung hình lớn, mắt chúng ta không thể nhận thấy được sự thay đổi 

này mà cảm giác như là hình ảnh đang chuyển động. Với Flash, số khung hình 

không nhất thiết phải lớn như trong kĩ thuật tạo video, nó giảm đi một cách đáng 

kể nhờ vào công nghệ được sử dụng trong Flash. Điều này cũng giúp làm giảm 

kích thước của tập tin Flash. 

2.4  Scene 

Scene được hiển như cảnh quay trong Flash, một cảnh quay là tập hợp các 

khung nhìn liên tiếp nhau. Nhờ vào cacnhr quay ta có thể tạo các thước phim dài 

nhưng không cần quản lý các lớp khi đối tượng trên cacnhr quay quá lớn. 
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2.5 Movie 

Movie là một thước phim hoàn chỉnh. Một movie có thể chứa một hoặc nhiều 

cảnh quay. Để chuyển đổi qua lại giữa các cảnh quay trong một movie, ta bấm vào 

biểu tượng và chọn tên của scene. Để kiểm tra một bộ phim hoàn chỉnh, bạn chọn 

Control > Test Movie (hoặc tổ hợp Ctrl+Enter). Bạn cũng lưu ý rằng, nếu bạn xây 

dựng một thước phim chứa nhiều đối tượng đồ họa và có nhiều cảnh quay, thì việc 

kiểm tra sự hoạt động của từng cảnh quay là điều cần thiết. Bạn chỉ nên kiểm tra sự 

hoạt động của toàn bộ phim khi các cảnh quay đã hoạt động tốt. Sở dĩ như vậy là 

vì, quá trình biên dịch một bộ phim hoàn chỉnh bao giờ cũng chậm hơn, chiếm 

nhiều tài nguyên bộ nhớ hơn so với biên dịch từng cảnh quay riêng lẻ. Điều này 

đặc biệt hữu ích với những máy có cấu hình không quá cao.   

2.6 Remarks 

Flash cũng hỗ trợ chế độ kiểm tra trực tiếp trong khung sáng tác. Để thực hiện 

chức năng này, bạn có thể chọn một trong hai chế độ: chế độ kiểm tra bằng tay, 

chế độ kiểm tra tự động. Đối với chế độ kiểm tra bằng tay, bạn sử dụng thanh đánh 

dấu Frame hiện tại, sau đó kéo trượt nó trên thanh TimeLine. Với chế độ kiểm tra 

tự động, bạn chỉ cần nhấn phím Enter. Nếu phim của bạn nằm trên TimeLine quá 

dài và bạn đang thực hiện chức năng kiểm tra tự động, bạn muốn dừng chế độ này 

ngay lập tức ! Khi đó, bạn hãy nhấn phím Enter thêm lần nữa. Chế độ kiểm tra tự 

động sẽ dừng ngay lập tức. 

2.7 symbol 

Symbol được xem như một dạng dữ liệu đóng gói trong Flash. Dữ liệu này có 

thể là một nét vẽ, một đường thẳng, một hình chữ nhật, một bức ảnh v.v.  
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Khi một symbol được tạo ra, bản gốc của nó được cất giữ ở thư viện (Library). 

Bản sao của symbol mà bạn nhìn thấy trên Stage gọi là một Instance của symbol 

(hay bản copy). Bạn có thể phóng to, thu nhỏ, làm méo, đổi màu, v.v. một bản sao 

của symbol trên Stage mà không làm ảnh hưởng đến nội dung của bản gốc trong 

thư viện. Muốn thay đổi nội dung của bản gốc, bạn phải sửa từ bản gốc ở thư viện. 

Bạn có thể tạo được ba loại symbol: Movie Clip, Graphic và Button. Đặc điểm 

của các symbol là chúng có Timeline riêng hay còn gọi là Timeline của symbol 

(Symbol Timeline). Còn timeline của bản thân Flash document gọi là timeline 

chính (Main Timeline) . 

− Một số cách để tạo symbol 

1. Chọn một đối tượng rồi chuyển nó sang symbol (sẽ có bài thực hành riêng) 

2. Tạo mới một symbol với timeline rỗng (chưa có nội dung) rồi bắt đầu bổ 

sung nội dung (sẽ có bài thực hành riêng) 

3. Cho Flash tự động tạo symbol như vừa thực hiện trong bài này. 

− Hiệu quả khi sử dụng symbol: 

Symbol giúp giảm kích thước tác phẩm đáng kể. Nếu bạn có một flash 

document có vẽ mười hình chữ nhật bằng công cụ vẽ Rectangle Tool và một flash 

document với mười hình chữ nhật là bản sao lấy từ một symbol hình chữ nhật gốc 

từ thư viện thì flash document tạo từ symbol có kích thước file nhỏ hơn nhiều. Do 

vậy, khi sử dụng một đối tượng nào đó hai lần trở lên, bạn nên chuyển nó sang 

symbol. 

3 CHỨC NĂNG CÁC BẢNG ĐIỀU KHIỂN   

3.1 Bảng điều khiển Library   

Vùng này quản lý các đối tượng được chia theo nhóm chức năng 

− Common Library: Buttons, Classes, Sound 

− Componet: quản lý thành phần GUI 

− Library: quản lý đối tượng được Import và Convert 
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3.2  Bảng điều khiển Properties  

Đây là  một panel quan trọng, chứa các thông số của đối tượng đang được lựa 

chọn. Tùy vào đối tượng đang được chọn mà sẽ có các loại thông số khác nhau 

hiển thị ở panel properties  

Ví dụ khi ta chọn một hình được vẽ trên stage thì sẽ có panel properties như 

sau:  

 

3.3 Bảng điều khiển Transform 

Vùng này tập hợp các lệnh điều chỉnh đối tượng gồm3 nhóm lệnh: 
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− Nhóm đầu tiên: kéo giãn chiều dài và chiều rộng (tính theo tỉ lệ %), nếu bạn 

nhấp chọn tùy chọn cuối cùng trong nhóm này (biểu tượng mắc xích bị phân 

đôi), thì độ kéo giãn của đối tượng theo chiều ngang và chiều dọc sẽ diễn ra 

đồng thời, ngược lại việc hiệu chỉnh kích thước theo chiều dài và chiều rộng là 

độc lập.  

− Nhóm thứ hai: Rotate (hiệu chỉnh góc quay), Skew (hiệu chỉnh góc dịch chuyển 

xiêng – hay độ kéo trượt theo hai phía).  

− Nhóm thứ 3: liên quan đến tọa độ 3D và điểm trọng tâm 3D. Chức năng này chỉ 

hoạt động đối với biểu tượng MovieClip. Chúng tôi sẽ trình bày kĩ hơn về biểu 

tượng này trong chương 3.  

 

3.4 Bảng điều khiển Align(Ctrl+K): 

Bảng điều khiển  Align dùng để can chỉnh lề trái, phải, trên và dưới cho các đối 

tượng. Can chỉnh kích thước cho đối tượng.  

Trong vùng align này chia làm bốn nhóm:  

− Nhóm Align: canh chỉnh vị trí của các đối tượng. Theo thứ tự các biểu tượng từ 

trái sang phải là canh trái, canh giữa theo chiều ngang, canh phải, canh trên, 

canh giữa theo chiều dọc và canh dưới. Nếu đánh dấu kiểm vào tùy chọn Align 

to Stage thì nó sẽ canh chỉnh theo khung soạn thảo, ngược lại, nó sẽ can chỉnh 

theo vị trí tương đối của các đối tượng.  

− Nhóm Distribute: canh chỉnh theo trục tương đối của các đối tượng. Theo thứ 

tự các biểu tượng từ trái sang phải là: canh chỉnh theo trục ở phía mép trên, theo 

trục đối xứng ngang, theo trục ở phía mép dưới, theo trục ở phía mép trái, theo 

trục đối xứng dọc và theo trục ở phía mép phải.  

− Nhóm Match Size: hiệu chỉnh cùng kích thước của đối tượng theo chiều ngang, 

chiều dọc, hoặc theo cả chiều ngang và chiều dọc. Nếu chọn tùy chọn Align to 

Stage, nó sẽ canh chỉnh kích thước đối tượng theo khung soạn thảo.  
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− Nhóm Space: hiệu chỉnh khoảng cách giữa các đối tượng theo chiều dọc và 

ngang.  

 

3.5 Bảng điều khiển history 

Bạn chỉ việc chọn thời điểm được chỉ định trong vùng History này để phục hồi 

các thao tác được đánh dấu tại thời điểm đó. Theo ma c̣ điṇh, Flash se ̃ấn điṇh 100 

lần undo (phuc̣ hồi laị thao tác trước đó) cho tài liêụ (hoa c̣ cho đổi tươṇg). Nếu baṇ 

muốn ta ng số lần Undo thı̀ haỹ thưc̣ hiêṇ thao tác sau: vào Edit > Preferences; choṇ 

General và sau đó thay đổi thông số Undo (hoặc Document Level Undo hoa c̣ 

Object Level Undo). Baṇ cũng cần lưu ý rằng, nếu số  lần Undo càng lớn, thı̀ tài 

nguyên bộ nhớ đươc̣ sử duṇg để lưu cũng sẽ lớn và có thể làm giảm hiêụ na ng làm 

viêc̣. 

 

3.6 Bảng điều khiển màu sắc 

Vùng Color: quản lý màu sắc. Bạn có thể hiệu chỉnh trực tiếp màu sắc cho đối 

tượng (chọn đối tượng, sau đó bấm vào bảng màu) hoặc có thể kết hợp với công cụ 

đổ màu mà ta sẽ tìm hiểu trong chương tiếp theo. 
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Trong bảng màu chuẩn này, ta có thể chọn mẫu màu RGB thông dụng hoa c̣ 

mẫu màu HSL – bằng cách bấm chuột vào biểu tượng quả cầu phía trên bên phải; 

hoặc chọn không màu bằng cách bấm vào biểu tượng hình vuông gạch chéo. Bạn 

cũng có thể chọn chế độ Transparent bằng cách điều chỉnh thông số Alpha. Bảng 

màu chuẩn còn cung cấp cho chúng ta một số mẫu màu Gradient có sẵn. Nếu nhu 

cầu sử dụng màu trong bảng màu chuẩn không đáp ứng đủ, bạn có thể sử dụng 

bảng màu nâng cao (tổ hợp phím Alt+Shift+F9). 

 

− None: chế độ không màu 

− Solid: mầu đơn 

− Linear Gradient: pha trộn màu 

− Stroke: màu viền 

− Fill: màu nền 

− Fill bitmap : đổ màu theo mẫu 

 

3.7 BẢng điều khiển ActionScript 

Trong khung soạn thảo ActionScript, phần soạn thảo nằm ở trung tâm của cửa 

sổ này. Vùng phía bên trái chứa các lớp thư viện và cây phả hệ (mô tả sư ̣kế thừa 

của các lớ p). Phía trên khung soạn thảo là hệ thống các công cụ hỗ trợ soạn thảo 

ActionScript. 

(1) – Bổ sung thêm các thành phần vào ActionScript. 
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(2) – Tìm kiếm và thay thế. 

(3) – Chèn target path. Chức năng này thường sử dụng khi làm việc với lớp. 

(4) – Kiểm tra lỗi cú pháp. 

(5) – Định dạng cho mã nguồn theo chế độ tự động của ActionScript. 

(6) – Xem các chỉ dẫn về mã nguồn. 

(7) – Tạo các điểm thoát khi debug chương trình. 

(8) – Đóng mở các khối mã lệnh chương trình. 

(9) – Hỗ trợ khi viết script. 

 

4 TẠO VÀ LƯU TRỮ TẬP TIN  

Bước 1 – Tạo một file Flash mới 

Khởi động ứng dụng Flash CS5. 

Để tạo ra một tài liệu mới, bạn hãy vào menu chính và chọn File> New. 

 

https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-1.jpg
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Sau đó, từ cửa sổ tài liệu mới, chọn ActionScript 3.0, và nhấn OK. Click vào 

hình ảnh bên dưới để phóng to. 

 

Bây giờ bạn sẽ thấy tài liệu Flash mới của bạn.  

 

Đây là không gian làm việc của bạn. Nó được tạo thành từ các cửa sổ khác 

nhau mà mỗi người đều có chức năng cụ thể. Bạn sẽ thấy một số trong những cửa 

sổ được đánh dấu trong hình dưới đây.  

https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-2.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-3.jpg
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Các cửa sổ mà bạn nhìn thấy ở đây là một số các cửa sổ mà bạn có thể làm việc 

với khi bạn mở một tài liệu Flash. Bạn đã có những thanh công cụ, thời gian, các 

thuộc tính inspector, vv  

Những cửa sổ tạo nên không gian làm việc của bạn có thể được sắp xếp lại. 

Bạn có thể di chuyển chúng đến các địa điểm khác nhau, điều chỉnh kích thước, 

bạn có thể đóng cửa một số trong số họ, hoặc bạn có thể đưa lên các cửa sổ khác 

mà không phải là chưa nhìn thấy được, vv … Các cửa sổ mà bạn đã mở và cách 

bạn sắp xếp các cửa sổ được gọi là bố trí không gian làm việc của bạn. Bạn có thể 

tùy chỉnh cách bố trí không gian làm việc của bạn hoặc bạn có thể chọn từ bất kỳ 

của các bố trí định sẵn mà có sẵn. 

Bước 2 – Lựa chọn một bố trí không gian làm việc 

Để chọn một bố trí mới, hãy vào menu chính và chọn Window> Workspace. Ở 

đây bạn sẽ thấy tất cả các cài đặt trước bố trí sẵn có mà có sẵn. Bạn đã có 

Animator, Classic, Debug, thiết kế, phát triển, Essentials và màn hình nhỏ. 

 

https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-4.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-5.jpg
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Nhấp chuột vào lựa chọn để xem sự khác nhau giữa các cách thức trình bày. 

Bước 3 – Move, collapse, expand và điều chỉnh kích thước của cửa sổ 

Nếu bạn muốn di chuyển các cửa sổ của bạn xung quanh, bạn nhấp vào tab cửa 

sổ, giữ và kéo cửa sổ đến vị trí mong muốn. 

 

Nếu bạn muốn thu gọn hoặc thu nhỏ cửa sổ, chỉ cần double-click vào tab. Để 

mở rộng một cửa sổ một lần nữa, sau đó chỉ cần kích đúp vào tab nữa. 

     

Nếu bạn muốn điều chỉnh kích thước của cửa sổ, đặt con trỏ chuột của bạn trên 

các cạnh của cửa sổ cho đến khi con trỏ biến thành mũi tên hai đầu. 

Và sau đó nhấp và kéo để điều chỉnh kích thước của cửa sổ. Bạn có thể điều 

chỉnh từ bên trái hoặc phải để thay đổi độ rộng. Và bạn cũng có thể điều chỉnh từ 

các cạnh trên hoặc dưới để thay đổi chiều cao. 

Bước 4 – Thiết lập lại một cách bố trí không gian làm việc Bạn có thể thiết 

lập lại tất cả mọi thứ bằng cách vào Window> Workspace> Reset [Active 

Layout]. 

https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-6.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-7.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-8.jpg
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Điều này sẽ thiết lập lại bất cứ bố trí đang hoạt động. Vì vậy, nếu bạn đang sử 

dụng bố trí Animator, nó sẽ thiết lập lại không gian làm việc của bạn trở lại để bố 

trí Animator mặc định, và làm cho mọi thứ gọn gàng và ngăn nắp lại. 

 

https://hocphotoshop.vn/wp-content/uploads/2015/11/new-flash-va-moi-truong-lam-viec-9.jpg
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BÀI 2: THANH CÔNG CỤ 
Mã bài: MĐ 31_02 

GIỚI THIỆU 

Bài học giới thiệu với bạn về chức năng của thanh công cụ trong phần mềm. 

Hướng dẫn bạn cách sử dụng các thanh công cụ để vẽ, cân chỉnh và tô màu cho đối 

tượng. 

MỤC TIÊU 

− Phân biệt các nhóm công cụ ; 

− Trình bày chức năng từng nhóm công cụ; 

− Sử dụng bảng điều khiển Properties, Library; 

− Vận dụng các nhóm công cụ để vẽ hình và chỉnh sửa thuộc tính của hình 

theo yêu cầu; 

− Thực hiện chính xác và cẩn thận các bài tập tạo hình phức tạp; 

NỘI DUNG CHÍNH 

1 CHỨC NĂNG THANH CÔNG CỤ   

Thanh công cụ chứa các công cụ để tạo hình, hiệu chỉnh và tạo các hiệu ứng 

cho các đối tượng. Bạn có thể thu gọn thanh công cụ bằng cách bấm vào biểu 

tượng thu nhỏ bên phải trên cùng, thứ hai từ phải sang (<<). Hoặc tắt nó đi, bằng 

cách bấm vào biểu tượng còn lại (x). 

 

2 CÁC CÔNG CỤ VẼ   

2.1 Công cụ Line  

Công cụ dùng để vẽ các đường thẳng , các đối tượng ở khung làm việc. Công 

cụ này có tất cả 3 tính chất : 

− Stroke color : màu của đường thẳng mà bạn vẽ (bên trái) 

− Stroke height : độ dày (độ đậm) của đường thẳng bạn vẽ (giữa) 

− Stroke style : các loại đường thẳng (nét chấm gạch hay nét đứt chẳng hạn) (bên 

phải) 
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− Scale: độ kéo dãn của hình được vẽ. Nó có thể là None, Normal, Horizontal 

hoặc 

Vertical – tương ứng với không kéo giãn, kéo giãn bình thường, kéo giãn theo 

chiều ngang và theo chiều dọc. 

− Hinting: giúp bảo vệ nét vẽ ở đường cong khỏi bị mờ. 

− Cap: thiết lập dạng thức cho đường kết thúc. 

− Join: xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

Mitter: điều khiển độ sắc nét của Mitter, khi Cap được chọn là Mitter. 

 

Để chỉnh sửa thông số này nếu trong trình làm việc của bạn chưa sẵn có trình 

Properties thì buộc bạn phải khởi động nó bằng cách chọn ở thanh Menu : 

Window/Properties . 

Để tô màu đường nét kiểu gradient , bạn dùng công cụ Arrow (hoặc ấn V) chọn 

vùng mà bạn muốn trượt màu sau đó chọn ở thanh Menu : Modify/Shape/Convert 

 

2.2 Công cụ Rectangle 
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Là công cụ sử dụng để vẽ hình chữ nhật và các dạng biến thể của nó. Dạng 

biến thể này có thể là hình chữ nhật có góc tròn. Hình vuông hay hình bình hành 

cũng là các trường hợp riêng khi sử dụng công cụ này. Khi muốn vẽ hình có tỉ lệ 

chiều rô ̣ng và chiều cao bằng nhau (hình vuông chẳng hạn), ta nhấn phím Shift. 

Khi bấm vào biểu tượng công cụ Rectangle, trong bảng thuộc tính Properties của 

nó, ta chú ý đến các thuộc tính sau đây: 

− Stroke color: chọn màu viền cho nét vẽ. 

− Fill color: chọn màu nền cho nét vẽ. 

− Stroke: kích thước của nét vẽ. 

− Style: dạng thức của nét vẽ. 

− Scale: độ kéo dãn của hình được vẽ. Nó có thể là None, Normal, Horizontal 

hoặc Vertical – tương ứng với không kéo giãn, kéo giãn bình thường, kéo giãn 

theo chiều ngang và theo chiều dọc. 

 

− Hinting: giúp bảo vệ nét vẽ ở đường cong khỏi bị mờ. 

− Cap: thiết lập dạng thức cho đường kết thúc. 

− Join: xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

− Mitter: điều khiển độ sắc nét của Mitter, khi Cap được chọn là Mitter. 

− Rectangle Option: cho phép hiệu chỉnh góc tròn cho hình chữ nhật. Nếu bạn 

chọn 

 Lock Corner Radius Controls to one Control – cho phép chỉnh góc tròn của 

hình chữ nhật theo dạng 4 góc đồng thời hay riêng lẻ - tức là khi bạn hiệu chỉnh 

độ cong của một góc, các góc khác cũng sẽ sao chép số liệu của góc hiệu chỉnh 

này. Các số liệu 4 góc ở phía trên tương ứng với độ cong của các góc. Bạn có 

thể nhập số liệu vào các ô được cung cấp sẵn, hoặc sử dụng thanh trượt ở phía 

bên dưới để hiệu chỉnh độ cong các góc cho hình chữ nhật góc tròn này. 

 Reset: đưa về các số liệu tùy chỉnh mặc định cho các góc tròn 

2.3 Công cụ Oval 
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Vẽ các hình Oval. Khi bấm chọn vào biểu tượng tam giác nhỏ ở phía dưới biểu 

tượng Rectangle, sẽ xuất hiện biểu tượng Oval này.  

 

Khi sử dụng công cụ Oval, ta chú ý đến điểm sau đây: nếu muốn tỉ lệ chiều rô ̣

ng và chiều cao luôn cân bằng nhau (ví dụ khi vẽ hình tròn) thì ta giữ phím Shift và 

vẽ, ngược lại, nếu khô ng nhấnn Shift thı̀ tỉ lệ đó sẽ không cân bằng (ví dụ khi vẽ 

hình Eclipse). Trong bảng thuộc tính Properties, ta có các tùy chọn sau đây: 

− Stroke color: chọn màu cho nét vẽ. 

− Fill color: chọn màu nền cho hình thể. 

− Stroke: chọn kích thước của nét vẽ. 

− Scale: độ kéo dãn của hình được vẽ. Nó có thể là None, Normal, Horizontal 

hoặc Vertical. 

− Hinting: giúp bảo vệ nét vẽ ở đường cong khỏi bị mờ. 

− Cap: thiết lập dạng thức cho đường kết thúc. 

− Join: xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

− Mitter: điều khiển độ sắc nét của Mitter, khi Cap được chọn là Mitter. 

− Oval Option: góc mở Start Angle và góc đóng End Angle giúp tạo hình Oval 

nhờ vào sự giới hạn của hai góc này. Góc mở Start Angle quay theo chiều kim 

đồng hồ, lấy vị trí gốc là vị trí góc 900, số đo của góc chính là số đo góc của 

phần bị khuyết. Góc đóng End Angle quay theo chiều ngược kim đồng hồ, số đo 

góc phần bị khuyết là góc bù 2 của góc này (tức 360-góc đóng).  

Ví dụ:  khi thiết lập góc mở Start Angle là 600, ta thu được hình như sau 
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Trong hình này, góc khuyết có số đo là 600. Góc khuyết sẽ được lấy từ vị trí 

900 và quay theo chiều kim đồng hồ. Nếu ta thiết lập góc đóng End Angle là 600, ta 

sẽ thu được hình như sau: 

Trong hình này, góc khuyết có số đo là 3600-600=3000, hay phần hình thể 

chiếm 600. Góc khuyết sẽ được lấy từ vị trí 900 và quay theo chiều ngược kim đồng 

hồ. Tương tự như trên, ta có thể kết hợp hình thể có số đo góc đóng 600 và góc mở 

1200. Ta sẽ thu được hình thể bên dưới. Phần hình thể được vẽ ra là sự kết hợp của 

cả hai hình tạo bởi góc đóng và góc mở như trên 

− Inner Radius: độ lớn bán kính của đường tròn bên trong. Đây là cách thức để 

tạo hình vành khăn. Hình vành khăn là hình được tạo bởi hai đường tròn đồng 

tâm, những phần chồng khít nhau sẽ bị loại bỏ. 

− Close Path: có tác dụng đối với hình thể tạo bởi góc đóng và góc mở. Nó sẽ tự 

động làm cho các đường kết nối trở nên liền mạch. 

Ví dụ: Hình bên trái không kích hoạt Close Path. Hình bên phải kích hoạt Close 

Path. Như ta thấy, với tùy chọn Close Path, hình thể sẽ được khép kính và thuộc 

tính Fill Color mới có tác dụng. 

 

2.4 Công cụ Rectangle Primitive 

Khi bấm vào biểu tượng hình tam giác nhỏ ở trên công cụ Rectangle, ta sẽ thấy 

xuất hiện công cụ Rectangle Primitive. Tương tự công cụ Rectangle, nhưng với 

công cụ này, ta có thể hiệu chỉnh góc tròn của nó sau khi nó được tạo ra. Đây là 

một ưu điểm của công cụ này 

 

2.5 Công cụ Oval Primitive 
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Hoàn toàn tương tự công cụ Oval. Bạn có thể hiệu chỉnh các thuộc tính góc 

mở, góc đóng, bán kính của hình vành khăn. Và cũng tương tự công cụ Rectangle 

Primitive, ta có thể hiệu chỉnh các thuộc tính của hình đã vẽ nhờ vào các nút nhấn 

nhấn. Nút nhấn trung tâm dùng để điều chỉnh kích thước bán kính vành khăn. Nút 

nhấn biên ngoài dùng để điều chỉnh góc đóng, góc mở. Việc hiệu chỉnh các góc 

đóng, góc mở, bán kính vành khăn cũng nhờ vào công cụ Selection mà chúng ta sẽ 

làm quen trong mục tiếp theo. 

 

Bạn cũng cần lưu ý, cũng giống công cụ Oval, để tạo dựng các hình thể sao cho 

chiều rô ̣ng và chiều cao (như hình tròn) bằng nhau nhờ vào Oval Primitive, ta 

cũng nhấn và giữ Shift khi vẽ hình. Với công cụ này, ta có thể tạo ra các hình dạng 

phức tạp mà không cần hiệu chỉnh các thông số ban đầu như công cụ cùng loại 

Oval. Chỉ cần hiệu chỉnh các nút điều khiển trên các khối hình cơ sở là ta đã nhận 

được những hình biến thể độc đáo. Hình cơ sở của nó cũng là hình chữ nhật (hình 

Oval có biên ngoài nội tiếp hình chữ nhật này) 

2.6 Công cụ PolyStar 

Dùng để vẽ đa giác và hình sao. Khi bấm chọn công cụ này, ta chú ý các tùy 

chọn trong bảng thuộc tính Propeties. 

− Fill color: chọn màu nền cho vật thể 

− Stroke color: chọn màu viền cho nét vẽ.  

− Stroke: chọn kích thước cho nét vẽ. 

− Style: chọn dạng thức cho nét vẽ. 

− Cap: thiết lập dạng thức cho đường kết thúc. 

− Join: xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

− Hinting: giúp bảo vệ nét vẽ ở đường cong khỏi bị mờ. 

− Mitter: điều khiển độ sắc nét của Mitter, khi Cap được chọn là Mitter. 
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− Tool Setting: thiết lập các tùy chọn nâng cao. Khi bấm vào nút Option, sẽ hiện 

ra hộp thoại sau 

 

 

Trong đó: 

 Style: lựa chọn hình dạng của đa giác là đa giác lồi hay hình sao. 

 Number of Sides: số lượng các cạnh đa giác (hay số lượng cánh hình sao). 

 Star point size (SPS): tỉ lệ giữa khoảng cách từ tâm của hình sao đến đỉnh lõm 

của hình sao và khoảng cảnh từ tâm của hình sao đến đỉnh lồi của hình sao. Tỉ 

lệ này nằm trong dải từ 0...1. Nếu tỉ lệ này càng lớn (càng gần 1) thì hình sao 

càng mập, ngược lại, nếu tỉ lệ này càng nhỏ thì hình sao càng gầy. 

Ví dụ: Hình sao mập (tỉ lệ SPS = 0.9) và hình sao gầy (tỉ lệ SPS = 0.1) 

 

2.7 Công cụ Text 

Là công cụ dùng để soạn thảo nội dung văn bản trong Flash. 

− Text Tool có ba loại  
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 Static Text (văn bản cố định – như nội dung của label trong lập trình hướng đối 

tượng) 

 Dynamic Text (văn bản có thể chọn, copy nhưng không thể thay đổi – như nội 

dung của TextBox khi hiệu chỉnh thuộc tính Readonly=True) 

 Input Text (nội dung văn bản có thể thay đổi – như nội dung của TextBox khi 

thuộc tính Readonly=False). 

− Character: Family (chọn loại phông chữ), Style (chọn dạng thức cho phông chữ, 

in đậm, in nghiêng…), Size (chọn kích thước cho phông chữ), Letter Spacing 

(chọn độ rộng cho kí tự trắng giữa các chữ cái), Color (chọn màu cho phông 

chữ), Auto Kern (tự động co giãn), Anti-Alias (làm cho nét chữ trở nên mượt 

mà hơn) 

 

− Show Border around Text: hiển thị đường viền xung quanh văn bản. 

− SubScript và SuperScript: tạo chữ viết dưới (kiểu x2) và viết trên (kiểu x2). 

− Format: can chỉnh vị trí văn bản (trái, phải, giữa, hai phía). 

− Spacing và Margin: Spacing hiệu chỉnh khoảng cách của các từ trong văn bản 

hoặc các dòng văn bản. Margin hiệu chỉnh khoảng cách bên trái hoặc bên phải 

của nội dung văn bản so với viền bên ngoài. 

− Behavior: Single Line (chỉ cho phép văn bản hiển thị trên một dòng – tức không 

chấp nhập kí tự xuống dòng hay nói cách khác, phím Enter sẽ không có hiệu lực 

khi soạn văn bản dạng này), MultiLine (cho phép văn bản hiển thị trên nhiều 

dòng, nếu nội dung văn bản dài hơn khung soạn thảo, nó sẽ tự động xuống dòng 

mà không cần phải nhấn phím Enter), MultiLine no Wrap (cho  phép văn bản 

hiển thị trên nhiều dòng, nếu nội dung văn bản dài hơn khung soạn thảo, nó 

không tự động xuống dòng), Password (nội dung văn bản sẽ bị ẩn dưới một kí 

tự được chọn làm mặt nạ – như các chấm đen hiểnn thi ̣ trong các ô nhập 

password). 
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− Orientation: thay đổi chiều hiển thị của văn bản. Ngoài ra, khi nội dung văn bản 

đã được soạn thảo, ngoài những thuộc tính nêu trên, văn bản còn có thêm một 

số thuộc tính sau đây: 

 Options: các tùy chọn như tạo liên kết trong trang html. Link – đường dẫn đến 

một liên kết nào đó. Target – cách thức mở liên kết, bao gồm _blank, _parent, 

_self và _top 

 Filter: tạo các hiệu ứng nâng cao như tạo đổ bóng, hiệu ứng bóng mờ, hiệu ứng 

cầu vồng… Để sử dụng các hiệu ứng này, bạn chỉ bấm vào biểu tượng đầu tiên 

trong vùng công cụ được tô vàng, từ bên trái sang. Nếu bạn thay đổi một hiệu 

ứng nào đó, và muốn lưu lại thiết lập này, bạn nhấp vào biểu tượng thứ ba từ 

trái sang. Nếu bạn muốn quay lại thiết lập mặc định, hãy nhấp biểu tượng thứ 

hai từ trái sang. Biểu tượng con mắt cho phép bạn tạm ẩn hiệu ứng được chọn. 

Biểu tượng mũi tên quay lùi, cho phép bạn quay lại thiết lập các thông số trước 

đó. Biểu tượng thùng rác cuối cùng, cho phép bạn xóa bỏ một hiệu ứng được 

chọn.  

 

2.8 Công cụ Pencil 

Đối với công cụ Pencil, bạn có thể dùng để vẽ các đối tượng bằng tay. Các 

thuộc tính tương ứng với công cụ Pencil mà bạn có thể hiệu chỉnh là: 

− Stroke color: màu sắc của nét vẽ. 

− Stroke: kích thước của nét vẽ. 

− Style: dạng thức của nét vẽ - đường liền nét, đứt nét… 

− Scale: độ kéo dãn của hình được vẽ. Nó có thể là None, Normal, Horizontal 

hoặc Vertical – tương ứng với không kéo giãn, kéo giãn bình thường, kéo giãn 

theo chiều ngang và theo chiều dọc. 
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− Hinting: giúp bảo vệ nét vẽ ở đường cong khỏi bị mờ. 

− Cap: thiết lập dạng thức cho đường kết thúc. 

− Join: xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

− Mitter: điều khiển độ sắc nét của Mitter, khi Cap được chọn là Mitter 

 

2.9 Công cụ Brush (phím B)  

Cũng tương tự công cụ Pencil, Brush cũng được dùng để vẽ. Chỉ có một khác 

biệt là nét vẽ của Brush không bao gồm viền chỉ có màu nền, còn Pencil thì ngược 

lại chỉ có màu viền không có màu nền. Các thuộc tính của Brush bao gồm: 

− Fill color: chọn màu cho nét vẽ brush. 

− Smoothing: độ mềm dẻo cho nét vẽ 

 

2.10 Công cụ Spray Brush 

Khi bạn bấm vào biểu tượng tam giác nhỏ ở trên biểu tượng Brush, thì sẽ xuất 

hiện biểu tượng của Spray Brush. Đây là công cụ phun màu tuyệt vời của Flash. 

Bạn có thể định nghĩa mẫu màu để phun, các chế độ phun màu: góc nghiêng, độ 

rộng, độ cao, chế độ xoay các biểu tượng theo góc ngẫu nhiên,…  
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Để tự định nghĩa một mẫu màu tô, bạn phải tạo một biểu tượng – hoặc là 

Graphic, Button hoặc MovieClip. Chúng ta sẽ thảo luận chi tiết về chúng trong 

chương 3. Ở đây, để minh họa cho một mẫu tô màu, chúng ta sẽ sử dụng biểu 

tượng MovieClip mà không thảo luận thêm về nó. Để tạo một kiểu phun màu như 

trong hình minh họa, hãy làm theo các bước sau: 

Bước 1: Định nghĩa một mẫu màu. Bạn hãy vẽ một hình đại diện. Ví dụ trong 

trường hợp của tôi, tôi sử dụng hình ngôi sao 10 cánh có chiều dài của các cánh 

xen kẻ nhau – tức là cánh dài, cánh ngắn liên tiếp nhau. 

Bước 2: Hiệu chỉnh kích thước của nó sao cho phù hợp. Kích chuột phải vào 

nó, chọn Convert to Symbol > MovieClips và nhấp Ok. 

Bước 3: Bấm chọn công cụ Spray Brush. Trong bảng Properties, chọn mục 

Symbol, chọn nút Edit, và chọn biểu tượng mà ta vừa tạo. Sau đó, bạn hãy hiệu 

chỉnh các thuộc tính trên bảng Properties này như: độ kéo rộng của biểu tượng 

khi phun (scale width), độ kéo theo chiếu cao của biểu tượng khi phun (scale 

height), độ rộng của đường phun (width), độ cao của đường phun (height), góc 

phun (Brush angle). Các chế độ tạo mẫu ngẫu nhiên: độ kéo giãn của biểu tượng 

(random scaling), góc xoay của biểu tượng (rotate symbol), góc phun (random 

rotation). 

 

2.11 Các công cụ xoá   

Công cụ dùng để xoá các nét vẽ 

2.12 Công cụ SubSelection 

Nhấp chọn biểu tượng SubSelection, sau đó bấm vào đối tượng. Khi đó, đường 

viền của đối tượng sẽ hiện ra các đường Bezier cấu thành nên vật thể. Các điểm 

được đánh dấu bằng chấm tròn được gọi là các điểm điều khiển đường Bezier. 
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Với công cụ này, ta có thể hiệu chỉnh vị trí của các điểm này. Điểm điều khiển 

trong đường Bezier cũng chia làm hai nhóm: nhóm điểm góc cạnh và nhóm điểm 

uốn cong. Bạn có thể nhận thấy chúng – hình vuông, chữ nhật tạo nên từ các điểm 

góc cạnh; đường tròn, eclipse được tạo từ các điểm uốn cong. 

  

2.13 Công cụ Pen 

Công cụ này dùng để vẽ các đường đa giác bằng cách tạo các điểm điều khiển, 

sau đó, tự động nối các điểm này lại với nhau. Các thông số liên quan đến công cụ 

này hoàn toàn tương tự với công cụ Line. Khi sử dụng công cụ Pen, bạn cũng lưu ý 

rằng, nếu bạn tạo hình thể có dạng đường thẳng, bạn chỉ việc nhấp vào nút đầu và 

nút cuối. Nếu bạn muốn tạo dạng đường cong, ba ̣n cần rê chuột liên tiếp để hiệu 

chỉnh đường điều khiển của nó. 

 
2.14 Công cụ Add Anchor Point và Delete Anchor Point 

Công cụ Add Anchor Point dùng để bổ sung thêm điểm điều khiển cho đường 

Bezier, ngược lại, Delete Anchor Point xóa bớt đi các điểm điều khiển cho đường 

Bezier.  

Để bổ sung thêm điểm điều khiển, ta chỉ việc chọn công cụ Add Anchor Point, 

sau đó bấm vào một vị trí trên đường biên. Để xóa đi điểm điều khiển, ta chỉ việc 

chọn công cụ Delete Anchor Point, sau đó bấm vào một điểm điều khiển cần xóa 

bỏ.  
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Việc bổ sung và xóa bỏ các điểm điều khiển rất hữu ích trong việc tạo các 

đường uốn. Với các đường uốn đặc thù, ta cần bổ sung vào một số lượng điểm điều 

khiển tối ưu cho việc hiệu chỉnh. Ta có thể lấy ví dụ: đối với đường Parabol, ta chỉ 

cần ba điểm điều khiển; với đường đồ thị hàm số đa thức bậc ba ta cần bốn điểm 

điều khiển. 

Các điểm điều khiển là các điểm nằm trên đường biên. Những điểm không nằm 

trên đường biên là các điểm thuộc đường điều khiển. 

 

2.15 Công cụ Convert Anchor Point 

Dùng để chuyển đổi điểm điều khiển góc cạnh thành điểm điều khiển uốn 

cong. Ngoài ra nó còn có chức năng hiệu chỉnh góc uốn nhờ vào các đường điều 

khiển.  

Chức năng này tương đối giống với chức năng hiệu chỉnh góc cạnh của công 

cụ SubSelection. Nhưng điểm khác biệt ở chỗ, công cụ Convert Anchor Point hiệu 

chỉnh các đường điều khiển một cách độc lập (tại một điểm điều khiển có hai 

đường điều khiển bên trái và bên phải.  

Công cụ này hiệu chỉnh các đường điều khiển bên trái và bên phải một cách 

riêng biệt.), trong khi đó công cụ SubSelection hiệu chỉnh đồng thời hai đường 

điều khiển này (điểm uốn đối xứng). Để chuyển đổi điểm điều khiển góc cạnh 

thành điểm uốn cong, ta chỉ việc chọn công cụ và nhấp vào điểm cần chuyển đổi. 

Để hiệu chỉnh góc xoay cho các đường điều khiển, ta chỉ việc xoay các đường điều 

khiển 

 

3 NHÓM CÔNG CỤ COLORS   

3.1 Công cụ Paint Bucket 

Đây là công cụ dùng để đổ màu nền cho vật thể. Khi kích vào biểu tượng này 

trên thanh công cụ, trên bảng thuộc tính Properties sẽ hiện ra các thông số liên 

quan: 
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Fill color: đổ màu nền cho đối tượng. Để đổ màu bên trong đối tượng, bạn cần 

lưu ý rằng khung viền bao quanh nó cần phải kín. Nếu có một khoảng hở trên 

đường viền này, thì công cụ không hoạt động (khác với các trình biên tập khác, 

thường thì trong trường hợp này, công cụ sẽ đổ màu lên cả những phần liền kề 

nó). Đó cũng chính là ưu điểm của công cụ này trong Flash của Adobe. Với công 

cụ này, bạn có thể tạo ra những hiệu ứng màu phức tạp. Nó hỗ trợ các chế độ màu 

RGB, HSL, chế độ màu Alpha, chế độ không màu, màu dạng kiểu cầu vồng. Bảng 

màu của Paint Bucket không cho phép bạn hiệu chỉnh dải màu cầu vồng với các 

màu tùy chọn, để làm điều này bạn cần kết hợp với bảng màu đầy đủ 

(Windows>Color). Trong hộp thoại màu này, cho phép bạn có thể sử dụng các 

kiểu pattern, bitmap và dải màu cầu vồng tùy chọn để đổ màu nền cho đối tượng. 

Nhưng bạn cũng lưu ý rằng, nó cần kết hợp với công cụ Paint Bucket này. 

 

3.2 Công cụ Ink Bottle 

Đây là công cụ dùng để đổ màu viền. Khi bấm chọn vào biểu tượng tam giác 

đen 

nhỏ ở trên biểu tượng Paint Bucket, sẽ xuất hiện biểu tượng công cụ Ink Bottle. 

 

Khi bấm vào biểu tượng này, trên vùng thuộc tính Properties sẽ xuất hiện các 

thuộc tính liên quan: 

− Stroke color: chọn màu viền.S 
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− troke: chọn kích thước cho viền. 

− Style: chọn dạng thức cho viền. 

− Cap: thiết lập dạng thức cho đường kết thúc. 

− Join: xác định cách mà hai phân đoạn của đối tượng nối với nhau. 

− Mitter: điều khiển độ sắc nét của Mitter, khi Cap được chọn là Mitter. 

3.3 Công cụ EyeDropper 

Đây là công cụ dùng để lấy thông số màu tại một vị trí trên đối tượng. Ta chỉ 

việc chọn biểu tượng, sau đó kích vào một vị trí nào đó trên bức ảnh (vị trí mà ta 

cần 

lấy thông số màu), khi đó, thông số màu nền mặc định sẽ là màu của vị trí mà bạn 

vừa kích chuô ̣t vào. 

3.4 Bảng màu 

Màu thực sự mạnh và hiệu quả trong việc diễn tả tông của thiết kế hoặc cảm 

xúc của nhân vật hoạt hình ban đang vẽ. Chúng ta sẽ chỉnh màu sử dụng bảng trộn 

màu HSB. 

Trước hết, hãy chuyển chế độ màu từ RGB sang HSB. Chế độ mặc định RGB 

là chế độ trộn màu dựa theo tỉ lệ 3 màu cơ bản: Red-Green-Blue. Chế độ HSB (hay 

HSV) là chế độ trộn màu dựa theo tỉ lệ của: 

− H (Hue) – Vùng màu 

− S (Saturation) – Độ bão hòa màu 

− B (Bright hay V - Value) – Độ sáng 

 

Thay đổi giá trị S sẽ tạo sự tương phản giữa các màu với nhau. Chỉnh các giá 

trị HSB sẽ giúp bạn thay đổi tông của thiết kế nhằm giúp thiết kế phù hợp với 

những gì có sẵn trước đó. 

Ví dụ:  
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3.5 Công cụ  Gradient 

Các hình ảnh được tạo ra với màu được đổ bóng thường đem lại hiệu quả cao 

về mặt thẩm mỹ, tạo cảm giác ba chiều. Sau đây chúng ta sẽ học sử dụng cách đổ 

màu theo chế độ gradient để được được điều trên. 

Ví dụ: vẽ các mũ 

Tạo 2 lớp chứa Đầu – Mắt 

 

 

− Để gây cảm giác đổ bong cho đầu robot, ta sử dụng loại màu Radial 
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− Màu ở phía trái ngoài cùng tương ứng với màu ở tâm của hình. Số lượng loại 

màu biến đổi là nhiều tùy ý 

− Để chỉnh cho bóng phần mắt hợp với phần đầu, ta dùng chức năng Gradient 

Transform Tool 

 

 

3.6 Công cụ Gradient Transform 

Nhờ vào công cụ này, ta có thể hiệu chỉnh các thông số khi đổ màu cầu vồng 

cho đối tượng. Sau khi tạo màu cầu vồng cho đối tượng, ta bấm chọn vào biểu 

tượng tam giác đen trên công cụ Free Transform, và lú c này sẽ xuất hiện công cụ 

Gradient Transform, bạn chỉ việc bấm chọn nó.  

Sau đó, bấm chuôṭ vào vùng màu cầu vồng. Trên vùng màu này, sẽ hiện ra một 

dạng thức đổ màu như hình bên trên. Bạn chỉ việc hiệu chỉnh hình bao củ a khung 

màu này như: kéo to (tăng kích thước vùng sáng), thu nhỏ (giảm kích thước vùng 

sáng), hiệu chỉnh vị trí của tam giác (thay đổi tâm của vùng sáng), bấm vào nút 

tròn và dịch chuyển nó (thay đổi vị trí vùng màu). 
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3.7 Sử dụng ảnh làm texture 

Đôi khi việc đổ màu theo cách trên chưa đạt được hiệu ứng cần thiết, đăc biệt 

với những chi tiết phức tạp như vỏ cây, bãi cỏ … thì cách đổ màu dựa vào 1 ảnh 

bit map lại là 1 cách tốt hơn để giải quyết vấn đề trên 

Ví dụ: 

Chuẩn bị trước ảnh để làm họa tiết, ảnh nên đủ nhỏ để có thể xuất file flash lên 

web 

    

− Chọn Paint Bucket Tool, sau đó chỉnh chế độ màu sang Bitmap 

− Chọn ảnh bitmap tương ứng sau đó tô màu như bình thường, ta có kết quả như 

sau 
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4 CÁC CÔNG CỤ CHỌN  

4.1 Công cụ Selection 

 

Với công cụ này, bạn có thể chọn đối tượng, một phần đối tượng bằng cách 

kích đôi chuột vào nó hoặc bôi đen một phần của nó. Bạn có thể kéo giãn, uốn các 

biên của hình thể (khi con trỏ chuột đặt ở các biên của hình và nó có dạng như 

biểu tượng Selection bổ sung thêm đường cong màu đen). 

4.2 Công cụ Lasso 

Tương tự công cụ Selection, công cụ Lasso cũng cho phép chọn. Điểm khác 

biệt là công cụ Selection dùng để chọn toàn bộ một hay nhiều đối tượng (bằng cách 

giữ phím Shift) hoặc một phần đối tượng theo khung chọn là hình chữ nhật. Còn 

công cụ Lasso có thể chọn theo hình dạng phức tạp.  Chúng ta chọn Lasso và vẽ ra 

khung chọn. Nó không nhanh bằng Selection nhưng tỏ ra hiệu quả trong nhiều 

trường hợp, nếu các đối tượng được chọn nằm phân tán hoa  ̣c buộc phải chọn một 

phần đối tượng. Cũng tương tự Selection, ta có thể giữ  hím Shift để chọn theo 

nhiều vùng khác nhau. Công cụ Lasso không thể dùng để tinh chỉnh đối tượng. Khi 

bấm vào biểu tượng này, sẽ xuất hiện thêm các công cụ  on bao gồm Magic Wand, 

Magic Wand Setting và Polygon Mode 

 

− Magic Wand Setting: 
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 Threshold – số pixel cho phép sai số khi choṇ,  

 Smoothing – cách thức làm mươṭ nét choṇ (bao gồm: pixel, rough, normal và 

smoothing). 

− Polygon Mode là cô ng cu ̣cho phép choṇ theo các đường gấp khúc phức tap̣.  

4.3 Công cụ Free Transform 

Đây là công cụ để tinh chỉnh góc cạnh, xoay đối tượng. Để sử duṇg công cu ̣

này, ta bấm chọn biểu tượng công cu ̣ trên thanh công cụ , sau đó chọn đối tượng 

cần hiêụ chı̉nh.  

Ta có thể thay đổi sự dịch chuyển tương đối của các phần đối tượng nếu ta đặt 

trỏ chuột theo cách cạnh của đối tượng và dịch chuyển nó. Nếu muốn phóng to, thu 

nhỏ đối tượng, ta chỉ đặt trỏ chuột vào các nút của đối tượng, và kéo ra ngoài nếu 

muốn tăng kích thước và kéo vào trong nếu muốn làm giảm kích thước.  

Nếu muốn xoay đối tượng, ta nhấn vào nút ở các góc của đối tượng, và xoay 

đối tượng. Khi làm việc với các đối tượng bằng công cụ này bạn cần lưu ý đến 

chức năng xoay đối tượng. 

 

 

Mặc định, khi ta tạo một đối tượng thì đối tượng đó đã tồn tại một tâm xoay 

(khi xoay đối tượng, đối tượng sẽ quay quanh tâm xoay này). Bạn có thể hiệu 

chỉnh vị trí của tâm xoay này bằng cách bấm chọn nó và di chuyển. Trên hình vẽ 

trên, bạn có thể thấy sự thay đổi vị trí của tâm xoay trên đối tượng.  

Ở đối tượng bên trái, tâm xoay nằm ở chính giữa của đường thẳng, còn ở hình 

bên phải, tâm xoay được dịch chuyển xuống góc phía dưới. 
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BÀI 3: LỚP VÀ KHUNG HÌNH 

Mã bài: MĐ 31_03  

GIỚI THIỆU 

Trong Flash khái niệm về Lớp và khung nhìn là hoàn toàn mới đơi với bạn. để sử 

dụng thành thọa Flash bạn phải nắm được 2 khái niêm này.ngaoif ra bài này còn 

hương dẫn bạn làm việc với lớp, khung nhìn và tạo chuyển động bằng phương 

pháp Frame by frame 

MỤC TIÊU 

− Trình bày khái niệm và chức năng của lớp, khung hình, bảng tiến trình; 

− Thao tác với các lớp và khung hình; 

− Vận dụng lớp mặt nạ và lớp chỉ dẫn thực hiện bài tập chuyển động; 

NỘI DUNG CHÍNH 

1 VAI TRÒ CỦA BẢNG TIẾN TRÌNH  (Timeline) 

TimeLine là vùng tương tác để tạo ra chuyển động trong movie của Flash. Để 

tạo ra chuyển động, TimeLine thay thế từng Frame một theo thời gian. 

 

Trong TimeLine, bạn có thể  dễ dàng thấy được ba phần chính: Phần quản lý 

Layer (bên trái), Phần quản lý Frame (phía trên bên phải) và Phần quản lý Công cụ 

(phía dưới bên phải). - Layer: quản lý các lớp đối tượng. Mỗi một đối tượng trên 

Layer sẽ có một thanh TimeLine của riêng mình.  

Trong trường hợp minh họa trên, thì đối tượng trên Layer 1 nằm trên TimeLine 

phía dưới và đối tượng trên Layer 2 nằm trên TimeLine phía trên. - Thanh 

TimeLine: chứa nhiều Frame. Khi tạo ra chuyển động, các Frame sẽ lần lượt thay 

thế cho nhau. Frame sau sẽ thay thế cho Frame trước đó. Ta có thể xem qua hành 

động bằng cách kéo Frame hiện tại (Frame đánh dấu màu đỏ) sang trái hoặc phải 

trên TimeLine.  
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− Các chức năng hiển thị trên thanh Timeline: Trong biểu tươṇg menu thả xuống 

nằm phı́a trên bên phải có các chức na ng sau: Tiny (siêu nhỏ ), Small (nhỏ), 

Normal (bı̀nh thườ ng), Medium (trung bı̀nh), Large (lớn), Preview (xem rõ 

hı̀nh),  review in Context (xem rõ hı̀nh theo ngữ cảnh).  

− Vùng thanh công cụ - gồm các công  cụ sau đây:  

 Center Frame: xác định Frame trung tâm 

 Onion Skin: cho phép hiển thị toàn bộ hình ảnh của đối tượng trên vùng Frame 

được chọn. Sự hiển thị này bao gồm toàn bộ đối tượng 

 

 Onion Skin Outlines: cho phép hiển thị toàn bộ hình ảnh của đối tượng trên 

vùng Frame được chọn. Sự hiển thị này chỉ bao gồm viền của đối tượng.  

 Edit Multiple Frames: cho phép hiển thị đối tượng gốc trên toàn bộ đối tượng 

hiển thị theo hai chức năng Onion Skin ở trên. Khi đó, ta có thể chỉnh sửa đối 

tượng 

 Các thông số khác: Current Frame – vị trí của Frame hiện tại (Frame đươc̣ đánh 

dấu đỏ ). Frame rate – tốc độ chuyển động (tính bằng số Frame trên giây). 

Thông số Frame rate càng lớn, thı̀ phim se ̃càng diễn ra nhanh. Theo chuẩn của 

kı ̃thuâṭ 24 hı̀nh trên giây thı̀ tốc đô ̣này là 24fps. Hiển nhiên, ba ̣n có thể thay 

đổi giá tri ̣này. Tuy nhiên, điều này không đươc̣ khuyến khı́ch vı̀ nó là chuẩn 

quốc tế. Elapsed Time – thời gian thực thi từ vi ̣ trı́ đầu tiên (frame 1) cho đến 

Frame hiêṇ taị (current Frame) trên thanh TimeLine.  

 

2 LỚP    

2.1 Lớp mặt nạ   
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Layer mask  là kiểu layer che, chỉ hiển thị các hình ảnh trong các layer bị 

che (Masked layer ) thông qua hình shape bên trong nó. Có tác dụng tạo khuôn 

cho hình một cách linh hoạt  

Khi Mask Layer có hiệu lực thì bạn không nhìn thấy nội dung của Mask Layer 

mà chỉ nhìn thấy những gì bị Mask Layer che khuất trước đó. 

 

Ví dụ minh hoạ bên dưới ta có layer "mặt nạ" là layer mask có nội dung là một 

hình shape hình trái tim. Còn layer "bi che" là masked layer có hình ảnh nền là cặp 

diễn viên 

 

2.2 Lớp chỉ dẫn (Guide Layer) 

 Lớp guide là lớp có nội dung là các đường định hướng chuyển động cho các 

đối tượng, khi xuất File thì nội dung của lớp Guide không được hiển thị. 

Ví dụ: đối tượng trên Layer 1 sẽ chuyển động theo đường định hướng trên 

Guide layer đặt trên nó. 

 

3  KHUNG NHÌN   (Frame) 

3.1 Khái niệm    
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Khung nhìn dùng trong kỹ thuật tạo chuyển động, vật thể chuyển động đước là 

nhờ kỹ thuật thay thế khung nhìn, mắt người chỉ có thể lưu không quá 24 

frame/giây 

3.2 Phân loại   

− Frame: là nơi biểu diễn thời gian, dựa vào tỷ lệ khung hình/ giây 

  Được hiển thị bởi các ô nhỏ đi ngang qua Layer 

 Tỷ lện khung hình/ giây mặc định 24fps 

− Key Frame: là nơi đặt đối tượng hoặc thời điểm bắt đầu/ kết thúc một hành 

động trên Time line 

 Một key frame có thể kéo dài tuỳ thuộc vào thời gian muốn nội dung của key 

frame đó được hiển thị 

 Theo mắc định, mỗi layer mới trong Timline chứa một keyframe tại frame thứ 

nhất. 

3.3 Một số thao tác làm việc với Frames 

 Thêm một Frame/ KeyFrame 

− Phím F5: chèn Frame vào thanh TimeLine (tương ứng với Insert Frame). Nếu 

vùng TimeLine trong thanh TimeLine đã được tạo Tween, thì nó sẽ tự động 

giãn vùng Tween này (chèn thêm Frame vào trong vùng Frame đã tạo Tween, 

các Frame mới tạo này cũng kế thừa Tween). Nêu chưa ta ̣o Tween, thı̀ nó đơn 

thuần sao chép toàn bô ̣các đối tươ ̣ng trên keyframe liền ngay trước vi ̣ trı́ của 

frame đươc̣ chèn. Khi thay đổi các đối tươṇg của bất kı̀ môṭ frame nào trong 

khoảng này thı̀ các các đối tươṇg trên các frame khác cũng se ̃đươc̣ câp̣ nhâṭ 

theo. 

− Phím F6: chèn KeyFrame vào thanh TimeLine (tương ứng với Insert 

KeyFrame). Frame cuối cùng khi chèn là một KeyFrame.  

− Với KeyFrame này, ta có thể tạo điểm chốt cho hành động trong một movie. 

Khi kết hợp với Tween, nó sẽ tạo một chuyển động mềm mại cho movie của 

Flash.  

− Điểm khác biêṭ khi sử duṇg Keyframe so với frame thông thường là frame 

thông thường chı̉ đơn thuần sao chép các đối tươṇg của keyframe trước đó để 

taọ ra môṭ daỹ các khung hı̀nh giống nhau. Trong khi đó, keyframe se ̃  taọ ra 

điểm chốt. Nó cũng sao chép toàn bô ̣các đối tươṇg của keyframe trước đó sang 

các frame liền ngay trước keyframe taọ ra điểm chốt. Nhưng khi ta thay đổi đối 

tươṇg ở keyframe mới tạo ra này, thı̀ các đối tượng trên các frame khác không 

thay đổi.  
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− Trong ví dụ này, chúng ta sẽ tạo một hình chữ nhật có nền trắng và viền đen 

(Hình 68). Tại Frame thứ 5, bạn nhấp vào Frame này, nhấn phím F5. Sau đó, 

bạn thay đổi độ lớn của viền (thuộc tính Stroke = 5). Giờ bạn hãy kiểm 

tra độ lớn của viền trên mọi Frame. Như bạn thấy, viền của tất cả hình chữ nhật 

trên mọi Frame đều thay đổi thành 5. 

− Bây giờ, bạn hãy làm ví dụ trên bằng cách thay phím F5 bằng phím F6. Bạn sẽ 

thấy rằng thuộc tính Stroke sẽ không thay đổi trên mọi Frame, chỉ thay đổi duy 

nhất ở KeyFrame cuối cùng (KeyFrame mà bạn hiệu chỉnh). 
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− Như vậy, bạn có thể thấy rằng, nếu bạn muốn sao chép một Frame cho các 

Frame tiếp theo, bạn sử dụng phím F5.  

− Ngược lại, nếu bạn muốn tạo một sự thay đổi, bạn cần sử dụng phím F6.  

− Sao chép và cắt dán một nhóm Frame: để thực hiện chức năng này, bạn hãy bôi 

đen nhóm Frame mà bạn muốn sao chép hoặc cắt dán,  au đó bạn kích chuột 

phải và chọn Copy Frames hoặc Cut Frames. Sau đó chọn Paste Frames 

 

 Clear Frames, Clear KeyFrame và Remove Frames 

− Clear Frames sẽ làm cho các đối tượng trên Layer của Frame được chọn sẽ bị 

xóa đi. Hay nói cách khác, Clear Frames sẽ tạo ra hai KeyFrame ở vị trí bắt đầu 

và kết thúc của nhóm Frame được đánh dấu. Tương ứng với vị trí đầu tiên, nó 

sẽ chèn một Blank KeyFrame (là một KeyFrame nhưng không chứa đối tượng 

nào trên nó) và KeyFrame tương ứng với vị trí kết thúc.  

− Clear KeyFrame cũng tương tự như Clear Frame, nhưng nó áp dụng cho một 

KeyFrame. Còn Remove Frames sẽ xóa sạch các Frame này lẫn đối tượng trên 

nó. 

− Convert to KeyFrames và Convert to Blank KeyFrames: chuyển đổi một Frame 

thành KeyFrame hoặc Blank KeyFrame.  

− Insert Blank KeyFrame: chèn một Blank KeyFrame.  

− Reverse Frames: cho phép lật ngược thứ tự của một nhóm Frame. Để thực hiện 

chức năng này, bạn bôi đên nhóm Frame, kích chuột phải và chọn Reverse 

Frame. Với chức năng này, bạn có thể tạo ra một chuyển động mang tính đối 

xứng. Tạo chuyển động nhờ vào kĩ thuật “Frame by Frame” Đây là kĩ thuật tạo 
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chuyển động dựa trên cơ sở của kĩ thuật 24 hình/giây. Các Frame sẽ hiển thị 

tuần  ự trên Scene. Sự hiển thị từng Frame một này tạo ra chuyển động cho đối 

tượng. Ta sẽ minh họa kĩ thuật “Frame by Frame”.  

Ví dụ: 

Minh hoạ cách tạo hiệu ứng động cho các kí tự trong từ “Flash”.  

Bước 1. Sử dụng công cụ Text, tạo một dòng văn bản có nội dung là “Flash”. 

Bước 2. Chọn công cụ Selection. Bấm vào dòng văn bản sau đó kích chuột 

phải và chọn Break Apart.  

Bước 3. Nhấp chọn Frame thứ hai trong TimeLine. Nhấp phím F6. Sau đó bấm 

chọn kí tự đầu tiên – kí tự F và dịch chuyển nó lên trên so với các kí tự còn lại 

hoặc thay đổi màu sắc của nó. 

Chọn Frame thứ ba trong TimeLine. Nhấp phím F6. Sau đó tiếp tục với kí tự 

thứ hai – kí tự l. Quá trình này cứ tiếp diễn cho đến kí tự cuối cùng là kí tự h.  

Bước 4. Nhấp Ctrl+Enter để kiểm tra sản phẩm. Với kĩ thuật Frame by Frame, 

bạn hoàn toàn có thể tạo ra hoạt cảnh. Nhưng một nhược điểm của kĩ thuật này là 

nếu bạn muốn tạo một hiệu ứng mềm mại thì bạn phải thao tác rất mất thời gian. 

Flash cung cấp cho bạn các phương pháp sau đây để tạo chuyển động với tên gọi là 

Tween.  

Có ba phương pháp Tween: Classic Tween, Motion Tween và Shape Tween. 

Về cơ bản, chúng có nhiều điểm tương đồng và nhiều điểm khác biêṭ đa c̣ trưng. 

Chúng ta sẽ lần lượt khảo sát ba loại Tween này. 
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BÀI 4: ÂM THANH, HÌNH ẢNH, VIDEO 

Mã bài: MĐ 31_04 

GIỚI THIỆU 

Bài này giới thiệu về khái niệm, phân loại tập tin ảnh, âm thanh, video. Hướng dẫn 

cách đưa tập tinh ảnh, âm thanh, video vaog file flash và các xử lý các tập tin đó 

MỤC TIÊU 

− Phân biệt được các dạng File hình; 

− Kết hợp các File hình, âm thanh và Video vào File Flash để tạo ra các bài tập 

phù hợp yêu cầu; 

NỘI DUNG CHÍNH 

1 TẬP TIN HÌNH ẢNH    

1.1 Ảnh vectơ    

 

Ảnh Bitmap- gọi theo từ kỹ thuật là ảnh mành hóa (Rater Image)- dùng lưới 

các điểm ảnh, tức pixel, để biểu thị hình ảnh. Mỗi pixel (điểm ảnh) được gán một 

vị trí và gán giá trị mầu cụ thể. Ảnh Bitmap là ảnh được tạo bởi ma trận các điểm 

ảnh 

1.2 Ảnh Bitmap    

 

Ảnh Vector được tạo bởi các đoạn thẳng và đường cong đuợc định nghĩa bằng 

các đối tượng toán học gọi là Vector. Hình Vector mô tả hình ảnh dựa trên các 

thuộc tính hình học của hình ảnh đó. Chỉnh ảnh Vector là chỉnh thuộc tính của đối 

tượng đó: mấu chốt là của xử lý ảnh Vector là ở chỗ này. 

1.3 Ảnh Gif động   
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Ảnh.gif thông thường là những bức ảnh được hình thành từ những chuyển 

động liên tục do nhiều bức ảnh ghép lại bởi các phần mềm chuyên dụng như: Easy 

GIF animator, Photoscape hoặc Photoshop. Hoặc do việc cắt và xử lý từ một video, 

clip. 

2 TẬP TIN ÂM THANH, HÌNH ẢNH, VIDEO   

2.1 Import âm thanh, hình ảnh và video vào thư viện  

Mặc dù chức năng Import to Library hỗ trợ cả chức năng Import Video, nhưng 

bạn nên sử dụng chức năng này chỉ cho âm thanh và hình ảnh. Riêng với video, 

bạn nên sử dụng chức năng Import Video.  

Cả hai chức năng này đều được tổ chức trong menu File>Import. 

2.2 Xử lý âm thanh 

 Có 2 loại âm thanh chính trong tập tin SWF: (Chỉ áp dụng cho file âm thanh 

dạng wave hoặc mp3) 

Âm thanh sự kiện (event sounds): Thường là những đoạn âm thanh ngắn được 

khởi động bằng 1 sự kiện nào đó (tiếng click chuột lên button... ). kiểu âm thanh 

này cần phải được tải vào máy hoàn toàn trước khi sử dụng,  

Âm thanh phân dòng (stream sounds): Thích hợp cho các đoạn nhạc dài làm 

âm thanh nền, có thể phát trước khi toàn bộ bài nhạc download hoàn toàn, nhưng 

không phù hợp cho âm thanh lặp (loop) như nhạc, tiếng nói. Loại âm thanh này có 

thể đồng bộ hoá với hoạt cảnh trong Movie 

Sau khi import một file âm thanh vào trong thư viện, ta có thể hiệu chỉnh thuộc 

tính của nó. Bạn hãy chọn file âm thanh vừa nhập vào, kích chuột phải và chọn:  

− Properties.  

− Hoặc Edit with Soundbooth.  

Bảng thuộc tính của âm thanh sẽ có dạng như sau 
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Bạn có thể nghe qua âm thanh nhờ vào chức năng Test, dừng chơi nhờ chức 

năng Stop, thay đổi file nguồn nhờ chức năng Import,… Đặc biệt, bạn có thể thay 

đổi định dạng nén cho file âm thanh nhờ vào Compression.  

Để xử lý âm thanh trong Flash, Adobe đã cung cấp cho ta một trình tiện ích 

riêng dành cho nhiệm vụ này đó là Adobe SoundBooth. Với SoundBooth, bạn có 

thể thay đổi định dạng âm thanh (bao gồm cả video), trích tách âm thanh khỏi 

video, bổ sung các hiệu ứng cho âm thanh, trích tách một phần của file âm 

thanh,… và nhiều tính năng khác. 

Bạn có thể nghe qua âm thanh nhờ vào chức năng Test, dừng chơi nhờ chức 

năng Stop, thay đổi file nguồn nhờ chức năng Import,… Đặc biệt, bạn có thể thay 

đổi định dạng nén cho file âm thanh nhờ vào Compression.  

Để xử lý âm thanh trong Flash, Adobe đã cung cấp cho ta một trình tiện ích 

riêng dành cho nhiệm vụ này đó là Adobe SoundBooth. Với SoundBooth, bạn có 

thể thay đổi định dạng âm thanh (bao gồm cả video), trích tách âm thanh khỏi 

video, bổ sung các hiệu ứng cho âm thanh, trích tách một phần của file âm 

thanh,… và nhiều tính năng khác. 
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Chúng ta sẽ thảo luận qua một vài chức năng trong SoundBooth.  

− Trích xuất một phần file âm thanh: bạn hãy dùng trỏ chuột và bôi đen phần âm 

thanh trên biểu đồ phổ của nó. Kích chuột phải và nhấp chọn Crop. Sau đó nhấp 

Save As và chọn định dạng xuất bản. Để kiểm tra phần âm thanh được chọn có 

đúng hay không, bạn hãy kéo thanh biểu diện trạng thái hiện tại đến các vị trí 

cần kiểm tra, sau đó nhấp Play.  

− Tạo hiệu ứng cho âm thanh: bạn hãy chọn mục effect bên cạnh, và chọn hiệu 

ứng cần áp dụng.  

Khi sử dụng âm thanh trong phim Flash, bạn cần tạo riêng một Layer cho nó. 

Bạn cần đảm bảo các phần âm thanh của bạn phải tương ứng với các hoạt cảnh 

trong phim. Điều đó sẽ giúp phim của bạn thật hơn, sinh động hơn.  

2.3 Xử lý hình ảnh  

Sau khi import một file hình ảnh vào trong thư viện, ta có thể hiệu chỉnh thuộc 

tính của nó. Bạn hãy chọn file âm thanh vừa nhập vào, kích chuột phải và chọn:  

− Properties.  

− Hoặc Edit with PhotoShop.  

Bảng thuộc tính của hình ảnh sẽ có dạng như sau.  

 

Chức năng trong bảng thuộc tính này tương tự với chức năng thuộc tính của âm 

thanh. Đối với hình ảnh khi nén bằng JPEG, bạn có thể chọn độ nén cho hình ảnh 

để giảm kích thước tập tin sau khi xuất bản.  

Để xử lý hình ảnh trong Flash, Adobe cho phép ta chỉnh sửa chúng bởi chương 

trình chuyên dụng là Adobe Photoshop. Có lẽ, đây là chương trình mà bạn đã quá 

quen thuộc 
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2.4 Xử lý video  

− Đây có thể là chức năng thú vị của Flash. Bạn hoàn toàn có thể sử dụng Flash 

để tạo các kĩ xảo điện ảnh (dù rằng đây không phải là chương trình chuyên 

dụng. Nếu bạn quan tâm, bạn có thể tham khảo chương trình Adobe Premier và 

Adobe After Effect trong cùng gói Master CS5 này).  

− Để làm việc với video, Flash cung cấp cho ta tiện ích Adobe Media Encoder để 

chuyển các tập tin video thành tập tin cho phép sử dụng trong Flash là flv hoặc 

f4v.  

− Để chuyển đổi, bạn chỉ việc chọn Export Setting và hiệu chỉnh các thông số cần 

thiết. Với tiện ích này, bạn có thể hiệu chỉnh một vài thuộc tính cho các đoạn 

video của bạn. 

Ngoài ra, Flash còn cho phép bạn hiểu chỉnh nâng cao với hai chương trình hỗ 

trợ kĩ xảo điện ảnh là Adobe Premier và Adobe After Effect.  

Khi import một video vào Flash, bạn có thể cho phép video mà bạn import vào 

sẽ nằm trên một khung hình độc lập hay được nhúng vào một trình media playback 

(nghĩa là chương trình có các thành phần điều khiển chế độ chơi). Với việc tạo một 

khung hình độc lập, ta có thể tạo các mặt nạ với hình thù phức tạp, tạo các khung 

trình chiếu rất hấp dẫn. Bạn sẽ được tìm hiểu điều này khi chúng ta tìm hiểu kĩ hơn 

về mặt nạ. 
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BÀI 5: CHUYỂN ĐỘNG VÀ BIẾN HÌNH        

Mã bài: MĐ 31_05 

GIỚI THIỆU 

Bài này giới thiệu về các phương pháp và công cụ hổ trợ bạn tạo sự chuyển 

động và biến hình cho đối tượng. 

MỤC TIÊU                                       

− Phân biệt được các loại chuyển động và các dạng biến hình; 

− Vận dụng kiến thức vào bài tập tạo sự chuyển động và biến đổi của hình 

ảnh; 

NỘI DUNG CHÍNH 

1 CLASSIC TWEEN 

1.1 Khái niệm 

Classic Tween là một kĩ thuật tạo chuyển động được cung cấp trong các phiên 

bản từ Flash CS3 trở về trước. Trong phiên bản Flash CS5+, Adobe vẫn còn duy trì 

kĩ thuật này. Về cơ bản, khi thao tác với kĩ thuật Classic Tween ta cần phải sử 

dụng đến hai KeyFrame khởi đầu và KeyFrame kết thúc. Kể từ ấn bản CS4, Adobe 

đã đưa vào một kĩ thuật mới gọi là Motion Tween – một kĩ thuật mà theo Adobe là 

sử dụng đơn giản, không cần tạo KeyFrame rắc rối như Classic Tween. Mục đích 

tạo ra kĩ thuật Classic Tween là tạo ra chuyển động cho đối tượng. Khi sử dụng 

Classic Tween, đối tượng sẽ được chuyển đổi thành hai biểu tượng Graphic (một 

biểu tượng cho KeyFrame đầu tiên và một biểu tượng cho KeyFrame kết thúc). 

Bạn không thể sử dụng các hiệu ứng 3D cho Classic Tween cũng như không thể sử 

dụng chức năng swap symbol cho đối tượng thể hiện. Nhưng sở dĩ Adobe vẫn lưu 

lại kĩ thuật này trong phiên bản CS5 dù kĩ thuật Motion Tween có nhiều ưu điểm 

hơn là vì kĩ thuật Classic Tween có những ưu điểm riêng mà Motion Tween không 

thể thay thế được. Một trong những ưu điểm đó là kĩ thuật Classic Tween cho phép 

chứa Frame ActionScript 

1.2 Tham số Ease 

Edit easing (bấm vào cây bút chì bên phải nút Ease) 

− Play (góc dưới bên trái) để xem thử hoạt động của Ease. 

− Stop (góc dưới bên trái) để ngừng xem hoạt động của Ease. 

− Reset để xóa giá trị của Ease, lúc này đường cong chuyển thành đường 

thẳng. 
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Hình 1: Trong hình minh họa là đường cong thể hiện Ease In lúc quả bóng rơi 

từ trên xuống. Ở giai đoạn đầu, đường cong ít dốc, quả bóng rơi chậm. Ở giai đoạn 

cuối, đường cong dốc nhiều, quả bóng rơi nhanh. 

Hình 2:Hình minh họa dưới đây là đường cong thể hiện Ease Out lúc quả bóng 

nảy lên. Ở giai đoạn đầu, đường cong dốc nhiều, quả bóng nảy nhanh. Ở giai đoạn 

cuối, đường cong ít dốc, quả bóng chậm lại. 

 

 Bạn cũng có thể dùng chuột để điều chỉnh độ dốc của đường cong để thay đổi 

tốc độ hoạt động của Tween: 
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Nếu bạn bỏ chọn mục Use one setting for all properties, bạn có thể bấm menu 

xổ xuống bên cạnh mục Property để điều chỉnh từng thông số áp dụng cho Tween 

(một số hiệu ứng sẽ được tìm hiểu ở các bài thực hành tiếp theo): 

− Position: Điều chỉnh tốc độ thay đổi vị trí đối tượng. 

− Rotation: Điều chỉnh tốc độ thay đổi góc quay đối tượng. 

− Scale: Điều chỉnh tốc độ thay đổi độ co dãn đối tượng. 

− Color: Điều chỉnh tốc độ thay đổi hiệu ứng màu cho đối tượng. 

− Filters: Điều chỉnh tốc độ thay đổi hiệu ứng lọc cho đối tượng. 

Bấm nút Cancel để hủy bỏ các thay đổi. 

Bấm nút OK để chấp nhận các thay đổi. 

Lưu ý: bạn phải chọn keyframe của Tween để có thể nhìn thấy mục Ease trên 

Property Inspector. 

1.3 Các bước sử dụng Classic Tween để tạo hiệu ứng động 

V í dụ sau đây sẽ trình bày cho bạn phương pháp tạo quả bóng rơi nhờ vào kĩ 

thuật Classic Tween.  

Bước 1. Trên khung sáng tác, bạn hãy sử dụng công cụ Oval để tạo một hình 

quả bóng và trang trí cho nó theo hình quả bóng chuyền.  

Bước 2. Kích chuột vào Frame thứ 10, nhấp phím F6 để chèn KeyFrame kết 

thúc. Tại Frame thứ 10 này, bạn hãy thay đổi vị trí của quả bóng (chạm mặt đất). 

Sau khi chạm đất, quả bóng sẽ nẩy lên. Để tạo điều này, bạn bấm vào Frame thứ 

20, nhấp phím F6 để chèn KeyFrame kết thúc. Tại KeyFrame này, bạn hãy thay 

đổi vị trí của quả bóng lần nữa (vị trí quả bóng nẩy đến). Bạn hãy tiếp tục quá trình 

này cho đến khi bạn cảm thấy phù hợp (thời điểm mà quả bóng dừng). Bạn có thể 

quan sát quá trình này trong hình 74 bên dưới. 

Bước 3. Bấm chuột vào khoảng cách giữa KeyFrame mở đầu và KeyFrame kết 

thúc, kích chuột phải và chọn Classic Tween. Bạn hãy lặp lại điều này cho các 

khoảng KeyFrame còn lại.  

Bước 4. Nhấn Ctrl+Enter để kiểm tra kết quả. Đây là một ví dụ đặc trưng sử 

dụng Classic Tween – dùng để tạo chuyển động của đối tượng. Bạn hoàn toàn có 

thể sử dụng nó để hiệu chỉnh thuộc tính của đối tượng, dù rằng việc này không 

phải là chức năng chính yếu dành cho nó. Bạn cũng cần lưu ý rằng, trong ví dụ ở 

trên, mỗi lần bạn nhấn phím F6 là bạn đã tạo mới một KeyFrame kết thúc và 

KeyFrame kế tiếp của KeyFrame kết thúc đó cũng đóng chức năng là KeyFrame 
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mở đầu của KeyFrame kết thúc sau. Nghĩa là mỗi lần bạn nhấp F6, bạn đã tạo ra 

thêm một khoảng đánh dấu KeyFrame để tạo Classic Tween. 

 

Trong hình minh họa trên, Layer 1 chứa quả bóng, Layer 2 chứa đối tươṇg 

minh ho ̣a cho sàn nhà (hình chữ nhật màu xanh). Các nút đen trên TimeLine của 

Layer 1 là các KeyFrame. Các khoảng giữa các nút này là các khoảng đánh dấu 

KeyFrame của Classic Tween.  

2 SHAPE TWEEN 

2.1 Khái niệm 

Kĩ thuật Shape Tween dường như có những tính năng riêng biệt. Mặc dù nó 

cũng có thể dùng để chuyển đổi màu sắc, hình dáng của vật thể như hai loại Tween 

còn lại. Nhưng chức năng chính của nó là “biến hình”. Để tạo sự biến hình, cũng 

tương tự Classic Tween, bạn phải tạo hai KeyFrame mở đầu và kết thúc. Shape 

Tween không hỗ trợ hiệu ứng 3D, không hỗ trợ chức năng swap symbol để thay 

đổi biểu tượng nguồn cho một đối tượng thể hiện. Khi tạo Shape Tween, đối tượng 

sẽ chuyển đổi thành hai đối tượng Graphic. Hai biểu tượng này tương ứng với hai 

Keyframe đầu tiên và Keyframe cuối cùng của Shape Tween. Về cơ chế của Shape 

Tween, nó sử dụng thuật toán Transform – nghĩa là sẽ dịch chuyển các điểm được 

đánh dấu theo một chỉ số nào đó ở Frame đầu tiên đến vị trí được đánh dấu cùng 

chỉ số trong Frame cuối cùng. 
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2.2 Tham số Ease 

Giá trị âm được gọi là ease in có tác dụng làm tốc độ hoạt động của tween lúc 

đầu chậm, đến cuối thì nhanh dần, giá trị âm lớn nhất là -100.  

Giá trị dương được gọi là Ease out có tác dụng làm tốc độ hoạt động của tween 

lúc đầu nhanh, đến cuối thì chậm dần, giá trị dương lớn nhất là 100. 

 

2.3 Các bước sử dụng Shape Tween để tạo hiệu ứng động 

Trong ví dụ này, chúng ta sẽ tạo hiệu ứng biến đường thẳng thành đường cong. 

Bạn không thể tạo được hiệu ứng này bằng các Tween còn lại. Đây cũng là một ví 

dụ điển hình sử dụng Shape Tween 

Bước 1. Dùng công cụ Line vẽ một đường thẳng trên khung sáng tác. 

Bước 2. Với công cụ Shape Tween, bạn có thể tạo Tween trước khi chèn 

KeyFrame hoặc sau khi chèn KeyFrame. Ta sẽ minh họa bằng việc tạo Tween 

trước. Bạn hãy dùng công cụ Selection, bấm chọn đối tượng, kích chuột phải và 

chọn Create Shape Tween.  
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Bước 3. Bấm chọn vào Frame 30 trên TimeLine, nhấp phím F6 để chèn KeyFrame 

kết thúc. Bạn bấm chọn công cụ Add Anchor Point và bấm vào vị trí giữa đường 

thẳng để bổ sung điểm điều khiển. Tiếp đến, bạn chọn công cụ Convert Anchor 

Point để tạo điểm uốn. Bạn hãy bấm chọn điểm mà bạn vừa tạo và uốn đường 

thẳng này thành đường cong như trên.  

Bước 4. Nhấn tổ hợp Ctrl+Enter để kiểm tra sản phẩm. Bạn lưu ý rằng, trong hình 

minh họa trên, tôi đã sử dụng chức năng Onion Skin. Sử dụng Shape Hint để điều 

khiển sự biến hình Khi sử dụng Shape Tween, nó sẽ tự động tạo ra sự biến hình 

theo một thuật toán được định sẵn. Nếu bạn muốn điều khiển sự biến hình này, 

Flash cũng cung cấp cho bạn công cụ đó là Shape Hint. Shape Hint là một điểm 

điều khiển khi sử dụng Shape Tween. Để sử dụng chức năng này, bạn cần tạo một 

Shape Tween cho một đối tượng, sau đó vào menu Modify > Shape > Add Shape 

Hint (phím tắt là Ctrl+Shift+H). Shape Hint sẽ xuất hiện theo cặp: một điểm ở 

Frame đầu tiên trên TimeLine của Tween và một điểm ở Frame cuối cùng. Các 

Shape Hint này được đánh chỉ số là a, b, c…. Bạn hãy quan sát hai hình vẽ sau đây 

 

Khi sử dụng Shape Hint, các điểm cùng cặp (cùng chỉ số) sẽ tạo ra sự biến hình 

tương ứng, nhưng luôn đảm bảo điểm cùng cặp của Frame thứ đầu tiên sẽ chuyển 

thành điểm cùng cặp của Frame cuối cùng (điểm a ở hình bên trái sẽ biến thành 

điểm a ở hình bên phải, tương tự điểm b và c). Bằng cách bổ sung các Shape Hint 

này, bạn có thể điều khiển chuyển động của đối tượng. Để gỡ bỏ một Shape Hint, 

bạn chỉ việc chọn nó, kích chuột phải và chọn Remove Hint. 

3 MOTION TWEEN 

3.1 Khái niệm 

Kĩ thuật Motion Tween cũng được dùng để tạo chuyển động. 

Nó cũng tương tự như kĩ thuật Classic Tween, nhưng nó đơn giản hơn kĩ thuật 

Classic Tween nhiều. Nó không đòi hỏi bạn phải tạo các KeyFrame. Một ưu điểm 
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của Motion Tween mà trong phiên bản Flash CS4 mới được bổ sung vào là hỗ trợ 

hiệu ứng 3D. Có hai hiệu ứng 3D là Translation và Rotation. Chi tiết về hai chức 

năng này ta sẽ tìm hiểu thêm trong mục cuối cùng của chương này 

Nếu so sánh với kĩ thuật Frame by Frame và Classic Tween, thì bạn cũng nên 

biết rằng, với kĩ thuật Motion Tween, bạn có thể tối ưu kích thước của file Flash 

khi xuất bản. Với Motion Tween, bạn còn có thể hiệu chỉnh đường dịch chuyển, 

tọa độ, góc xoay, Filter, Blending… Nhờ vào công cụ Selection và thuộc tính trong 

bảng Motion Editor. 

 

3.2 Các bước sử dụng Motion Tween để tạo hiệu ứng động 

Trong ví dụ này, ta tạo hiệu ứng chuyển động theo hình cánh cung cho đối 

tượng được vẽ. Trong hình minh họa, đường màu xanh minh họa cho đường 

chuyển động của đối tượng. 

Bước 1. Dùng công cụ Brush vẽ một hình ảnh bất kì trên khung sáng tác. 

Bước 2. Bấm vào công cụ Selection, nhấp chọn đối tượng vừa vẽ. Kích chuột 

phải chọn Create Motion Tween. Flash sẽ tự động tạo một khoảng Frame mặc định 

để tạo chuyển động. Nếu số lượng Frame này không thỏa mãn nhu cầu sử dụng, 

bạn có thể thay đổi nó bằng cách đặt con trỏ chuột vào vị trí cuối cùng cùng vùng 

Frame được đánh dấu. Khi trỏ chuột có dạng , bạn hãy nhấp chuột và kéo sang trái 

hoặc sang phải.  

Bước 3. Di chuyển hình được vẽ sang vị trí mới. Khi đó, bạn sẽ thấy trên 

khung sáng tác xuất hiện một thanh mô tả chuyển động của đối tượng (thanh màu 

xanh trong hình minh họa). Bạn có thể sử dụng công cụ Selection để thay đổi dạng 

thức của đường chuyển động. 
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Bước 4. Nhấn tổ hợp Ctrl+Enter để kiểm tra sản phẩm. Hiệu chỉnh chuyển 

động và các hiệu ứng nâng cao với Motion Editor. Đây là một công cụ mạnh mẽ 

được tích hợp với kĩ thuật Motion Tween. Để sử dụng chức năng này, đầu tiên bạn 

hãy tạo một Motion Tween. Sau đó, vào Windows>Motion Editor. Khi đó, cửa sổ 

Motion Editor xuất hiện. Hộp thoại Motion Editor này được chia làm hai phần: 

phần bên trái và phần bên phải. Phần bên trái chứa các chức năng và các thông số 

liên quan, phần bên phải là biểu đồ minh họa. Ta có thể hiệu chỉnh một trong hai 

phần này. Các nhóm chức năng trong Motion Editor mà bạn cần quan tâm là: - 

Basic Motion: dịch chuyển vị trí của vật trong không gian ba chiều (theo tọa độ x, 

tọa độ y và góc z) 

 

− Transformation: xoay chuyển (skew) theo chiều x, y hoặc kéo giãn (scale) theo 

chiều x, y.  

− Color Effect: bấm vào biểu tượng dấu cộng để bổ sung vào các hiêụ ứ ng. Có 

các hiệu ứng Alpha, Tint, Brightness và Advanced color. Nếu muốn loại bỏ, ta 

chỉ việc nhấp vào dấu trừ, và chọn hiệu ứng cần xóa.  

− Filter: cũng tương tự như Filter cho văn bản. Ta có thể bổ sung bằng cách bấm 

vào dấu cộng, và loại bỏ bằng cách bấm vào dấu trừ. 

− Eases: bổ sung thêm các hiệu ứng khác. 

4 TẠO CHUYỂN ĐỘNG NHỜ VÀO MOTION PRESETS 

Flash CS5 cung cấp sẵn cho ta các hiệu ứng chuyển động có sẵn trong vùng 

chức năng Motion Presets. Để sử dụng chức năng này, ta vào Windows > Motion 

Presets. Vùng chức năng Motion Presets này cung cấp cho chúng ta rất nhiều hiệu 

ứng làm sẵn.  
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Khi sử dụng các hiệu ứng trong vùng chức năng này, các đối tượng của bạn 

không cần phải chuyển đổi sang biểu tượng. Bạn có thể thao tác trực tiếp trên các 

đối tượng. Dĩ nhiên, bạn cũng có thể áp dụng các hiệu ứng này cho các biểu tượng 

như Graphic, Button hay MovieClip. Để minh họa cho vùng chức năng này, ta sẽ 

cùng nhau xây dựng một vài hiệu ứng hoạt hình sau đây:  

4.1 Hiệu ứng quả bóng chuyển động 

Bạn hãy tạo một khối cầu dạng 3D như trên hình vẽ. Sau đó, bạn hãy bấm chọn 

đối tượng, bấm tiếp vào khung Motion Presets và chọn lựa hiệu ứng chuyển động 

tương ứng. 

Ở trong ví dụ này, tôi sử dụng loại chuyển động bounce-in-3D. Sau khi chọn 

lựa hiệu ứng chuyển động, bạn nhấp nút Apply. Nếu kết hợp với Onion Skin, 

chúng ta sẽ thấy dạng chuyển động của nó như hình minh họa bên dưới. Khi sử 

dụng dạng thức chuyển động được tạo sẵn của Motion Presets, bạn sẽ nhận thấy 

rằng việc tạo chuyển động trong trường hợp này cũng sẽ quy về việc sử dụng 

Motion Tween. Bạn sẽ dễ dàng kiểm tra được điều này khi quan sát thanh 

Timeline. Trên Timeline bạn sẽ nhận thấy được dạng Tween được sử dụng là 

Motion Tween (hay bạn có thể nhìn thấy đường chuyển động của đối tượng – đây 

là dấu hiệu của Motion Tween). Nếu bạn quan sát trong thư viện Library, bạn cũng 

sẽ thấy rằng một movieClip mới đã được tạo ra. Điều này có nghĩa Flash CS5+ đã 

làm sẵn cho bạn từ A-Z. 
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4.2 Hiệu ứng chữ chạy 3D 

 Thông thường, khi kết thúc một bộ phim thời trung cổ, các thông tin về phim 

sẽ được hiển thị theo dạng thức chữ chạy từ dưới lên và thu nhỏ dần. Chúng ta sẽ 

sử dụng chức năng Motion Presets để tạo hiệu ứng này. 

Bạn hãy nhập một đoạn nội dung văn bản, sau đó chọn hiệu ứng text-scroll-3D 

trong vùng chức năng Motion Presets. Nhấp Apply. Cuối cùng, bạn hãy nhấn tổ 

hợp Ctrl+Enter để kiểm tra. 

 

5 CÔNG CỤ BONE VÀ BIND 

5.1 Công cụ Bone 

Với công cụ Bone, bạn có thể tạo ra các chuyển động dựa trên các khớp nối. 

Các chuyển động này có thể lấy ví dụ như các khớp xương tay chân, các khớp nối 

của cần cẩu, hình rồng uốn lượn, rắn trườn,… Công cụ này rất hữu ích và đơn giản. 
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Đây là công cụ mới được bổ sung vào trong Adobe Flash CS4. Khi sử dụng 

công cụ này, ta cần phân biệt các trường hợp sau: 

- Trường hợp 1: Nếu đối tượng cần tạo khớp nối là đối tượng liên tục (hình rắn 

trườn, rồng lượn…), ta sẽ sử dụng công cụ này một cách trực tiếp. Trường hơp̣ này 

thườ ng sử dụ ng khi ta thao tác trưc̣ tiếpp trên các đối i tươṇg đồ hoạ vector đươ ̣c 

thiết kế bảng các công cu ̣của Flash hoa  ̣c import từ các trı̀nh xử lý đồ hoạ vector 

như Illustrator. 

- Trường hợp 2: Nếu đối tượng cần tạo không liên tục, cần có khớp nối (như 

khớp xương, khớp nối cần cẩu…), ta sẽ sử dụng công cụ này sau khi convert các 

phần của nó thành các biểu tượng. Trườ ng hơ ̣p này thườ ng sử du ̣ng khi ta import 

các đối tươṇg đồ họa điểm và sử du ̣ ng Photoshop để cắt thành các phần khác 

nhau. Tiếp theo, ta sẽ minh họa cho việc sử dụng công cụ Bone trong hai trường 

hợp này. 

 Công cụ Bone trong trường hợp 1 

− Bước 1. Bạn hãy sử dụng công cụ Pencil hoặc Brush để tạo hình một chú rắn. 

− Bước 2. Bấm chọn công cụ Bone, sau đó vẽ các đường khớp nối như trong hình 

minh họa.  

− Bước 3. Hãy sử dụng công cụ Selection để kiểm tra các mối nối. Để tạo hiệu 

ứng động, bạn hãy nhấp chọn vào một Frame nào đó (ví dụ Frame 20), nhấn 

phím F6. Cơ chế làm việc tự động của công cụ Bone sẽ giúp tạo ra chuyển động 

nếu bạn hiệu chỉnh độ cong của đối tượng tại Frame này nhờ vào các khớp nối. 

Bạn hoàn toàn không cần sử dụng đến kĩ thuật Tween.  

− Bước 4. Nhấp tổ hợp Ctrl+Enter để kiểm tra kết quả. Bạn thấy chuyển động của 

chú rắn như thế nào? Rất mềm mại phải không? Với công cụ này kết hợp với 

ActionScript, bạn hoàn toàn có thể tạo ra trò chơi “Rắn tìm mồi”. Dĩ nhiên đó 

chỉ là định hướng mà thôi, nếu bạn muốn thực sự tìm hiểu về kĩ thuật lập trình 

game trong Flash, bạn hãy tìm các giáo trình chuyên về chủ đề này. Trong 

phạm vi giáo trình này, chúng tôi không đưa ra những dự án game tầm cỡ, 

chúng ta chỉ tập trung vào kĩ thuật tạo hoạt hình, cách điều khiển đối tượng (đây 

là một trong những chức năng nền tảng của lập trình game) và một số hiệu ứng 

thường được sử dụng trong kĩ xảo (cả kĩ xảo truyền hình lẫn kĩ xảo điện ảnh). 

Tôi cũng đưa  vào môṭ số hướng dẫn để tạo nên các game nhỏ với muc̣ đı́ch giú 

p ba ̣n điṇh hı̀nh đươ ̣c cách thứ c lâp̣ trı̀nh game trên Flash. Nếu baṇ hiểu đươc̣ 

cơ chế này, baṇ hoàn toàn có thể ta ̣o ra các game theo kic̣h bản củ a baṇ. 
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 Công cụ Bone trong trường hợp 2 

− Bước 1. Bạn hãy tạo ba khối hình chữ nhật (tượng trưng cho các phần của cần 

cẩu) và sau đó convert chúng thành các đối tượng Graphic. 

− Bước 2. Bấm chọn công cụ Bone, sau đó vẽ các đường khớp nối như trong hình 

minh họa. 

− Bước 3. Hãy sử dụng công cụ Selection để kiểm tra các mối nối. Chọn Frame 

20, nhấn phím F6, sau đó thay đổi hình dạng của cần cẩu bằng cách điều chỉnh 

các mối nối. 

− Bước 4. Nhấn tổ hợp Ctrl+Enter để kiểm tra.  

 

Nếu bạn gặp khó khăn trong việc điều khiển các bộ phận của chiếc cần cẩu 

này, bạn hãy dành chút thời gian để tìm hiểu về các thuộc tính của các đoạn nối 

trong công cụ Bone này ở ngay dưới đây. 

 Bảng thuộc tính của các đoạn nối bởi công cụ Bone 

Khi bạn nhấp chuột vào một đoạn thẳng nối các mối nối, trong bảng thuộc tính 

Properties sẽ hiện ra các thông số trong hình.  
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− Location: Position X và Y (tọa độ của thanh nối), Length (độ dài của thanh nối), 

Angle (góc nghiêng của thanh nối), Speech (tốc độ xoay của thanh nối). 

− Joint Rotation: cho phép hoặc không cho phép thanh nối có thể xoay – tương 

ứng với Enable được chọn hay không được chọn. 

− Rotation Constrain: cho phép mối nối gốc của thanh nối dịch chuyển trong 

vùng từ Min đến Max. 

 



 

73 

− Joint x Translation và Joint y Translation: cho phép thanh nối dịch chuyển theo 

chiều x hay chiều y. Thuộc tính constraint cho hai trường hợp này hoàn toàn 

tương tự thuộc tính constraint của Rotation. 

− Spring: là một chức năng mới của IK Bone, nó có hai thuộc tính Strength (số 

lượng của Spring. Khi giá trị này lớn hơn 0, khung sườn sẽ phản ứng lại với 

một chuyển động vật lý có tỷ lệ thuận giữa giá trị Strength và chuyển động tổng 

thể) và Damping (giá trị đề kháng Strength). Tùy chọn này ảnh hưởng đến độ 

tắt dần của chuyển động, lần lượt xác định bằng khoảng thời gian giữa sự 

chuyển động ban đầu và thời gian khi IK Bone trở lại vị trí dừng của nó). Đây 

là một tính năng mới đối với công cụ này trong phiên bản Flash CS5+ này mà 

Adobe đã bổ sung vào. 

5.2 Công cụ Bind 

Công cụ này phải dùng kết hợp với công cụ Bone. Khi sử dụng công cụ Bone 

trong trường hợp 1, ta có thể kết hợp với công cụ Bind. Với công cụ Bind, bạn có 

thể ép buộc các thanh nối phụ thuộc lẫn nhau. Khi sử dụng công cụ Bind, và bấm 

vào một thanh nối, sẽ hiện ra bốn điểm điều khiển đối với thanh nối đó (trong hình 

minh họa bên dưới, đó là các nút được đánh dấu vàng). 

 

Tương ứng với các điểm điều khiển này là các viền của phần đối tượng được 

điều khiển bởi thanh nối. Để cho mỗi mối nối liên kết với một mối nối khác, ta sử 

dụng công cụ Bind, bấm chọn các nút điều khiển này và kéo thả vào vị trí thanh 

nối khác (thanh nối mà các điểm này phụ thuộc vào). 

6 CÔNG CỤ DECO 

Là công cụ trang trí nghệ thuật. Với công cụ này, ta có các hiệu ứng tùy chọn: 

Vine Fill, Grid Fill, Symmetry Brush, 3D Brush, Building Brush, Decorated Brush, 

Fire Animation, Flame Brush, Flower Brush, Lightning Brush, Particle System, 

Smoke Animation và Tree Brush. 

6.1 Hiệu ứng Vine Fill 

Tạo hiệu ứng nghệ thuật dạng cây nho. Khi bấm chọn dạng biểu tượng này, sẽ 

xuất hiện bảng thuộc tính sau  
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− Leaf: biểu tượng tương ứng với biểu tượng lá. Nếu bạn muốn thay đổi, bạn 

chỉ việc nhấp vào Edit và chọn dạng symbol tương ứng. Nếu bạn muốn đổi 

màu lá, bạn nhấp vào biểu tượng Color tương ứng với Leaf. Nếu muốn sử 

dụng hình mặc định, bạn bấm chọn Default Shape.  

 

− Flower: hoàn toàn tương tự nhưng nó tương ứng với biểu tượng hoa. Nếu bạn 

muốn thay đổi màu hoa, bạn nhấp vào biểu tượng Color tương ứng với Flower. 

Nếu muốn sử dụng hình mặc định, bạn bấm chọn Default Shape. 

− Advanced Option: Branch Angle (góc xoay của các cành nho), Color (màu của 

cành nho), Pattern Scale (kéo giãn mẫu cành nho) và Segment Length (độ dài 

của các cành nho). Animate Pattern: xây dựng một nhóm (gồm cành, là và hoa) 

lên từ ng Frame mô ̣t. Chức năng này giúp tạo hiệu ứng động. Bạn có thể hiệu 

chỉnh tốc độ nhờ vào Frame Step.  

6.2 Hiệu ứng Grid Fill 

Ta ̣o hiêụ ứ ng nghê ̣thuậ t da ̣ng lướ i. Khi bấm chọn hiệu ứng Grid Fill, trong 

bảng thuộc tính có các thuộc tính sau:  

• Fill: nhấp chọn edit để thay đổi biểu tượng. Bấm vào biểu tượng color để đổi 

màu cho biểu tượng. Bấm vào Default Shape để chọn hình mặc định. 

• Advanced Options: Horizontal Spacing (khoảng cách theo chiều ngang), 

Vertical Spacing (khoảng cách theo chiều dọc) và Pattern Scale (độ phóng to 

của biểu tượng).  

6.3 Hiệu ứng Symmetry Brush 
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Hiêụ ứng này giúp taọ các mẫu nghê ̣thuâṭ có tı́nh chất đối xứng. Khi bấm chọn 

hiệu ứng Symmetry Brush, trong bảng thuộc tính Properties sẽ hiện ra các thuộc 

tính sau đây: 

− Module: bấm edit để thay đổi biểu tượng. Bấm color để đổi màu cho biểu 

tượng. Chọn Default Shape để chọn hình mặc định. 

− Advanced Options: Reflect Across Line (tạo cặp điểm đối xứng qua đường 

chuẩn), Reflect Across Point (tạo cặp điểm đối tứng qua điểm chuẩn), Rotate 

Around (tạo các điểm dạng vòng), Grid Translation (tạo một mảng các điểm). 

Test Collisions: cho phép tránh hiện tượng các biểu tượng va chạm vào nhau. 

 

6.4 Hiệu ứng 3D Brush 

Hiệu ứng 3D Brush được sử dụng để tạo các kiểu phối màu từ nhiều đối tượng. 

Mỗi một thao tác phun màu bằng hiệu ứng này cần sử dụng tối đa 4 đối tượng 

 



 

76 

Với hiệu ứng này, các đối tượng sẽ được phun theo hiệu ứng 3D (ta ̣o to ̣a đô ̣

ngẫu nhiên trong không gian 3 chiều…). Để thay đổi các đối tượng, bạn chỉ việc 

nhấp vào nút Edit, và chọn một đối tượng khác để thay thế. Các đối tượng để thay 

thế phải là các biểu tượng của Flash (MovieClip, Button hoặc Graphic). Các tính 

năng trong mục Drawing Effect này hoàn toàn tương tự trong hiệu ứng Vine và 

Grid.  

Trong mục Advanced Options có các tùy chọn sau đây: 

− Max objects: số lượng đối tượng được tạo cực đại trong mỗi lần phun. 

− Spray area: vùng được phun (tính theo pixel). 

− Perspective: cho phép tạo hiệu ứng phối cảnh hay không. 

− Distance scale: độ kéo giãn theo khoảng cách (độ phóng to – zoom). 

− Random scale range: Tỉ lệ kéo giãn ngẫu nhiên (bao nhiêu trong số các biểu 

tượng đó chịu tác động của độ kéo giãn ngẫu nhiên). 

− Random rotation range: tạo các góc quay ngẫu nhiên cho các biểu tượng. 

6.5 Hiệu ứng Building Brush 

− Với hiệu ứng Building Brush, bạn có thể tạo dựng các tòa nhà cao tầng. Công 

cụ này rất hữu ích trong các tác vụ muốn xây dựng một đô thị sầm uất. 

 

Trong mục Advanced Options, có hai chức năng: 

− Tùy chọn thả xuống: cho phép bạn lựa chọn các mẫu nhà cao tầng. Bạn có 4 

lựa chọn mẫu nhà cao tầng – skyscraper 1, skyscraper 2, skyscraper 3 và 

skyscraper 4. Nếu bạn muốn tạo các mẫu nhà ngẫu nhiên, bạn có thể chọn 

Radom Building. 

− Building size: kích thước (theo chiều ngang) của tòa nhà. Khi xây dựng các tòa 

nhà, bạn cần lưu ý: sau khi chọn công cụ Deco và chọn mẫu nhà, bạn hãy nhấp 

chuột và kéo dọc theo hướng lên phía trên. Nếu độ cao của tòa nhà đã phù hợp, 

bạn thả chuột.  
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Với hiệu ứng này bạn có thể dễ dàng tạo dựng các ngôi nhà cao tầng. Bạn lưu ý 

rằng, các ngôi nhà cao tầng này được tạo bằng cách lắp ghép các phần lại với nhau 

để tạo nên một tòa nhà hoàn chỉnh. Nếu bạn muốn tạo hiệu ứng cho một đối tượng 

ngôi nhà hoàn chỉnh, bạn cần nhóm các phần của ngôi nhà thành một đối tượng. 

6.6 Hiệu ứng Decorated Brush  

Với công cụ Decorated Brush, bạn có thể tạo các đường viền nghệ thuật theo 

các mẫu được cung cấp sẵn. 

 

Trong mục tùy chọn Advanced Option, bạn có 3 tùy chọn: 

− Tùy chọn thả xuống: có 20 dạng đường viền nghệ thuật cho bạn chọn lựa. 

− Pattern color: chọn màu cho đường viền nghệ thuật. 

− Pattern size: kích thước của biểu tượng nghệ thuật. 

− Pattern width: độ rộng của biểu tượng nghệ thuật. 

6.7 Hiệu ứng Fire Animation 

Hiệu ứng Fire Animation sẽ tạo ra một ngọn lửa cháy sáng. Nó rất hữu dụng 

trong các tác vụ cần tạo dựng ngọn lửa. Đối với hiệu ứng này, mục Advanced 

Options có các tùy chọn sau: 

− Fire size: kích thước ngọn lửa. 

− Fire speech: tốc độ cháy của lửa.  

− Fire duration: hiệu ứng động của lửa sẽ diễn ra trong bao nhiêu frame. Bạn sẽ 

thấy đó chính là số keyframe hiển thị trên thanh TimeLine. Nhưng điều này chỉ 

đúng trong trường hợp tùy chọn End Animation không được chọn.  

− End Animation: ngọn lửa tàn dần (nếu được chọn), hoặc diễn tiến mãi mãi (nếu 

không được chọn). 

− Flame color: màu phía rìa ngoài của ngọn lửa. 

− Flame core color: màu của lõi ngọn lửa. 
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− Fire spark: số ngọn lửa.  

 

Thông thường, khi tạo dựng một hoạt cảnh có sử dụng đến ngọn lửa, bạn nên kết 

hợp với hiệu ứng tạo khói (Smoke Animation) mà chúng ta sẽ tìm hiểu ở phần tiếp 

theo. 

6.8 Hiệu ứng Flame Brush 

Hiệu ứng này giúp tạo dựng cách phun màu theo hình dáng ngọn lửa. 

Trong mục Advanced Options có 2 tùy chọn: 

• Flame size: kích thước của ngọn lửa. 

• Flame color: màu của ngọn lửa. Hiệu ứng này tương đối đơn giản. Nó không 

có nhiều ứng dụng trong các dự án thiết kế phim hoạt hình.  

 

6.9 Hiệu ứng Flower Brush 
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Hiệu ứng này quả thật rất thú vị. Nhờ vào nó, chúng ta có thể tạo các cành hoa. 

Với mục Advanced Options, ta có các tùy chọn sau: 

− Tùy chọn thả xuống: cho phép bạn chọn lựa các loại hoa sau: Garden 

Flower, Rose, PoinSettia và Berry 

 

 Flower color: màu cho hoa. 

 Flower size: kích thước của hoa. 

 Leaf color: màu cho lá. 

 Leaf size: kích thước của lá. 

 Fruit color: màu của quả. 

 Tùy chọn branch: cho phép hiển thị cành cây hay không. Nếu tùy chọn này 

được kích hoạt, bạn có thể chọn tù y cho ̣n bên dướ i Branch color. 

 Branch color: màu của cành cây. 

6.10 Hiệu ứng Lightning Brush 

Hiệu ứng Lightning dùng để tạo các tia sáng. Nó được ứng dụng trong việc tạo 

các tia sét, hoặc các hiệu ứng phóng điện khác. Với mục Advanced Options, bạn có 

các tùy chọn sau đây:  

− Lightning color: màu của tia sáng. 

− Lightning scale: độ kéo giãn của tia sáng. 

− Tùy chọn Animation: nếu muốn tạo hiệu ứng động cho tia sáng. 

− Beam width: độ rộng của tia sáng. 

− Complexity: độ rối (độ phức tạp) của chùm tia sáng 
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6.11 Hiệu ứng Particle System 

Hiệu ứng này tạo một chùm hạt được phóng ra từ một nguồn phát. Bạn sẽ thấy 

nó cũng rất hữu ích trong nhiều tác vụ: phun bong bóng nước, phun các hạt bụi… 

 

Mục Drawing Effect có hai tùy chọn cho các loại hạt. Bạn có thể thay đổi 

chúng như đối với hiệu ứng vine, grid và 3D brush. Mục Advanced options có các 

tùy chọn sau:  

− Total length: diễn tiến hành động trên bao nhiêu frame. 

− Particle generation: nguồn phát các hạt sẽ diễn ra trên bao nhiêu frame. 

− Rate per frame: tốc độ trên mỗi frame. 

− Life span: mỗi một hạt sẽ có thời gian tồn tại trên bao nhiêu frame. 

− Initial speech: tốc độ khởi tạo. 

− Initial size: kích thước khởi tạo. 
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− Min initial direction: góc phun nhỏ nhất. 

− Max initial direction: góc phun lớn nhất. 

− Gravity: trọng lượng của hạt. 

− Rotation rate: tốc độ quay vòng của hạt. 

6.12 Hiệu ứng Smoke Animation 

Hiệu ứng này tương tự với hiệu ứng Fire Animation. Nó dùng để tạo hiệu ứng 

bóc khói. Thường hiệu ứng này sử dụng kết hợp với hiệu ứng Fire Animation. 

 

Trong mục Advanced options có các tùy chọn sau đây: 

− Smoke size: kích thước của khói. 

− Smoke speed: tốc độ khói. 

− Smoke duration: diễn tiến của hiệu ứng khói trên bao nhiêu frame. Cũng tương 

tự Fire Animation, số keyframe trên Timeline sẽ chính là giá trị của Smoke 

duration trong trường hợp tùy chọn End Animation không được chọn. 

− End Animation: hiệu ứng khói bốc lên và tan biến vào không khí (nếu tùy chọn 

này được chọn) và không tan biến vào không khí (trong trường hợp 

tùy chọn này không được chọn). 

− Smoke color: màu của khói. 

− Background color: màu của khói khi khói dần tan vào không khí. 

6.13 Hiệu ứng Tree Brush 

Hiệu ứng này sử dụng để tạo các loại cây khác nhau. Flash cung cấp cho ta khá 

nhiều dạng cây để sử dụng. Trong mục Advanced options có các tùy chọn sau đây: 

− Tùy chọn thả xuống: cho phép bạn chọn lựa các loại cây. Flash cung cấp sẵn 

cho chúng ta 20 loại cây khác nhau. 

− Tree scale: độ kéo giãn của cây. 
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− Branch color: màu của cành cây. 

− Leaf color: màu của lá cây. 

− Flower/Fruit color: màu của hoa hoặc quả. 

Với công cụ Deco, bạn thả sức để sáng tác các kịch bản cho các thước phim 

hoạt hình của bạn cũng như cho game. Dù rằng công cụ Deco này đã có trong 

phiên bản CS4, nhưng với phiên bản CS5+ này, công cụ này đã hoàn thiện hơn, 

cung cấp cho ta nhiều tùy chọn hơn để sáng tác. Mục tiêu của Adobe đặt ra qua 

mỗi phiên bản là làm sao để đơn giản hóa công việc thiết kế cho người dùng, để 

mở rộng phạm vi đối tượng sử dụng – không chỉ dành cho người dùng chuyên 

nghiệp mà còn hướng đến người dùng phổ thông. 

7 CÔNG CỤ 3D TRANSLATION VÀ 3D ROTATION 

7.1 Công cụ 3D Translation 

Công cụ này cho phép chúng ta có thể tạo chuyển động 3D cho đối tượng. Như 

chú ng ta đã thảo luận ở trên, công cụ này chỉ hoạt động đối với đối tượng được tạo 

Motion Tween. Ví dụ sau đây sẽ minh họa cho việc sử dụng công cụ 3D 

Translation. Trong ví dụ này, ta sẽ tạo một mặt phẳng và cho phép nó chuyển động 

trong không gian 3 chiều. Để làm được điều này, chúng ta sẽ thao tác theo  các 

bước sau đây: 

- Bước 1. Trên Layer 1, bạn hãy một hình bình hành (sử dụng công cụ hình chữ 

nhật và công cụ Free Transform) để tượng trưng cho mặt phẳng và trên Layer 2 

bạn hãy tạo một hệ tọa độ Descartes 3 chiều như hình minh họa. 
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- Bước 2. Chọn hình bình hành, kích chuột phải và chọn Create Motion Tween 

Sau đó, bấm chọn công cụ 3D Translation. Bạn có thể sử dụng công cụ này để di 

chuyển mặt phẳng theo các chiều x (trục ngang), y (trục đứng) và z (điểm chấm 

trung tâm). 

- Bước 3. Để đảm bảo rằng trục tọa độ mà ta tạo tồn tại song song với các layer 

của mặt phẳng, ta cần chọn Frame cuối cùng trên TimeLine mặt phẳng của Layer 

này và nhấn phím F5.  

- Bước 4. Nhấn tổ hợp Ctrl+Enter để kiểm tra kết quả 

 

7.2 Công cụ 3D Rotation 

Công cụ này cho phép chúng ta có thể xoay chuyển 3D cho đối tượng. Như ta 

đã thảo luận ở trên, công cụ này cũng chỉ hoạt động đối với đối tượng được tạo 

Motion Tween. 

Bạn thao tác hoàn toàn tương tự ví dụ sau trên. Nhưng ở đây, mặt phẳng sẽ xoay 

chuyển 3D trong không gian. Để làm được điều này, chúng ta sẽ thao tác theo các 

bước sau đây: 

− Bước 1. Trên Layer 1, bạn hãy một hình bình hành (sử dụng công cụ hình chữ 

nhật và công cụ Free Transform) để tượng trưng cho mặt phẳng và trên Layer 2 

bạn hãy tạo một hệ tọa độ Descartes 3 chiều như hình minh họa. 
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− Bước 2. Chọn hình bình hành, kích chuột phải và chọn Create Motion Tween 

Sau đó, bấm chọn công cụ 3D Rotation. Bạn có thể sử dụng công cụ này để 

xoay chuyển mặt phẳng theo các chiều x (trục ngang), y (trục đứng) và z (vòng 

tròn bên trong) 

 

− Bước 3. Để đảm bảo rằng trục tọa độ mà ta tạo tồn tại song song với các layer 

của mặt phẳng, ta cần chọn Frame cuối cùng trên TimeLine mặt phẳng của 

Layer này và nhấn phím F5.  

− Bước 4. Nhấn tổ hợp Ctrl+Enter để kiểm tra kết quả.  
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BÀI 6: BIỂU TƯỢNG VÀ CÁC HIỆU ỨNG  

Mã bài: MĐ 31_06    

GIỚI THIỆU 

Bài này giới thiệu về các biểu tượng trong Flash và cách tạo hiệu ứng trên từng 

biểu tượng. 

MỤC TIÊU 

− Nêu chức năng của các biểu tượng và hiệu ứng; 

− Thực hiện tạo và chỉnh sửa các thuộc tính của biểu tượng; 

− Áp dụng các hiệu ứng cho biểu tượng; 

NỘI DUNG CHÍNH 

1 CÁC LOẠI BIỂU TƯỢNG   

1.1 Biểu tượng nút nhấn  

Biểu tượng Button dùng để bổ sung một tương tác với movie, đáp trả các sự 

kiện kích chuột, ấn phím, kéo các thanh kéo và các hành động khác. Một biểu 

tượng Button sẽ có bốn Frame tương tác: Up, Down, Over và Hit. Biểu tươṇg 

Button có thể đươc̣ cài đa ṭ và điều khiển bằng ActionScript. Điều này hoàn toàn 

khác so với biểu tươṇg Graphic ở trên. Baṇ cũng cần lưu ý rằng, trong Flash có hai 

lớp đối tươṇg Button: Simple Button và Button. Lớp Simple Button là lớp Button 

do người dùng thiết kế và sử dụng chức na ng Convert to Symbol. Lớp Button còn 

laị nằm trong thư viện fl.Controls được sử duṇg trong viêc̣ thiết kế giao diêṇ GUI 

cho các ứng duṇg. Chúng là hai lớp đối tượng hoàn toàn khác biêṭ. Mặc dù chúng 

có nhiều điểm tương đồng. Trong muc̣ này, nếu ta chı̉ để cập đến Simple Button 

mà không quan tâm đến đối tươṇg fl.Controls.Button.  

 Tạo một Button 

− Chọn đối tượng cần chuyển đổi sang Button.  

− Nhấp phím F8 hoặc kích chuột phải, chọn Convert to Symbol. Khi đó, sẽ xuất 

hiện hộp thoại sau: 
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Trong mục Type, chọn Button và nhấp Ok.  

 Tạo hiệu ứng cho Button  

Ở đây, ta chỉ thao tác để tạo hiệu ứng cho Button. Ta không thảo luận thêm về 

việc sử dụng TimeLine và cách tạo hiệu ứng động. Chi tiết về phần này tôi se ̃trı̀nh 

bày trong chương tiếp theo.  

Mỗi biểu tượng Button có 4 Frame trên TimeLine. Tương ứng với Frame Up là 

hiệu ứng khi trỏ chuột được thả ra (sau khi bấm xuống), Frame Down tương ứng 

với hiệu ứng khi trỏ chuột nhấn xuống, Frame Over tương ứng với hiệu ứng khi trỏ 

chuột di chuyển qua đối tượng và Frame Hit tạo một vùng tương tác ảo cho Button 

(nghĩa là khi thao tác trên vùng này hoàn toàn tương tự với thao tác trên chính 

Button đó). Vùng tương tác này gọi là ảo bởi nó không hiển thị trên movie. Sau 

đây, ta sẽ thao tác để tạo hiệu ứng cho Button.  

(1) Kích đôi chuột vào Button vừa tạo.  

(2) Nhấp chọn Frame Up, nhấn phím F6 và thay đổi thuộc tính màu sắc, toạ đô ̣

x và y, màu viền, đô ̣ rôṇg, độ cao… cho Button này. Hoàn toàn tương tự cho 

Frame Down và Frame Over.  

(3) Nếu bạn muốn tạo vùng tương tác ảo, bạn hãy sử dụng công cụ vẽ để tạo 

một vùng tương tác này trong Frame Hit: chọn Frame Hit, nhấp F6 và vẽ một hình 

thể trong Frame Hit này.  

(4) Quay trở lại Scene, nhấp Ctrl+Enter để kiểm tra. Viêc̣ taọ Button và điều 

khiển nó trong Flash là hết sức đơn giản. So với lớp fl.Controls.Button, thı̀ Simple 

Button đơn giản hơn nhiều. Ta cũng cần lưu ý rằng, Simple Button không hổ trợ 

thuôc̣ tı́nh label (phần va n bản hiển thi ̣trên Button) nhưng ta hoàn toàn có thể taọ 

đươc̣ văn bản cho Button bằng công cu ̣Text kết hơp̣ với từng frame Up, Down, 

Over và Hit.  

 Các thuộc tính của biểu tượng Button  

− Instance Name: tên hiển thị của biểu tượng. Được dùng khi làm việc với 

ActionScript.  
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− Thanh tùy chọn thả xuống: cho phép chuyển đổi qua lại giữa các loại biểu 

tượng.  

− Instance of: chọn swap để thay đổi biểu tượng cho đối tượng hiển thị.  

− Position and Size: thay đổi vị trí và kích thước cho đối tượng.  

− Color effect: chọn hiệu ứng màu sắc cho đối tượng, bao gồm:Brightness, Tint, 

Advanced và Alpha.  

− Display: với thuộc tính Blending, cho phép ta chọn các chế độ pha trộn màu sắc 

cho Button.  

− Tracking: với Options, bạn có thể chọn Track as Button hoặc Track as 

MenuItem.  

− Filter: hoàn toàn tương tự với Filter khi làm việc với công cụ Text.  

 

 Tạo biểu tượng Button nhanh chóng 

Bạn có thể sử dụng một trong các chức năng sau đây để tạo một biểu tượng 

Button hết sức nhanh chóng:  
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 Sử dụng các Button được tạo sẵn: vào Windows > Common Libraries > Button.  

 Sử dụng Commands: bạn hãy tạo một khối hình thể, nhấp chọn nó. Sau đó vào 

Commands > Make Button. 

1.2 Biểu tượng Graphic 

Biểu tượng Graphic là một hình ảnh tĩnh có thể được tái sử dụng để tạo ra 

chuyển động. Bất kì một ảnh điểm, vector hay văn bản đều có thể chuyển đổi thành 

Graphic. Chúng chỉ có một Frame trên thanh TimeLine (điều đó có nghıã là nếu ta 

đa ṭ nó trên môṭ frame duy nhất thı̀ nó luôn duy trı̀ môṭ traṇg thái nào đó mà khô ng 

bao giờ ta ̣o ra đươ ̣c nhữ ng hiêụ ứ ng đô ̣ng). Biểu tượng graphic cũng không hổ 

trơ ̣Actionscript. 

 Tạo một Graphic 

− Chọn đối tượng cần chuyển đổi sang biểu tượng Graphic. 

− Nhấn phím F8 (hoặc kích chuột phải, chọn Convert to Symbol). Trong hộp 

thoại Convert to Symbol, có các tùy chọn sau. 

 

 Name: tên của biểu tượng sẽ được tạo. 

 Type: loại biểu tượng cần tạo. Ở đây, chúng ta chọn là Graphic 

Tiếp đến, bạn nhấp Ok. Một biểu tượng Graphic sẽ được tạo và đưa vào thư 

viện. 

 Các thuộc tính của biểu tượng Graphic 

− Thanh tùy chọn thả xuống: cho phép chuyển đổi qua lại giữa các loại biểu 

tượng. 

− Instance of: khi kích chuột vào tùy chọn swap, bạn có thể thay đổi biểu tượng 

của đối tượng thể hiện được chọn. 

− Position and Size: cho phép hiệu chỉnh vị trí theo tọa độ của đối tượng thể hiện 

(x và y), và kích thước (w – width và h – height). Tùy chọn Lock width and 

height values together cho phép thay đổi kích thước chiều rộng và cao đồng 

thời hay riêng lẻ.  
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− Color effect: với tùy chọn Style, bạn có thể hiểu chỉnh các thuộc tính 

Brightness, Tint, Advanced và Alpha cho đối tượng. 

− Looping: tùy chọn liên quan đến số lần lặp lại hành động của biểu tượng 

Graphic. Nó có thể là Loop, Play Once và Single Frame. 
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 Tạo hiệu ứng động đơn giản bằng biểu tượng Graphic 

Trong vı́ du ̣này, ta se ̃ ta ̣o hiêụ ứng đôṇg bawfng cách sử dụng bieeru tươṇg 

Graphic. Trong vı́ du ̣này, tôi có đeef câp̣ đeesn ba khái niêṃ: TimeLine, frame và 

keyframe. Chúng ta chı̉ minh hoạ cho vı́ du ̣sử duṇg biểu tươṇg Graphic mà không 

thảo luâṇ thêm về chúng..  

(1) Baṇ haỹ sử duṇg công cu ̣Rectangle để taọ một hı̀nh chữ nhâṭ màu xanh 

blue và sau đó chuyển đổi nó sang biểu tươṇg graphic. 

(2) Nhấp đôi chuôṭ vào biểu tươṇg graphic này để mở thanh Timeline của nó. 

Trong thanh Timeline này, ta choṇ frame thứ 2 và nhấn phı́m F6 để tạo mới môṭ 

keyframe. Trên keyframe này, ta thay đổi màu sắc cho hı̀nh chữ nhâṭ thành màu 

đỏ.  

(3) Quay trở laị với khung sáng tác, taị frame thứ 2 nhấn phı́m F5. 

Khi kiểm tra movie, baṇ cần choṇ đổi tươṇg graphic và hiêụ chı̉nh các thông số 

trong muc̣ Looping lần lươṭ: loop, play one, single frame để quan sát kết quả. Khi 

choṇ hiêụ ứng loop, thı̀ sư ̣biển đổi từ màu xanh blue sang màu đỏ và ngươc̣ laị se ̃
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diển ra môṭ cách liên tuc̣ (la p̣ liên tuc̣); khi choṇ hiêụ ứng play one thı̀ sư ̣biến đổi 

đó chı̉ diển ra môṭ lần duy nhất; khi choṇ single frame thı̀ không có sư ̣biến đổi nào 

diễn ra (bởi nó chı̉ sử duṇg môṭ frame đơn duy nhất).  

Hai tùy choṇ loop và play one thường sử duṇg khi muốn taọ ra các hı̀nh ảnh 

đôṇg như đối với các ảnh động gif. Nghıã là sử dụng chức na ng thay thế từng 

khung hı̀nh đơn giản. Còn đối với single frame, nó thường đươc̣ sử duṇg khi ta 

muốn tối ưu khung thiết kế. Baṇ có thể thiết kế nhiều hı̀nh ảnh trên đối tươṇg 

graphics này. Mỗi hı̀nh ảnh đươc̣ thiết kế trên mỗi keyframe riêng biêṭ. Khi cần sử 

duṇg hı̀nh ảnh trên frame nào, ta chı̉ cần chọn thuộc tı́nh looping tương ứng với tùy 

choṇ single frame và chı̉ điṇh tùy choṇ first tương ứng với keyframe mà hı̀nh ảnh 

của đối tươṇg cần dùng đang thiết lâp̣. Cách làm này giúp ta quản lý các đối tươṇg 

đồ hoạ đơn giản hơn. Baṇ haỹ thử tưởng tươṇg, baṇ có môṭ khung cảnh. Khung 

cảnh này se ̃ thay thế theo 4 mùa: xuân, ha,̣ thu, đông. Khi thiết kế cảnh, ta có thể 

taọ môṭ biểu tượng graphic có tên là landcape. Trên landcape này se ̃có 4 keyframe 

tương ứng với sư ̣biến đổi cảnh sắc theo 4 mùa. Trong phim, nếu ta cần hiển thi ̣ 

theo cảnh sắc của mùa nào, thı̀ ta chı̉ việc thay đổi tham số first từ 1 – 4 (khi 

looping đươc̣ choṇ là single frame) mà không phải thay đổi quá nhiều các lớp đối 

tươṇg hay tùy chı̉nh lại trên thanh Timeline. 

1.3 Biểu tượng Movie Clip 

Là một mẫu hoạt hình của Flash có thể được tái sử dụng. Khác với Graphic và 

Button, MovieClip có riêng một TimeLine với vô số Frame có thể dùng để taọ hoaṭ 

hı̀nh. Một MovieClip có thể bao gồm một hoặc nhiều biểu tượng Graphic, Button 

hoặc thậm chí là MovieClip. Cũng tương tự như Button, bạn có thể cài đặt một tên 

hiển thị cho nó để điều khiển nó bằng ActionScript. 

Các thuộc tính của biểu tượng MovieClip  

− Instance Name: tên hiển thị của biểu tượng. Được dùng khi làm việc với 

ActionScript.  

− Thanh tùy chọn thả xuống: cho phép chuyển đổi qua lại giữa các loại biểu 

tượng.  

− Instance of: chọn swap để thay đổi biểu tượng cho đối tượng hiển thị.  

− Position and Size: thay đổi vị trí và kích thước cho đối tượng.  

− 3D Position and View: hiểu chỉnh vị trí trong không gian và khung nhìn 3D.  

− Perspective Angle: hiệu chỉnh góc phối cảnh theo độ xa gần.  

− Vanishing Point: hiệu chỉnh tọa độ của điểm triệt tiêu.  

− Color effect: chọn hiệu ứng màu sắc cho đối tượng, bao gồm:Brightness, Tint, 

Advanced và Alpha.  



 

92 

 

− Display: với thuộc tính Blending, cho phép ta chọn các chế độ pha trộn màu sắc 

cho Button.  

− Tracking: với Options, bạn có thể chọn Track as Button hoặc Track as 

MenuItem. Đây là cách thức tương tác với Button. Nó có thể taọ hiệu ứng theo 

cách của môṭ Button truyền thống hay theo cách của một MenuItem.  

− Filter: hoàn toàn tương tự với Filter khi làm việc với công cụ Text. 

2 CÁC LOẠI HIỆU ỨNG 

Timeline Effects    

Các hiệu ứng Các thông số chung 

− Effects (Insert > Timeline Effects 

> Effects: blur, drop shadow, 

expend, explode ) 

− Blur: Tạo hoạt cảnh phóng to mờ 

cạnh 

− Effect duration: Nhập số frame 

là độ dài cho hoạt cảnh 

− Direction of movement: Hướng 

diễn hoạt 

− Update preview: xem trước với 
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− Drop shadow: Tạo bóng đổ thô. 

Tuy nhiên kiểu này không đẹp 

lắm, nên sử dụng kiểu tô radials 

cho bóng đổ tròn và linear cho 

kiểu bóng đổ vách. 

các thông số vừa chọn 

Còn những kiểu khác có thể sử dụng sử dụng Soften Fill Edges (Modify > 

Shape > Soften Fill Edges). Đối với các hình bitmap có nền trong suốt nên tạo 

bóng đổ trước bằng các phần mềm chỉnh sửa ảnh như: photoshop hay fireworks rồi 

import vào flash ở dạng file png. 

− Expend: hiệu ứng chuyển động tịnh tiến 

− Explode: Tạo hiệu ứng nổ tung 

− Transform (Insert > Timeline Effects > Transform/ Transition) 

− Transform : tạo các hiệu ứng biến đổi như scale, rotate,  

− Transition : 2 hiệu chuyển cảnh Fade and Wipe 

2.1  Hiệu ứng mặt nạ  

Hiệu ứng mặt nạ (Masking) Dùng để thiết lập vùng hiển thị tùy ý các hình ảnh 

ở các lớp bị che nằm dưới (Masked layer ) qua một khuôn hình ở lớp mặt nạ ở 

trên (mask Layer ). Trong kỹ thuật này bao giờ cũng có cấu trúc như sau: layer 

mask ở trên cùng và một hay nhiều lớp bị che nằm ở dưới chứa hình ảnh nền cần 

hiển thị. 

Bằng cách thêm vào các chuyển động cho lớp mask hay các lớp bị che, ta có 

thể tạo ra nhiều hiệu ứng thú vị như hiệu ứng đèn pha, kính lúp, chụp x-quang... 

−  Tạo layer mask: Rclick lên layer và chọn mask hay Modify > timeline > layer 

properties > chọn mask 

− Thêm bớt các lớp bị che (Masked layer ) bằng cách Drag các layer vào hoặc 

ra khỏi layer mask 

− Chỉnh sửa lớp mask và các lớp bị che: bỏ khoá layer, chọn outline để dễ quan 

sát phần bị che trong khi chỉnh sửa. 

Khuyết điểm: 

Layer mask  KHÔNG: 

− Có hình là đường viền (stroke color): Nhưng nếu bạn vẫn muốn tạo hiệu ứng 

mask đường viền thì phải chuyển đường stroke thành màu fill (Modify > shape 

> convert to fill) 

− Có nhiều instance trong layer mask: Hiệu ứng mask chỉ hiệu lực lên 1 instance 

thôi. Nếu bạn vẫn muốn dùng nhiều instance để mask 1 cảnh nền thì phải lồng  
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− Là layer motion, guide, folder...: Như vậy ta sẽ không có một hình shape trong 

layer mask mà di chuyển theo 1 đường dẫn được. Nhưng điều này được khắc 

phục bằng movieClip  

− Ảnh hưởng gộp lên 1 layer bị che được: Như vậy không thể có 1 hiệu ứng tổng 

hợp từ 2 layer mask trên 1 layer bị che được...bạn chỉ khắc phục bằng 1 

movieClip chứa 2 layer của layer mask  

− Mask 1 layer mask được: không mask nhiều cấp được ngoại trừ sử dụng 

movieClip  

− Mask theo kiểu gradient: Bạn không thể tạo 1 vùng mask có biên mờ. Tóm lại 

trong layer mask chỉ có thể chứa: hình shape (không stroke), text, group, 

instance. 

Ví dụ: Trong bài này bạn sẽ thực hành tạo ảnh động (animation) theo phương 

pháp motion tween kết hợp với mask layer để cho dòng chữ TUỔI TRẺ ONLINE 

xuất hiện dần theo từng ký tự. Các bước thực hành như sau: 

Bước 1: Tạo mới một flash document/ Lưu một flash document 

Bước 2:  Sử dụng Text Tool để viết một đoạn text. 

− Bấm chọn vào Text Tool trên thanh công cụ bên phải: 

 

− Nhấp chuột vào chỗ 12.0pt trên Property Inspector: 

 



 

95 

− Đổi số 12 thành 50 rồi nhấn phím ENTER để chấp nhận giá trị mới: 

 

− Bấm chuột vào Stage và gõ vào dòng chữ TUỔI TRẺ ONLINE: 

 

− Bấm phí ESCAPE để thoát khỏi khung text, lúc này cả đoạn text đã được chọn 

và có một khung hình chữ nhật bao quanh: 

 

− Để canh giữa đoạn text này trên Stage, trước hết chọn Edit>Cut từ menu: 
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Kế đến chọn Edit>Paste in Center từ menu: 

 

− Bạn thu được dòng chữ được canh giữa Stage như sau: 

 

Bước 3. Thêm một layer vào Timeline. 

− Bấm chuột vào nút New Layer để thêm một layer vào Timeline: 
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− Bấm đúp vào Layer 2 và đổi tên thành mask: 

 

Bước 4 : Chọn Rectangle Tool để vẽ hình chữ nhật. 

− Bấm chọn Rectangle Tool từ thanh công cụ: 

 

Chuột sẽ đổi hình dáng từ mũi tên sang chữ thập + . 

− Kéo chuột từ góc trên bên trái sang góc dưới bên phải để bao phủ chữ TUỔI 

TRẺ ONLINE: 
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Bạn thu được một hình chữ nhật màu xanh bao phủ chữ TUỔI TRẺ ONLINE: 

 

Bước 5. Sử dụng Selection Tool để chọn hình chữ nhật và tạo motion tween. 

− Bấm chọn Selection Tool trên thanh công cụ bên phải: 

 

− Bấm chọn hình chữ nhật. Khi đã được chọn, hình chữ nhật chuyển sang dạng 

hạt li ti, đồng thời phía dưới chuột xuất hiện mũi tên bốn chiều: 

 

− Bấm phím phải chuột cho xuất hiện menu ngữ cảnh và chọn Create Motion 

Tween: 

 

− Do hình chữ nhật vừa tạo ra không phải là một symbol nên flash thông báo cần 

phải chuyển nó sang symbol để tạo tween (xem thêm phần tìm hiểu về symbol 

ở cuối bài). Bạn bấm OK để đồng ý: 
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Sau khi bấm chọn OK, bạn thấy một số thay đổi như sau: 

1. Hình chữ nhật không còn những hạt li ti nữa vì đã được chuyển thành 

symbol. 

2. Trên Property Inspector xuất hiện biểu tượng symbol (hình bánh xe) là 

Movie Clip với dòng chữ Instance of: Symbol 1. (xem thêm phần tìm hiểu 

về symbol ở cuối bài) 

3. Trong khu vực frame của Timeline, Flash đã tự động bổ sung số frame 

thành 24 frame (mặc định cho motion tween hoàn thành trong một giây - 

theo mặc định Flash CS4 thiết lập tốc độ 24 fps). Đồng thời Playhead được 

di chuyển đến frame số 24. Bên cạnh đó bạn còn thấy các frame từ 1 đến 24 

đã được đổi sang màu xanh nhạt đặc trưng của motion tween của Flash CS4. 
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− Bấm F6 để chèn keyframe vào vị trí frame 24 (Xem bài thực hành 1- cách chèn 

keyframe), tại frame này xuất hiện một hình thoi màu đen. Đây là đặc trưng của 

motion tween mới của Flash CS4. 

 

− Đưa chuột đến keyframe 1 của motion tween và bấm chọn keyframe 1 khi nhìn 

thấy phía dưới chuột xuất hiện một khung chữ nhật mờ, playhead sẽ chuyển đến 

keyframe 1 

 

− Đưa chuột vào mép phải của hình chữ nhật, bấm và di chuyển hình chữ nhật 

sang trái, giữ phím Shift để hình chữ nhật di chuyển theo chiều ngang. 

 

Khi nhả chuột ra, bạn thu được sự thay đổi như hình vẽ. 

 

Trên hình bạn thấy một đường thẳng có các chấm dọc theo đường thể hiện vị 

trí của các frame, đây là điểm đặc trưng của motion tween cho đối tượng của Flash 

CS4, hoàn toàn khác với motion tween của các phiên bản Flash trước đây (Flash 

CS4 gọi motion tween theo cách cũ là Classic motion tween) 

− Motion tween kéo dài 24 frame, trong khi đoạn text chỉ kéo dài 1 frame, bạn bổ 

sung frame cho layer chứa đoạn text bằng cách bấm chuột vào frame số 24 của 

layer chứa đoạn text. 

Để chèn thêm frame vào Timeline bạn chọn Insert > Timeline > Frame từ 

menu (hoặc bấm phím tắt F5): 
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Kết quả thu được như sau: 

 

− Bấm phím phải chuột vào layer mask để xuất hiện menu ngữ cảnh và chọn 

Mask. Biểu tượng của các layer sẽ biến đổi như phần bên phải của hình dưới 

đây đồng thời cả hai layer này bị khóa lại. 

 

Lúc này trên Stage dòng chữ TUỔI TRẺ ONLINE bị hình chữ nhật che khuất 

đã xuất hiện đầy đủ. (Xem thêm phần Tìm hiểu về Mask layer ở cuối bài) 

− Xem thử animation lúc đang biên soạn 

Để xem thử kết quả lúc đang biên soạn, bạn nhấn phím ENTER. Chữ TUỔI 

TRẺ ONLINE với từng ký tự xuất hiện nhanh qua màn hình. 

− Xuất file thành flash movie 

Để xuất file thành flash movie, bạn chọn Control > Test Movie từ menu: 
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2.2 Hiệu ứng Blur  

Hiệu ứng làm mờ ảnh thay đổi giữa hai ảnh. Khi một bức ảnh bị làm mờ đi thì 

bức kia sẽ hiện rõ ra và ngược lại. Bạn có thể sử dụng hiệu ứng đơn giản này khi 

muốn làm nổi bật một đối tượng nào đó đang nằm trong nhiều đối tượng hiện có. 

 

Bước 1: Đầu tiên, bạn phải có 2 bức ảnh để làm ví dụ, có thể download 2 bức 

ảnh dưới đây mà chúng tôi sử dụng trong bài này: 

 

Bước 2: Tạo một file flash mới. Chọn Modify > Document (Ctrl + J). Thiết lập 

độ rộng của file là 340px, chiều cao là 200 px. Chọn bất kỳ màu nào làm màu nền 

của file và thiết lập Frame rate là 24 fps. Sau đó kích OK. 
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Bước 3: Vào File > Import > Import to Stage (Ctrl + R) và Import hai bức ảnh 

đã chọn sẵn vào file flash. 

Bước 4 : Kích đúp vào layer 1 để đổi tên thành picture 1. Sau đó, chỉ chọ một 

bức ảnh và nhấn phím Ctrl + X (Cut). Tạo một layer mới ở phía trên layer picture 1 

và đổi tên thành picture 2.  

Bước 5: Chọn layer picture 2 và nhấn phím Ctrl + Shift + V (Paste in Place).  

Bước 6: Sử dụng các phím mũi tên hoặc chuột để đặt hai bức ảnh theo vị trí 

như sau: 

 

Bước 7: Trở lại layer picture 1 và nhấn phím F8 (Convert to Symbol) để 

chuyển đổi bức ảnh đầu tiên sang dạng Move Clip Symbol. Xem hình dưới. 

 

Bước 8: Chọn công cụ Selection Tool (V) và kích một lần lên bức ảnh để chọn 

nó. Sau đó, vào Properties Panel (Ctrl + F3). Kích lên tab Filters trong Properties 

Panel. Kích lên biểu tượng dấu cộng và chọn Blur filter. Tạo các thông số như sau:  

1. Blur X và Y : 122. Quality : Medium 
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Bước 9: Kích chọn frame 10, 30, 40 và 60 sau đó nhấn phím F6.  

Bước 10: Trở lại Frame 10. Dùng công cụ Selection Tool (V) và kích một lần 

lên picture 1 để chọn nó. Sau đó, trở lại phần Properties Panel, vào phần Filters và 

thiết lập lại Blur theo các thông số sau: 

 

Lặp lại quá trình này tại frame 30 và 60.  

Bước 11: Kích chuột phải lên bất kỳ vị trí nào trong vùng màu xám giữa frame 

1 và 10, 30 và 40, sau đó chọn Create Motion Tween từ menu phải xuất hiện. 

 

Bước 12: Thực hiện tương tự các bước đã làm với picture 1 trên picture 2  

Bước 13: Dùng công cụ Selection Tool (V) và chọn layer picture 2. Sau đó 

nhấn phím F8 (Convert to Symbol) để chuyển đổi picture 2 sang dạng Movie Clip 

Symbol. 

 

Bước 14: Kích vào frame 10, 30, 40 và 60 lần lượt nhấn phím F6.  

Bước 15: Trở lại frame 10 và lặp lại bước 8 nhưng có khác một chút là bây giờ 

bạn đang thực hiện đối với picture 2. Sau đó lặp lại quá trình này với frame 30.  
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Bước 16: Kích chuột phải lên bất kỳ vị trí nào trong vùng màu xám giữa frame 

1 và 20, 30 và 40, sau đó chọn Create Motion Tween từ menu phải xuất hiện. 

 

Kiểm tra lại sản phẩm (Ctrl + Enter). 

2.3 Hiệu ứng nổ tung  

Bước 1. Tạo 1 file có thông số như hình 1: 

 

Bước 2. Dùng công cụ Text, chỉnh các thông số như hình 2 và gõ vào chữ Yeah! 

 

Bước 3. Chọn Window > Color Mixer và chỉnh thông số Alpha là 50% (xem hình 3): 
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Bước 4. Nhấp chuột phải vào Frame 3, chọn Insert KeyFrame (xem hình 4) 

 

Bước 5. Nhấp chọn khung chữ và chỉnh các thông số như hình 5: 
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Bước 6. Thực hiện tương tự Bước 4, Bước 5 cho các Frame 5, 7, 9, 11, mỗi lần 

tăng lên 10 (riêng ở Frame 11 ta đổi màu chữ thành đỏ) (xem hình minh họa cho 

Frame 11) 

 

Bước 7. Lưu ý rằng ta đang ở Frame 11. Nhấp chọn dòng chữ, chọn Insert > Timeline 

Effects >Effects > Explode (xem hình 7) 
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Bước 8. Trong bảng Explode ta chọn OK. 

Bước 9. Nhấn Ctrl + Enter để kiểm tra kết qu 
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BÀI 7: CƠ BẢN VỀ NGÔN NGỮ ACTIONSCRIPT 

Mã bài: MĐ 31_07  

GIỚI THIỆU 

Bài này giới thiệu với bạn về ngôn ngữ Action Scrip. Cách sử dụng các câu lệnh 

lập trình và các sự kiện có sẵn nhằm tạo ra một đoạn clip đơn giản. 

MỤC TIÊU 

− Nêu cú pháp tổng quát của các cấu trúc lệnh ActionScript; 

− Vận dụng các cấu trúc lệnh lệnh ActionScript cho khung hình, nút nhấn, File 

Video 

− Thực hiện viết lệnh cho một số chuyển động cơ bản 

NỘI DUNG CHÍNH 

1 KHÁI NIỆM CƠ BẢN  

1.1 Khái niệm về ngôn ngữ Action Script 

Action Script là một ngôn ngữ script được xây dựng trong Flash, với các lệnh 

điều khiến Flash movie làm việc theo đúng những gì mình mong muốn. 

− Script có thể ngắn gọn vài chữ hay cũng có thể dài nhiều trang. 

Script có thể được viết gộp lại một chổ hay cũng có thể viết rãi rác khắp nơi 

trong movie. 

1.2  Sự kiện event 

− Sự kiện (Event): là một tình huống xãy ra (di chuyển chuột lên nút, nhấp chuột 

vào nút, …), hoặc là thời điểm thiết lập đã đến (tiến trình đã đến khung hình 

khóa có thiết lập tương tác). 

− Sự kiện của chuột Mouse gồm có: 

 Press: Click chuột trên nút Button 

 Release: Nhả chuột trên nút Button 

 ReleaseOutside:  Nhả chuột bên ngoài nút Button. 

 RollOver: Di chuyển chuột trên phạm vi của nút. 

 RollOut: Di chuyển chuột ra khỏi phạm vi của nút. 

 DragOver: Nhấp chuột trên nút và kéo rê chuột trên phạm vi của nút. 

 DragOut: Nhấp chuột trên nút và kéo rê chuột ra khỏi phạm vi của nút. 

− Sự kiện của bàn phím Keyboard gồm có: 

 KeyPress và khai báo phím nhấn. 
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− Sự kiện của khung hình: khi tiến trình đến một khung hình. 

1.3 Hành động action 

− Hành động (Action): là môt tác động tương tác đến đích Target  khi xãy ra sự 

kiện Event. Ví dụ: 

 Khi sự kiện nhả chuột trên nút Button xãy ra thì  hành động Goto đến Frame số 

# và Play. 

 Khi Playhead đến Frame khóa thì hành động Stop. 

 

2 CÁC ĐỐI TƯỢNG TRONG FLASH SỬ DỤNG ACTIONSCRIP  

− Frame 

− Nút nhấn 

− Movie Clip 

3 CÁC ACTION THÔNG DỤNG 

Timeline Control 

 

− Nhảy đến một khung hình trong một 

cảnh và chạy hoạt hình 

− Nhảy đến một khung hình trong một 

cảnh và dừng hoạt hình 

− Nhảy tới frame kế tiếp. 

− Nhảy tới scene kế tiếp 

− Chạy hoạt hình 

− Nhảy tới frame kế trước 

− Nhảy tới scene kế trước. 

− Dừng hoạt hình 

− Ngưng tất cả âm thanh 
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Movie Clip Control 

 

− Nhân bản Movie Clip 

− Nhận thuộc tính 

− Điều khiển button 

− Điều khiển Movie Clip 

− Tháo bỏ movie clip 

− Thiết lập thuộc tính 

− Bắt đầu kéo rê 

− Kết thúc kéo rê 

− Chỉ định đường dẫn 

− Cập nhật sau biến cố 

Browse / Network 

 

− Full screen 

− Geturl 

− Tải movie 

− Tải movie number 

− Tải biến 

− Tải biến number 

− Ngừng tải movie 

− Ngừng tải movie number 

4 CÁC KIỂU DỮ LIỆU 

− Kiểu số nguyên 

− Kiểu số thực 

− Kiểu Boolean 

− Kiểu xâu String 

− Kiểu mảng  

− Kiểu đối tượng Object 

− Kiểu biến và hằng 

5 CÂU LỆNH ĐIỀU KHIỂN 
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5.1 Câu lệnh if 

Cú pháp 

if (biểu_thức_điều_kiện_đúng) 

{ 

Thực hiện lệnh 1; 

} 

Else 

{ 

//biểu thức điều kiện sai 

Thực hiện lệnh 2; 

} 

Các câu lêṇh if có thể đươc̣ viết liên tiếp nhau. Khi đó , ta se ̃có một cấu trúc if 

–else liên tuc̣. 

If (điều_kiện_1) 

Lệnh_1; 

else if (điều_kiện_2) 

Lệnh_2;.... 

else if (điều_kiện_n) 

Lệnh_n; 

Giải thích  

Kiểm tra điều kiện củ a biểu thứ c điều kiện, nếu nó nhâṇ giá tri ̣đúng thı̀ thưc̣ 

hiêṇ phần lệnh tương ứng với if (lêṇh 1); ngược laị, se ̃thực hiện phần lêṇh tương 

ứng với else (lêṇh 2). 

Ví dụ:  

Ví dụ in ra kết luận số a là số dương chẵn hay không là số dương chẵn. 

Ví dụ  Kết quả 

var a:int = 5; 
if ((a%2==0)&&(a>0)) 
{ 
trace(a+” là số dương chẵn”); 
} 
Else 

{ 
//biểu thức điều kiện sai 
trace(a+” không là số dương chẵn”); 
} 

5 không là số dương 
chẵn 
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Bạn cũng lưu ý rằng các câu lệnh if cũng có thể lồng vào nhau, nghĩa là bên 

trong câu lệnh if còn có thể chứa câu lệnh if khác. Đây cũng là tình huống rất 

thường gặp 

Ví dụ: Giải phương trình bậc hai 

Ví dụ  Kết quả 

var a:Number = 2, b:Number = 3, 

c:Number = -5, delta:Number; 

delta = b*b - 4*a*c; 

if(delta>0) 

trace("Phương trıǹh có hai nghiệm: 

"+ ((-b+Math.sqrt(delta))/2/a).toString() 

+ " và " + ((-b 

Math.sqrt(delta))/2/a).toString()); 

else 

if(delta==0) 

trace("Phương trıǹh có 

nghie ̣̂m kép: " + (-b/2/a).toString()); 

else 

trace("Phương trıǹh vo  

nghie ̣̂m"); 

 

Phương trıǹh có 

hai nghie ̣̂m: 

1 và -2.5 

 

 

5.2 Câu lệnh switch 

Cú pháp 

Switch (biểu_thức) 

{ 

case giá_trị_1: 

Lệnh 1; 

break;… 

case giá_trị_(n-1): 

Lệnh n-1; 

break; 

default: 

Lệnh n; 

} 
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Giải thích:  

Kiểm tra giá tri ̣của biểu thức, nêu nó nhâṇ giá tri ̣1 thı ̀Lêṇh 1 se ̃được thưc̣ thi, 

…, nêu nó nhâṇ giá tri ̣n-1 thı ̀Lêṇh n-1 se ̃được thực thi. Trong trường hơp̣, biểu 

thức không nhận từ giá tri ̣ 1 cho đến giá tri ̣ n-1 thı̀ nó se ̃ thưc̣ hiêṇ Lêṇh n. Sau 

mỗIcâu lệnh trong các trường hợp case, cần có câu lệnh break để thoát khỏi vòng 

la P̣ case. Néu khô ng có break, các trường hợp case tiếp theo cũng se ̃được thự c 

hiêṇ. 

Ví dụ:  

Cho a là một số nguyên cho trước. Nếu a là 0 thì in ra “Số Không”; nếu a là số 

1 thì in ra “Số Một”. Trong các trường hợp còn lại thì in ra thông báo “Không 

biết”. 

Ví dụ  Kết quả 

var a:int = 2; 

switch(a) 

{ 

case 0: 

trace(“Số Không”); 

break; 

case 1: 

trace(“Số Một”); 

break; 

default: 

trace(“Không biết”); 

} 

Không biết 

 

Bài tập. 

1. Haỹ viết đoa ̣n chương trıǹh cho phép in ra thô ng báo số ngày trong mô ̣ t 

tháng. Trong đó , tháng là mô ̣ t số nguyên cho trướ c. Haỹ sử du ̣ng lệnh 

switch thay vı ̀sử du ̣ng câu lêṇh if ở trên. 

Hướng dẫn: Nêu tháng là 2 thı̀ có 28 hoa c̣ 29 ngày. Nêu tháng là 1, 3, 5, 7,  

 8, 10, 12 thı̀ có 31 ngày. Nêu tháng 4, 6, 9, 11 thı̀ có 30 ngày 2. Haỹ viết đoaṇ 

chương trı̀nh cho phép kiểm tra môṭ kı́ tự cho trước là quốc gia thuộc châu luc̣ nào. 

Các kı́ tự bao gồm: a – Anh, m – My,̃ v – Viêṭ nam, n – Nam phi. Trong trường 

hợp nhâp̣ vào môṭ kı́ tự khác a, m, v, n thı̀ đưa ra thông báo là 

“Không biết”. 
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5.3 Các câu lệnh lặp for, while và do…while 

Ngôn ngữ AS cung cấp cho chúng ta ba dạng vòng lặp for: for, for…in và for 

each…in. 

 Câu lệnh lặp for 

Cú pháp 

for(var i:int = bt_khởi_tạo; bt_giới_hạn; bt_tăng) 

{ 

Lệnh; 

} 

Giải thích:  

Lêṇh se ̃ đươc̣ thưc̣ hiêṇ với số lần chı́nh là số lần la p̣ của i. Số lần la p̣ 

của i se ̃là (bt_giới_ha ̣n – bt_khởi_tạo)/bt_ta ng + 1. 

Ví dụ: 

 Viết đoạn chương trình in ra các số từ 0 đến 5 

Ví dụ  Kết quả 

for(var i:int = 0; i<6; i++) 

{ 

trace(i); 

} 

//hoặc 

for(var i:int = 0; i<=5; i++) 

trace(i); 

0 1 

2 

3 4 5 

Giá tri ̣của biến i se ̃đươc̣ la p̣ từ 0 đến 5 (nhỏ hơn 6) vớ i bướ c nhảy là 1 (vı ̀

i++). Điều đó có nghıã là biến i nhâṇ các giá tri ̣ là 0, 1, 2, 3, 4, 5 và 6. Câu lêṇh 

trace se ̃ in ra giá trị của biến i tương ứng với từng vòng la p̣. 

Ví dụ: Viết đoạn chương trình tính tổng các số từ 1 đến 100 

Ví dụ  Kết quả 

var S:int = 0; 

for(var i:int = 1; i<=100; i++) 

S+=i; 

trace("Tổng là: "+S); 

Tổ ng là: 5050 

 
 

 

Giá trị̂ củ a biến i sẽ đượ̂  c la ̣̂p từ 1 đến 100 vớ i bướ c nhảy là 1 (vı̀ i++). Sau mỗi 
vò ng la ̣̂p, giá trị̂ của i sẽ đượ̂ c co ̣̂ ng dồ n vào biến S. Câu lệnh trace sẽ in ra giá trị̂ 
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củ a biến S. 
Ví dụ: Viết đoạn chương trình tính tổng các số chẵn từ 1 đến 100 

Ví dụ  Kết quả 

var S:int = 0; 
for(var i:int = 1; i<=100; i++) 
if(i%2==0) 
S+=i; 
trace("Tổ ng các số chẵn là: "+S); 

Tổ ng các số chẵn là:: 
2550 

 

Ví dụ: Viết đoạn chương trình cho phép tính tổng các phần tử dương của mảng. 

Ví dụ  Kết quả 

var mang:Array = new Array(); 
for(var i:int = 0; i<100; i++) 
mang.push(Math.round(10*(Math.rando
m()-0.5))); 
var S:int = 0; 
for(i = 0; i<100; i++) 
if(mang[i]>0) 
S+=mang[i]; 
trace(S); 
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 Câu lệnh lặp for…in  

Khi chı̉ số của mảng khô g liên tuc̣ hoa c̣ không tuân theo một quy tắc nào đó , 

thı ̀cách sử duṇg vòng la p̣ for ở trên tỏ ra không cò n hiêụ quả. Đẻ khắc phuc̣ nhượ 

c điểm này, AS bổ sung vòng lặp for…in. Bên ca ̣ nh đó , đố i với trườ ng hợp 

Object, thı ̀phần đánh chı ̉số có thể không đơn thuần là số mà có thể là kiểu dữ liêụ 

bất kı.̀ Khi đó , ta bắt buộ c phải sử duṇg vòng lặp for…in này (hoa c̣ for…each…in 

trong mu ̣c tiếp theo). 

Cú pháp 

for(var index in Array/Object) 

{ 

Lệnh; 

} 

Giải thích:  
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Trong vò ng la  ̣p for…in này, chı̉ số index se ̃được vét trong tâ ̣ p chı ̉ số của 

Array hoa  ̣c Object. Tương ứng với chı̉ số này, ta có thể thu được giá tri ̣của các 

phần tử tương ứng. 

Ví dụ:  

Ví dụ sử dụng for…in kết hợp với Array 

Ví dụ  Kết quả 

var items:Array = new Array(1, 2, 3); 

for(var index in items){ 

trace("Phần tử thứ " + index + " là " + 

items[index]); 

} 

Phần tử thứ 0 là 1 

Phần tử thứ 1 là 2 

Phần tử thứ 2 là 3 

Trong câu lệnh for…in này, thì biến index là một chỉ số. Nó được khai báo trực 

tiếp trong vòng lặp for. Biến index này se ̃nhâ ̣n các giá tri ̣ là 0, 1, 2 (tương ứ ng 

với chı̉ số củ a ba phần tử 1, 2, 3 củ a mảng). Khi in ra giá tri,̣ thı̀ ta se ̃in ra giá tri ̣ 

của phần tử có chı̉ số tương ứng. 

Ví dụ:  

Ví dụ sử dụng for…in kết hợp với Object 

Ví dụ  Kết quả 

var mang:Object = {'b': "Nam", 'g': "Nữ ", 
'u': "Kho  ng biết"}; 
for(var i in mang) 
trace(mang[i]); 

Nữ 
Nam 
Kho  ng biết 

 Câu lệnh lặp for each…in 

Tương tư ̣như câu lệnh for…in, câu lệnh for each…in cũ ng có thể sử duṇg cho 

mảng có chı̉ số không liên tuc̣ hoa c̣ Object. Tuy nhiên, for each…in truy cập đến 

các phần tử trưc̣ tiếp mà không cần thông qua chı̉ số 

Cú pháp 

for each(var item in Array/Object 

{ 

Lệnh; 

} 
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Ví dụ: Ví dụ sử dụng for each…in kết hợp với Array 

Ví dụ  Kết quả 

var items:Array = new Array(1, 2, 3); 

for each (var item in items) 

{ 

trace(item); 

} 

1 2 3 

Khác với câu lệnh for…in, biến item trong câu lệnh for each…in se ̃nhâ ̣n giá 

tri ̣của các phần tử của mảng chứ không phải là chỉ số như trong trường hợp trên. 

Nó cũng được khai báo trực tiếp trong vòng lặp for. 

Ví dụ: Ví dụ sử dụng for each…in kết hợp với Object 

Ví dụ  Kết quả 

var mang:Object = {'b': "Nam", 'g': "Nữ ", 

'u': "Không biết"}; 

for(var item in mang) 

trace(item); 

Nữ 

Nam 

Khô ng biết 

5.4 Câu lệnh lặp while 

Nếu biểu thức điều kiện đúng thì lặp lại quá trình thực thi lệnh. Nghĩa là câu 

lệnh while luôn kiểm tra biểu thức điều kiện trước khi thực hiện lệnh. Nếu biểu 

thức điều kiện sai ngay từ đầu thì lệnh sẽ không được thực hiện. 

Cú pháp 

while(biểu_thức_điều_kiện) 

{ 

Lệnh; 

} 
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Ví dụ: In ra các số giảm dần từ 3 đến 1. 

Ví dụ  Kết quả 

var i:int = 3; 

while (i>0) 

{ 

trace(i); 

i--; 

} 

3 2 1 

Trong vı́ du ̣này, biểu thứ c i>0 là đúng nên câu lêṇh trace và i-- se ̃đươc̣ thưc̣ 

hiêṇ. Giá tri ̣của i se ̃ lần lươṭ đượ c in ra. Đồng thời giá tri ̣của i se ̃giảm xuống. 

Đến khi biến i nhâṇ giá tri ̣ 0 thı̀ biểu thứ c i>0 không còn đúng và vòng la p̣ kết 

thức. 

Ví dụ: Tính tổng các phần tử có giá trị dương của mảng. 

Ví dụ  Kết quả 

var mang:Array = new Array(); 

var i:int = 0; 

while(i<100) 

{ 

mang.push(Math.round(10*(Math.random(

)-0.5))); 

i++; 

} 

var S:int = 0; 

i=0; 

while(i<100) 

{ 

if(mang[i]>0) 

S+=mang[i]; 

i++; 

} 

trace(S); 

116 

5.5 Câu lệnh lặp do…while 
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Khác vớ i câu lêṇh while, khi sử du ̣ng lêṇh do…while thı̀ lệnh se ̃đượ c thưc̣ 

hiêṇ trước, sau đó kiểm tra biểu thức điều kiện, nếu biểu thức điều kiện còn đúng 

thì lệnh sẽ tiếp tục được thực hiện. Khác với lệnh while, đối với lệnh do…while thì 

lệnh bên trong nó được thực hiện ít nhất một lần. 

Cú pháp 

Do 

{ 

Lệnh; 

} while(biểu_thức_điều_kiện); 

Ví dụ: Viết đoạn chương trình in ra các số theo thứ tự giảm dần từ 3 đến 1. 

Ví dụ  Kết quả 

var i:int = 3; 

do{ 

trace(i); 

i--; 

} while (i>0); 

3 2 1 

Trong đoận chương trıǹh này, ca u lệnh trace sẽ đượ̂  c thự̂  hie ̣̂n và giá trị̂ 

của biến I sẽ đượ̂ c in ra, biến i giảm xuố ng 1 đơn vị̂, sau đó kiểm tra điều kiện 

i>0. Nếu i >0 đúng, thı ̀quay lậ  i vòng la ̣̂ p. Do đó , giá trị̂ đượ̂ c in ra là 3, 2, 1. 

5.6 Các lệnh continue, break và return 

Lệnh continue: lệnh này cho phép bỏ qua một vòng lặp hiện tại và thực hiện 

vòng lặp tiếp theo. 

Ví dụ  Kết quả 

for (var i:int = 0; i<4; i++){ 

if(i%2==0) continue; 

trace(i); 

}; 

1 3 

Dù biến i được xét duyêṭ từ 0 đến 4 nhưng nếu giá tri ̣ của i là chẵn thı̀ lêṇh 

continue đươ ̣c thưc̣ hiện và các lêṇh tiếp theo trong bước lặp hiêṇ ta ̣i se ̃bi ̣bỏ qua. 

Néu i nhâṇ giá tri ̣lẻ, thı̀ lêṇh continue không đươc̣ tiến hành in ra giá tri ̣của i (chı̉ 

giá tri ̣lẻ 1, 3).  

Lệnh break: cho phép thoát khỏi vòng lặp. 

Ví dụ  Kết quả 
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var i:int = 0; 

do{ 

trace(i); 

if (i>=5) break; 

i++; 

} while (true); 

0 1 

2 

3 4 5 

Trong vı́ dụ này, vòng la p̣ do…while khô ng có tı́nh dừ ng và nó se ̃la p̣ maĩ (do 

điều kiện lặp là true). Vò ng la p̣ này se ̃tiến hành in ra giá tri ̣của i sau đó ta ng giá 

tri ̣I lên 1. Nếu giá tri ̣i vượ t quá 5 thı̀ lệnh break được thực hiện và vò ng la  ̣p bi ̣ 

bỏ qua. Trong trườ ng hơ ̣p này, trace nằm trướ c viêc̣ kiểm tra giá tri ̣i>=5, nên nó 

vẫn in ra giá tri ̣5. Kết quả thu đươc̣ như trên. Lệnh return: trả về giá trị cho hàm 

(nếu return nằm trong hàm) và kết thúc chương trình (nếu lệnh return nằm trong 

chương trình chính). Khi ga p̣ lêṇh return, thı̀ tất cả các câu lêṇh tiếp theo trong 

hàm (tứ c nhữ ng lêṇh nằm trong hàm nhưng nằm sau return) se ̃không đươc̣ thưc̣ 

hiêṇ. Bảng so sánh chức năng của ba lệnh continue, break, return 

Lệnh  Chức năng 

continue  
Bỏ qua bướ c la p̣ hiêṇ ta ̣ i và 

thư ̣c hiêṇ bướ c la  ̣p tiếp theo. 

break  Thoát khỏi vòng lặp. 

return  

Thoát khỏi vòng la p̣, thoát 

khỏi hàm, thoát khỏi chương 

trı̀nh. 

Xét về mức đô ̣maṇh yếu, ta có 

thể sắp xếp như sau: 

continue < break < return 
 

6 MỘT SỐ LỆNH ACTIONSCRIP THƯỜNG DÙNG   

6.1 Sử dụng cho đối tượng Frame  

 Chọn key frame ở trong timeline, rồi gõ phím F9 để mở Action Panel ra để 

viết code hay để xem code AS đã được viết ở đó. 

Khi Play Head chạy tới key frame đó thì AS sẽ hoạt động . Ví dụ Khi Play 

head chạy tới keyframe 30 thì sẽ chuyển tới frame 1 và tiếp tục chơi nữa. 
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6.2  Sử dụng cho đối tượng nút nhấn   

Click chọn nút, rồi gõ phím F9 để mở Action Panel ra để viết code hay để xem 

code AS đã được viết ở đó. 

AS viết trên nút chỉ hoạt động khi chuột tác động lên nút mà thôi. Ví dụ: Khi 

nhả chuột trên nút TPHCM thì play head chuyển đến frame số 3 và dừng lại. 

 

Gán trực tiếp vào button: lệnh được đặt trong button 

Gán thông qua tên instance của nó: Lệnh được đặt trong timeline của button 

đó. 

Nhập lệnh trực tiếp vào 

button (Event in button):  

Click chọn button và gõ 

  Gán lệnh qua tên instance của button 

(Event in keyframe): 

Click chọn keyframe có button đó rồi gõ 
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lệnh trong action panel lệnh trong action panel 

on(mouseEvent)  

{ 

   statements; 

} 

my_btn.mouseEvent = function()  

{ 

 lệnh statements; 

} 

Ví dụ: Lệnh nhảy đến keyframe 5 trong cùng timeline khi click chuột lên 

button "jump_btn" 

on(press)  

{ 

 gotoAndStop(5); 

} 

  jump_btn.onPress = function() 

{ 

 gotoAndStop(5); 

} 

Flash khuyến khích nhập lệnh thông qua tên instance. Cách nhập lệnh này còn 

có thuận lợi hơn khi thay thế đối tượng (vì khi thay thế các lệnh nhập trực tiếp sẽ 

biến mất) 

Lệnh trong 

button 

Lệnh gán qua 

tên instance 

button 

sự kiện 

press onPress Click chuột trên nút. 

release onRelease Nhả chuột trên nút (thường sử dụng) 

releaseOutside onReleaseOutside Nhả chuột ngoài nút sau khi press. 

rollOver onRollOver Rê chuột trên nút. 

rollOut onRollOut Rê ra ngoài chuột sau khi rollOver. 

dragOut onDragOut Drag chuột ngoài nút sau khi press. 

dragOver onDragOver Drag chuột lên nút lại sau khi dragOut. 

6.3 Sử dụng cho đối tượng Movies clip   

 Click chọn movie clip, rồi gõ phím F9 để mở Action Panel ra để viết code hay 

để xem code AS đã được viết ở đó. 

AS kèm theo Movies clip có thể điểu khiển Movies clip đó hay là các Movies 

clip trong cùng một timeline hay các timeline ở ngoài movie. 
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Các thuộc tính và phương pháp của movie Clip 

instanceName._x Vị trí x 

instanceName._y Vị trí y 

instanceName._xscale Tỉ lệ chiều ngang 

instanceName._yscale Tỉ lệ chiều dọc 

instanceName._alpha Độ trong suốt 

instanceName._rotation Góc xoay 

instanceName._width Chiều rộng 

instanceName._height Chiều cao 

instanceName._name Tên của instance 

instanceName._parent Instance cha 

instanceName._xmouse Vị trí x của chuột 

instanceName._ymouse Vị trí y của chuột 
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instanceName.onDragOut Kéo rê ra ngoài 

instanceName.onDragOver Kéo rê lên trên 

instanceName.onPress Click chuột 

instanceName.onRelease Nhả nút chuột 

instanceName.onReleaseOutside Nhả nút chuột bên ngoài 

instanceName.onRollOut Lăn bánh xe chuột bên ngoài 

instanceName.onRollOver Lăn bánh xe chuột bên trên 

6.4 Viết Action Script ở keyframe cho nút 

Chọn key frame ở trong timeline của nút, rồi gõ phím F9 để mở Action Panel 

ra để viết code hay để xem code AS đã được viết ở đó. 
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BÀI TẬP 

1 Sử dụng công cụ vẽ cơ bản 

Hãy sử dụng các công cụ vẽ để tạo các nội dung sau đây trên cùng một Stage: 

1. Tạo Layer 1 và đổi tên thành BauTroi. Chọn biểu tượng bảng màu. Chọn 

Stroke color = None, Fill Color = Linear Gradient. Chọn chế độ đổ màu 

Extends Color. Trong kiểu đổ màu cầu vồng này, bạn chỉ chọn hai màu: màu đen 

(mã màu là #000000) đến màu đen trắng (mã màu #999999), 

trong đó màu đen ở phía trên, màu đen trắng ở phía dưới. Sử dụng công cụ 

Rectangle, tạo một hình chữ nhật ở trên Layer này. Sử dụng bảng hiệu 

chỉnh Align để can chỉnh kích thước và vị trí cho hình chữ nhật này trùng 

khớp với kích thước Stage. 

2. Tạo Layer 2 và đổi tên thành MatTrang. Chọn biểu tượng Oval với thuộc 

tính Stroke Color = None, Fill Color là màu Radial Gradient (màu một có mã 

màu là #FFFF00, màu 2 có mã màu là #FFFFFF). Hãy sử dụng công cụ 

Gradient Transform để hiệu chỉnh kích thước của vòng màu bên trong lớn 

hơn và đặt mặt trăng vào vị trí thích hợp trên bức tranh này. 

3. Sử dụng công cụ PolyStar để tạo một ngôi sao màu vàng nhạt, kích thước là 

20x20. Convert ngôi sao này sang biểu tượng Graphics và đặt tên là Sao. 

Chọn công cụ Spray Brush, chọn biểu tượng cho nó là Sao ở trên. Hiệu 

chỉnh các thông số như sau: Scale width = 20% Scale height = 25% Chọn cả ba tùy 

chọn Random Scaling, Rotate Symbol và Random Rotation. Hiệu chỉnh kích thước 

của Brush là width=height=300px, Brush Angel là 90 CW. Tạo mới Layer đặt tên 

là Sao. Hãy quét nhanh công cụ Spray Brush này lên Layer này để tạo các ngôi sao 

nhỏ trên bầu trời. 

4. Tạo mới một Layer và đặt tên là KhungCua. Sử dụng công cụ Rectangle 

Primitive để tạo một hình chữ nhật có kích thước width=200, height=150, 

chọn Fill color là None, Stroke color là màu đen, loại đường viền style là 

stippled, kích thước của đường viền là 5px. Sử dụng công cụ Deco để đổ 

màu nghệ thuật (cành hoa nho) cho khung cửa sổ này.  

5. Tạo mới Layer đặt tên là NgoiNha. Hãy sử dụng các công cụ cần thiết để vẽ 

nên ngôi nhà mơ ước của bạn. Lưu ý: hãy sử dụng màu sắc thật hài hòa trong đêm 

tối  

6. Tạo mới Layer đặt tên là DamMay. Hãy sử dụng công cụ Pen để tạo nên 

các đám mây có viền cong. Tô màu cho nó bằng màu xanh nhạt (mã màu 

#66CCCC) và hãy loại bỏ viền của nó. 
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7. Tạo mới Layer đặt tên là ConNguoi. Hãy sử dụng các công cụ cần thiết để 

phát họa chân dung của một cô gái đang đi dưới ánh trăng. 

8. Tạo mới Layer đặt tên là DenLong. Hãy phát họa cây đền lồng và đặt nó 

vào tay cô gái. 

9. Tạo mới Layer đặt tên là CayCoi. Hãy phát họa hình một rặng tre hoặc một 

cây cổ thụ. Chọn màu sắc hợp lý 10.Tạo mới Layer đặt tên là TieuDe. Sử dụng 

công cụ Text để soạn thảo trên Layer này nội dung “Ánh Trăng Trên Quê Hương”. 

2 Sử dụng biểu tượng và tạo hoạt cảnh 

Hãy sử dụng bức ảnh chứa các đối tượng được vẽ ở trên để thực thi bài thực 

hành số 2 

1. Hãy chuyển đổi MatTrang trong Layer 2 thành biểu tượng MovieClip và 

đặt tên cho nó là MatTrang. Hãy sử dụng Classic Tween để tạo hiệu ứng 

động cho mặt trăng. Mặt trăng có hai hiệu ứng động là: đổ bóng mờ và di 

chuyển. Để tạo hiệu ứng bóng mờ, hãy sử dụng thuộc tính Filter=Blur của 

MovieClip. Các thao tác này chỉ được sử dụng Classic Tween. 

2. Hãy xóa bỏ các ngôi sao trên bầu trời ở trên. Trong thư viện, hãy chọn lại 

biểu tượng Graphic là Sao mà bạn đã tạo. Bạn hãy chuyển đổi nó thành 

MovieClip. Sử dụng Motion Tween để tạo hiệu ứng tăng giảm độ trong suốt 

(thuộc tính Alpha của MovieClip). Thuộc tính này thay đổi từ 80% đến 

100%. Tiếp tục sử dụng công cụ Spray Brush, lần này bạn chọn biểu tượng 

cho nó là MovieClip Sao. Hiệu chỉnh các thông số tương tự như bài thực 

hành số 1. Sau đó, quét lên Layer Sao. 

3. Hãy sử dụng công cụ Bone để tạo chuyển động cho đôi chân cô gái. Các 

phần còn lại không cần tạo chuyển động. Bạn kết hợp với Motion Tween để 

tạo sự di chuyển (thay đổi vị trí trong bức ảnh) cho cô gái. 

4. Sử dụng Motion Tween để tạo chuyển động cho các đám mây. Các đám mây 

chuyển động theo dạng thức 3D (kết hợp công cụ 3D Rotation và 3D 

Translation). 

5. Hãy tạo mới một Layer đặt tên là BienHinh. Trên Layer này, bạn hãy tạo 

một ngũ giác. Sử dụng Shape Tween để tạo hiệu ứng biến hình cho hình thể 

này thành hình ngôi sao năm cánh. Hãy đặt nó vào một vị trí thích hợp. 

Hãy sử dụng các công cụ tạo hoạt hình (Tween, Bone, Bind, 3D,…) để tạo một 

VideoClips. Lưu ý trong bài này, sinh viên cần kết hợp với một bài hát. Nội dung 

phim và nội dung bài hát phải tương đối phù hợp. Bài hát dài không dưới 1 phút. 

3 Lập trình với actionscript 
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Trong bài thực hành này, bạn cần hoàn tất các nội dung sau: 

1. Tạo một đối tượng quả bóng bằng công cụ Oval. Sau đó, hãy chuyển đổi nó 

thành biểu tượng MovieClip. Cài đặt tên thể hiện cho nó là QuaBong. Hãy 

xóa quả bóng này trên Stage. Mở khung soạn thảo ActionScript, bây giờ 

bạn hãy viết ActionScript để tạo chuyển động 3D cho quả bóng, thay đổi 

thuộc tính alpha khi nó chuyển động. Sự thay đổi thuộc tính alpha này qui 

định theo thời gian (thay đổi từ 80% đến 100%). 

2. Tạo mới một Scene. Trên Scene này, bạn hãy sử dụng hai bức ảnh. Hiệu 

chỉnh kích thước cho chúng bằng nhau. Kích thước của chúng không quá 

lớn, sao cho ta có thể đặt chúng trên Stage nhưng vẫn còn khoảng trống. Sử 

dụng đối tượng Tween để tạo hoạt hình cho hai bức ảnh này. 

Để tạo hoạt hình nhờ vào Tween trong ActionScript, bạn có thể thao tác 

như hướng dẫn sau: Hãy đưa hai đối tượng ảnh này vào trong thư viện, sau đó 

chuyển đổi chúng thành các biểu tượng MovieClip, và đặt tên cho chúng lần lượt 

là Anh1 và Anh2. Bạn quan sát mã chương trình sau 

import fl.transitions.easing.*; 

import fl.transitions.Tween; 

var OneTween:Tween; 

var TwoTween:Tween; 

Ở đây, bạn sử dụng package fl.transition. Đối tượng Tween được đưa vào 

để sử dụng. Các hiệu ứng động cũng được đưa vào qua dòng lệnh thứ nhất. 

Tiếp theo, bạn hãy tạo chuyển động cho đối tượng nhờ vào đối tượng 

Tween. Cách sử dụng Tween cũng tương tự như bạn tạo một Thread vậy. 

OneTween = new Tween(Anh1, "y", Bounce.easeOut, 50, 

100, 3, true); 

OneTween.start(); 

TwoTween = new Tween(Anh2, "y", Bounce.easeOut, 250, 

300, 3, true); 

TwoTween.start(); 
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Đối tượng Tween có phương thức khởi tạo Tween(Object, String, Function, 

Number, Number, Number, Boolean). Object là đối tượng mà ta sẽ áp dụng 

hiệu ứng Tween; String là tên thuộc tính mà ta sẽ sử dụng – như “x”, “y”,…; 

Function là tên phương thức sẽ áp dụng – chi tiết hơn bạn có thể thử 

nghiệm với chức năng Add New Items to Script với gói fl.transition.easing; 

Number thứ nhất và Number thứ hai là hai biên chuyển động. Number thứ 

ba là số lần chuyển động (duration), tham số Boolean mặc định được sử 

dụng là true. Hãy kiểm tra xem thử nó hoạt động hoàn hảo hay không. Đây 

thực sự là cách tạo chuyển động rất hoàn hảo. 

3. Tạo mới một dự án khác. Trong dự án này có ba file: file main.fla, file 

human.as, file student.as. File main.fla là khung trình diễn chính. Các file 

còn lại được sử dụng như các lớp. File human.as là một lớp chứa hai thuộc 

tính là Name:String và Age:int và bốn phương thức chính là void 

SetName(String), String GetName(void), void SetAge(int) và int 

GetAge(void). Lớp student kế thừa lớp Human. Ngoài ra, nó còn có thêm 

thuộc tính ID:String và hai phương thức void SetID(String), String 

GetID(void). Quay trở lại với khung trình diễn chính, bạn hãy phát họa 

hình một con người. Sau đó, bạn hãy convert nó sang biểu tượng 

MovieClip. Cài đặt tên hiển thị cho nó là ConNguoi. Cuối cùng bạn hãy xóa 

nó ra khỏi stage. Trên khung trình diễn này, bạn hãy tạo một Button và ba 

textbox kèm theo ba label. Ba label có nội dung là: Tên, Tuổi, MãSV. Ba 

textbox còn lại tương ứng dùng để nhập nội dung theo ba trường này 

(Name, Age và ID). Khi người dùng nhập dữ liệu và nhấp nút Add, hình 

người sẽ hiển thị ra bên dưới. Đồng thời, bên cạnh nó là các thông tin về 

đối tượng này (Tên, Tuổi và MãSV). 

4. Trong bài thực hành này, bạn hãy tạo một dự án gồm bốn file: main.fla, 

solutions.as, solution1.as và solution2.as. Trên stage của main có ba 

textbox và ba label tương ứng để nhập các số a, b và c. Một nút nhấn để giải 

phương trình, và một label nữa để hiển thị kết quả. File solutions.as là một 

interface chứa hai phương thức là DoSolution và ToString. Hai lớp 

solution1.as và solution2.as là hai lớp thực thi giao diện solutions.as này. 

Phương thức DoSolution của đối tượng trong solution1.as sẽ giải phương 

trình bậc 1, phương thức DoSolution của đối tượng trong solution2.as sẽ 

giải phương trình bậc hai. Phương thức ToString của cả hai đối tượng có 

nhiệm vụ in ra nghiệm cuối cùng. Đối tượng trong solution1.as chứa hai 

thuộc tính là a:Number và b:Number. Đối tượng trong solution2.as chứa ba thuộc 
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tính là a:Number, b:Number và c:Number. Sau khi bạn hoàn tất yêu 

cầu này, hi vọng bạn sẽ hiểu rõ hơn về giao diện. 

4 Bài tập kĩ thuật Tween 

Hãy sử dụng kĩ thuật Tween kết hợp với các công cụ tạo hiệu 

ứng 3D để tạo dựng các hiệu ứng như trong Motion Presets cho hai hiệu ứng nêu 

trên: 

a) Hiệu ứng quả bóng di chuyển trong không gian. 

b) Chữ chạy 3D. 

5 Tạo kĩ xảo điện ảnh với Flash  

Trong phần này, chúng tôi sẽ hướng dẫn cho bạn cách tạo một số kĩ xảo thường 

được dùng trong các chương trình truyền hình hiện nay. Trước khi thảo luận chi 

tiết, chúng ta sẽ tìm hiểu sơ qua về kĩ xảo điện ảnh là gì ?  

Kĩ xảo điện ảnh đó là những hiệu ứng được tạo dựng nhờ công cụ máy tính để 

làm cho các bộ phim, các chương trình truyền hình trở nên hấp dẫn hơn. Kĩ xảo 

điện ảnh có thể phân làm hai dạng cơ bản:  

− Kĩ xảo dành riêng cho các chương trình truyền hình: như các hiệu ứng chuyển 

cảnh, hiệu ứng văn bản, hiệu ứng trong các chương trình gameshow,…  

− Kĩ xảo dành riêng cho các thước phim điện ảnh: các hiệu ứng tạo sóng, tạo mây 

mù, phép thuật,…  

Sự phân loại này được quy định trong giáo trình này. Chúng ta sẽ không đi vào 

thảo luận chi tiết về các dạng kĩ xảo này. Chúng ta chỉ sử dụng Flash như là công 

cụ để tạo ra một số kĩ xảo thông dụng.  

6 Kĩ xảo biến hình (kĩ xảo điện ảnh)  

Một kĩ xảo biến hình (ví dụ một nhân vật A dùng phép thuật để biến thành 

nhân vật B) thực chất đó là một kĩ thuật bấm máy. Người quay phim sẽ quay hai 

hình ảnh này trong cùng một hình nền, hai nhân vật có cùng một thế đứng như 

nhau. Việc biến hình chỉ đơn thuần là sự tiếp diễn của hai cảnh quay này. Để cho 

phim có thêm hiệu ứng đặc sắc, bạn có thể sử dụng hiệu ứng động của Flash (như 

bốc khói, tạo một luồng sáng,…) để làm cho hiệu ứng thêm đẹp mắt. Việc xây 

dựng các hiệu ứng này bạn có thể tìm hiểu trong các ví dụ tiếp theo sau.  

Bạn lưu ý rằng, nếu bạn muốn tạo một hiệu ứng ghép hình, thì Flash không hỗ 

trợ cho bạn. Bạn có thể dùng chương trình chuyên dụng là Adobe After Effect.  

7 Kĩ xảo chú gấu thổi lửa  
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Trong ví dụ này, chúng ta sẽ sử dụng một thước phim có hình chú gấu. Chú 

gấu sẽ há miệng. Khi đó, một luồng ánh sáng màu đỏ (mà ta gọi là lửa) sẽ phóng 

ra. Kĩ xảo mong chờ trong thước phim cuối cùng là thước phim chú gấu này sẽ thổi 

ra lửa.  

Đầu tiên, bạn hãy tạo một dự án mới. Bạn hãy import Video hình chú gấu vào 

(File Bear.flv trong thư mục Video của CD đính kèm). Bạn hãy hiệu chỉnh các 

thuộc tính khi import dữ liệu theo hình mô tả của hình bên dưới đây  

 

Sau đó, bạn nhấp vào Next. Trong cửa sổ tiếp theo, bạn chọn Embbed Video và 

nhấp Finish.  

Giờ đây, video mà bạn import vào nằm trong thư viện (nếu bạn chọn import to 

Library), nằm trong Stage (nếu bạn chọn import to Library). Để tạo kĩ xảo điện ảnh 

như chúng ta thảo luận ở trên, các bạn hãy thực hiện các bước sau đây  

Bước 1 Bạn hãy kéo video trong thư viện vào trong Stage, sử dụng chức năng 

Align để hiệu chỉnh kích thước cho video trùng với kích thước của Stage và đặt nó 

trùng khớp lên Stage.  
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Video hình chú gấu đã được đặt vào Layer 1. Bạn hãy sửa tên Layer 1 này 

thành Bear.  

Bước 2. Tạo mới một Layer, đặt tên cho nó là Fire. Bạn hãy vẽ lên Layer này 

một hình chữ nhật màu đỏ, loại bỏ viền. Tiếp theo, bạn hãy convert nó thành 

MovieClip. Trong bảng thuộc tính của MovieClip này, bạn chọn Filter là Blur, 

hiệu chỉnh độ BlurX và BlurY là 41.  

Bước 3. Bạn hãy kéo thanh đánh dấu Frame hiện tại trên TimeLine, xem vị trí 

cần tạo quả cầu lửa xuất hiện. Bạn hãy bấm vào Frame tương ứng trên Layer Fire, 

nhấn phím F6 để tạo một KeyFrame. Kích chuột phải lên quả cầu lửa, chọn Create 

Motion Tween. 

Chọn Frame kết thúc việc phóng lửa và kéo vị trí kết thúc của Tween về tại vị 

trí Frame này. Tại Frame này bạn hãy kéo giãn quả cầu lửa này dài ra. Trên các vị 

trí bên trong Tween, bạn hãy hiệu chỉnh vị trí của cầu lửa khớp với miệng chú gấu 

(các vị trí đánh dấu đen trên TimeLine). 

Giờ đây, bạn có thể kiểm tra thành quả của mình. Nhấn Ctrl+Enter để kiểm tra. 

Bạn có thể kết hợp với những video mà bạn xây dựng nên. Việc xây dựng một 

video và sử dụng Flash để tạo kĩ xảo là một trải nghiệm khá thú vị đang chờ đợi 

bạn đấy. Hi vọng bạn sẽ thực hiện kĩ xảo này một cách thành thạo. 
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8 Kĩ xảo cuộc chiến trên không của hai chú chim 
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Bạn sử dụng video có tên Bird.flv trong thư mục Video của CD đính kèm. 

Cũng tương tự như trường hợp trên. Bạn tạo Layer Bird để chứa video mà bạn 

import vào. Layer Light chứa quầng sáng đỏ bao quanh chú chim. Bạn cần tạo một 

Motion Tween để hiệu chỉnh vị trí của quầng sáng luôn di chuyển và bao quanh 

chú chim. Bạn cần hiệu chỉnh vị trí bắt đầu và kết thúc của quầng sáng phù hợp với 

vị trí xuất hiện và biến mất của chú chim.  

Tại vị trí chú chim thứ hai xuất hiện, bạn tạo một luồng sáng xanh phóng ra 

(tức chú chim này phóng lửa về phía chú chim thứ nhất), nó nàm trên Layer One. 

Luồng sáng phóng về phía trước. Do không phóng trúng chú chim 1, nên luồng 

sáng sẽ bị vụt tắt khi sát biên màn hình. Khi vụt tắt, nó tạo ra một quầng sáng lớn. 

Bạn hãy hiệu chỉnh các vị trí cho thích hợp trong Motion Tween dành cho luồng 

sáng xanh này. Bạn hãy nhấn Ctrl+Enter để kiểm tra kết quả. 

9 Kĩ xảo người bay trên những chú ngựa  

Đây cũng là một kĩ xảo tương đối đơn giản. Bạn chỉ cần tạo hai Layer: Layer 1 

chứa nội dung video, Layer 2 chứa hình người. Bạn đặt người vào một vị trí thích 

hợp trên cảnh quay, và sử dụng Motion Tween (hay Classic Tween) để tạo quỹ đạo 

bay của nhân vật này. 
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10 Tạo thước phim Flash tựa 3D  

Flash mặc định không hỗ trợ các đối tượng đồ họa 3D. Nó không cung cấp cho 

chúng ta các công cụ để tạo và phối màu 3D. Flash chỉ cung cấp cho ta công cụ tạo 

ra sự dịch chuyển 3D và quay theo các góc trong không gian. Nếu bạn thật sự 

muốn tạo một đối tượng động 3D, tôi khuyên bạn nên sử dụng đến các chương 

trình chuyên dụng: Autodesk Maya là một sự lựa chọn hoàn hảo nhất. Tuy nhiên, 

nếu bạn là người yêu thích Flash, bạn cũng có thể sử dụng Plugin hỗ trợ 3D – 

FreeSpin3D. Đây cũng là một Plugin khá thú vị hỗ trợ 3D hoàn hảo. Nhưng Plugin  

này có giá không rẻ chút nào. Nếu bạn muốn trải nghiệm một cảm giác miễn 

phí với đồ họa 3D trong Flash, bạn có thể tạo dựng nó nhờ vào ngôn ngữ lập trình 

ActionScript. Để tạo một thước phim 3D trên ActionScript, sẽ thuận lợi hơn nếu 

chúng ta xây dựng trên thư viện mã nguồn mở PaperVision3D. Chúng tôi sẽ trình 

bày khá chi tiết về thư viện này trong chương cuối của giáo trình. Một khó khăn là 

bạn cần có một lượng kiến thức toán học khá vững chắc để tạo dựng các đối tượng 

đồ họa 3D. Thư viện mã nguồn mở PaperVision3D được cung cấp cho hầu hết các 

trình soạn thảo ActionScript, nhưng chúng tôi sẽ trình bày trên Flex Buider bởi đây 

là trình soạn thảo ActionScript chuyên nghiệp nhất.  

Dù không cung cấp cho ta các công cụ chuyên dụng để thiết kế 3D, nhưng với 

kĩ thuật phối màu Gradient và kĩ thuật Layer, chúng ta có thể tạo dựng một thước 

phim có “cách nhìn 3D”. Trong ví dụ sau đây, tôi sẽ trình bày cách xây dựng đoạn 

phim đánh golf. Khi người đánh golf đánh vào quả bóng, thì quả bóng sẽ lăn và rơi 

vào lỗ golf trên sân cỏ.  

Bước 1. Tạo mới một Layer có tên là Glass. Bạn hãy phối màu Linear 

Gradient, và chọn chế độ màu như hình bên dưới.  
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Bước 2. Tạo lỗ golf trên sân golf. Tạo một Layer mới tên là hole. Trên Layer này, 

bạn hãy tạo một hình Eclipse như sau. 

 

 

 

Sau khi tạo xong lỗ golf, bạn bổ sung thêm một thanh dọc làm cờ cắm trên lỗ 

golf. Sau khi hoàn tất bước này, bạn hãy đặt lỗ golf vào một ví trí thích hợp trên 

khung trình diễn của bạn. Bạn cũng lưu ý rằng, khung trình diễn trong trường hợp 

này rộng hơn theo chiều ngang sẽ thích hợp hơn so với khung trình diễn có chiều 

dọc gần bằng hoặc lớn hơn chiều ngang. Tôi khuyến cáo bạn trong trường hợp này, 

nên chọn tỉ lệ theo chuẩn HD là 8:3 (trường hợp của tôi là 850px theo chiều ngang, 

400px theo chiều dọc. 
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Bước 3. Tạo quả bóng golf. Hãy sử dụng công cụ vẽ hình Eclipse, tạo một khối 

hình tròn (giữ Shift và kéo chuột). Sau đó hiệu chỉnh thuộc tính màu Gradient như 

bên dưới. Quả bóng golf này nằm trên Layer ball. 

 

Bước 4. Tạo thanh chơi golf. Thanh chơi golf này sẽ đánh vào quả bóng để tạo 

hiệu ứng đánh golf. Thanh chơi golf được đặt trên Layer line. 
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Lưu ý:  

Bạn cần đặt Layer thanh đánh bóng vào sau Layer quả bóng chơi golf. Tiếp 

theo, bạn sẽ sử dụng kĩ thuật Motion Tween để tạo hiệu ứng cây đánh golf đánh 

vào quả bóng chơi golf. Trong trường hợp bên dưới, tôi sử dụng kết hợp công cụ 

3D Rotation. 

 

Khi sử dụng Motion Tween, bạn hiệu chỉnh vị trí kết thúc của nó là tại Frame 

thứ 5. Trên các Layer còn lại, bạn bôi đen Layer thứ 5 tương ứng (nhấn thêm phím 

Ctrl), sau đó nhấn phím F5 để sao chép Frame 1 đến các Frame còn lại (quan sát 

khung TimeLine ở trên).  

Bước 5. Tạo hiệu ứng quả bóng lăn. Tại Frame thứ 5 trên Layer ball, bạn nhấn 

phím F6 để tạo mới một KeyFrame. Sau đó, sử dụng Motion Tween để tạo chuyển 

động cho quả bóng tiến về phía lỗ đánh golf. 
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Đường di chuyển của quả bóng được chia làm hai phần: Phần 1 – từ vị trí ban đầu 

đến lỗ golf (Frame 5 đến Frame 60). Phần 2 – Từ vị trí bề mặt lỗ golf xuống dưới lỗ golf 

(Frame 60 đến Frame 65).  

Bước 6. Theo cách quan sát của chúng ta, thì từ giai đoạn quả bóng trên bề mặt 

xuống đến đấy của lỗ golf, thì quả bóng sẽ biến mất. Để thực hiện điều này, ta sẽ sử dụng 

kĩ thuật Layer. Bạn sử dụng công cụ Lasso, chọn trên Layer Glass một phần như hình 

minh họa bên dưới. 

 

Lưu ý:  

Bạn nên sử dụng thuộc tính Lock cho các Layer còn lại (trừ Layer glass và 

Layer hole).  

Sau khi chọn được vùng chọn như trên, bạn sử dụng chức năng Distribute to 

Layers. Khi đó, sẽ xuất hiện một số Layer mới, bạn hãy nhóm các Layer này thành 

một nhóm bằng một Folder mới (bạn đặt tên cho nó là LayerTech). Sau đó, kéo 

Folder này lên trên tất cả các Layer còn lại. 
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Đến đây, hầu như bạn đã hoàn tất thước phim. Tuy nhiên để cho phim được 

thật hơn, chúng ta sẽ bổ sung thêm hiệu ứng đổ bóng. Sau đây là dự án hoàn chỉnh. 

 

Với dự án golf này, hi vọng bạn sẽ có cảm giác 3D sống động. Chúng ta chỉ 

đơn thuần sử dụng những kĩ thuật đơn giản được cung cấp trong Flash: hiệu ứng 

Shadow, hiệu ứng Gradient và kĩ thuật Frame, và kết quả thu được là một thước 

phim tựa 3D.  

Nếu bạn muốn tạo một hiệu ứng 3D tựa như trái đất quay, bạn cũng hoàn toàn 

có thể dựa vào các hiệu ứng này. Khi đó, bạn cần một bức ảnh về hình ảnh trái đất 

được phát họa trên một mặt phẳng (chứ không phải là trên mặt cầu). Bạn kết hợp 

với công cụ Fill Color (bạn chọn là kiểu Bitmap) với kĩ thuật Shape Tween. Lúc 

này, bạn sử dụng công cụ Gradient Transform để tạo sự dịch chuyển ảnh trong một 

khối hình tròn. Đây cũng là một cách thức khá thú vị và cực kì đơn giản. Bạn hãy 

thực hiện dự án này xem như bài tập. 

Nếu bạn muốn tạo một thước phim 3D với những hiệu ứng phức tạp (các nhân 

vật, đối tượng quay trong không gian) thì dường như việc áp dụng những kĩ thuật 

nêu trên là quá khó khăn. Khi đó, bạn nên chuyển sang một chương trình như 

Autodesk Maya, bởi lẻ Adobe Flash cũng không hỗ trợ cách xây dựng dạng phim 

3D hoàn chỉnh như thế (trừ phi bạn lập trình hoàn toàn trên ActionScript). 

11 Một vài ví dụ sử dụng kĩ thuật mặt nạ Mask  

− Ví dụ về việc sử dụng mặt nạ động: trong ví dụ này, bạn sẽ tạo một mặt nạ động 

cho một lớp đối tượng. Bạn sẽ sử dụng hai lớp: Layer Art và Layer Mask. 
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Bạn hãy sử dụng Motion Tween (hoặc Classic Tween) để tạo hiệu ứng dịch 

chuyển lớp mặt nạ dọc theo đường nghệ thuật. Tiếp theo, bạn hãy kích chuột phải 

lên lớp Mask, chọn Mask. Lập tức lớp mặt nạ chuyển động này sẽ tạo hiệu ứng 

xuất hiện từng phần cho đối tượng hình nghệ thuật.  

− Ví dụ về việc sử dụng mặt nạ biến hình: trong ví dụ này, bạn sẽ tạo một mặt nạ 

biến hình. Hoàn toàn tương tự như ví dụ trên, nhưng chỉ khác một điểm là trong 

ví dụ trên, bạn sử dụng Motion Tween (hoặc Classic Tween), còn trong ví dụ 

này, bạn sử dụng Shape Tween. 
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Mặt nạ động tạo ra một hiệu ứng khá thú vị. Mặt nạ biến hình có chức năng 

cũng không kém thú vị. Bạn hoàn toàn có thể sử dụng hai loại mặt nạ này tạo ra 

các hiệu ứng hay khi trình chiếu một Album ảnh.  

− Ví dụ về việc sử dụng mặt nạ có thể di chuyển được (draggable mask). Để tạo 

loại mặt nạ này, chúng ta cần tạo một đối tượng để làm mặt nạ. Đối tượng này 

phải là biểu tượng movieclip hoặc button. Thông thường, người ta sẽ sử dụng 

biểu tượng movieclip.  

Đầu tiên, bạn hãy tạo hai Layer: Layer 1 chứa ảnh nền (tạm gọi là background), 

Layer 2 tạo một hình ngũ giác để làm mặt nạ (tạm gọi là mask). 

 

Để tạo được hiệu ứng này, bạn cần sử dụng ActionScript. Ở đây, chúng ta sẽ sử dụng 

ActionScript nhờ vào Code Snippets. Bạn chọn đối tượng hình ngũ giác, bấm vào biểu 

tượng Code Snippets. 
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Bạn chọn nhóm Actions > Drag and Drop. Sau đó, bạn hãy nhấp đôi chuột vào 

biểu tượng này. Bạn hãy nhấn Ctrl+Enter để kiểm tra. Tại thời điểm này, bạn có 

thể di chuyển đối tượng hình ngũ giác này.  

Tiếp theo, chúng ta sẽ sử dụng kĩ thuật Mask. Bạn hãy chọn Layer Mask, kích 

chuột phải, và chọn Mask. Bạn sẽ thu được kết quả như hình bên dưới. 

 

Bạn hãy kiểm tra movie một lần nữa bằng cách nhấn tổ hợp Ctrl+Enter. Bạn sẽ 

thấy rằng, hiệu ứng mask đã hoạt động. Tuy nhiên, bạn không thể di chuyển được 

đối tượng dùng làm mặt nạ này. Sở dĩ như vậy là vì, khi bạn sử dụng hiệu ứng 

mask, đối tượng movieclip được làm mặt nạ sẽ được tự động ấn định thuộc tính 

buttonMode là false. Chúng ta cần thay đổi thuộc tính này. Bạn hãy nhấn phím F9 

để quay lại với khung soạn thảo ActionScript. Sau đó, bổ sung dòng lệnh  

movieClip_1.buttonMode = true;  

Bạn có thể tham khảo toàn bộ mã lệnh của chương trình như bên dưới. 

movieClip_1.addEventListener(MouseEvent.MOUSE_DOWN, 

fl_ClickToDrag);  

function fl_ClickToDrag(event:MouseEvent):void{  
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movieClip_1.startDrag();  

}  

stage.addEventListener(MouseEvent.MOUSE_UP, fl_ReleaseToDrop);  

function fl_ReleaseToDrop(event:MouseEvent):void{  

movieClip_1.stopDrag();  

}  

movieClip_1.buttonMode = true;  

Tạo SlideShow ảnh: Trong ví dụ này, tôi sẽ hướng dẫn cho bạn cách tạo một 

SlideShow ảnh nhờ vào kĩ thuật Mask. Để tạo được SlideShow ảnh này, bạn hãy 

sử dụng một vài bức ảnh và import vào thư viện. Trong ví dụ này, tôi sử dụng 3 

ảnh. Bạn tạo 6 Layer, 3 Layer chứa ảnh, và 3 Layer dùng để tạo mặt nạ. Mỗi mặt 

nạ sẽ được đặt ngay trên bức ảnh. Bạn có thể tham khảo hình minh họa bên dưới. 

 

 


